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Источники информации компании Bio-Rad 

В таблице 1 представлены источники информации компании Bio-Rad и порядок поиска необходимой 
информации. 

Таблица 1. Источники информации компании Bio-Rad 
 

Ресурсы поддержки Как получить доступ к информации 

Региональные представители 
компании Bio-Rad Laboratories 

Произведите поиск информации и контактов на веб-сайте Bio-Rad 
Laboratories, выбрав свою страну на домашней странице 
(www.bio-rad.com). Найдите ближайшее иностранное 

представительство на последней странице данного руководства. 

Технические замечания и 
литература 

Перейдите к веб-сайту компании Bio-Rad Laboratories 
(www.bio-rad.com). Наберите термин в поисковой строке и выберите 
Documents (Документы) для поиска ссылок на технические заметки, 

руководства и прочую литературу. 

Технические специалисты Персонал отдела технической поддержки компании Bio-Rad состоит из 
опытных специалистов, способных оказать заказчикам практическую 
квалифицированную поддержку. 
Для нахождения региональной службы технической поддержки по 
телефону обратитесь в ближайшее представительство компании 
Bio-Rad Laboratories. Для получения технической поддержки в США и 
Канаде наберите номер телефона 
800-424-6723 (бесплатный телефон) и выберите опцию технической 
поддержки. 

Письменные условные обозначения, используемые в 
данном руководстве 

Таблица 2 перечисляет письменные условные обозначения, используемые в настоящем руководстве. 

Таблица 2. Условные обозначения, используемые в руководстве 
 

Условное обозначение Значение 

СОВЕТ: Содержит полезные инструкции, включая информацию, которая более 
подробно поясняется далее в настоящем руководстве. 

ПРИМЕЧАНИЕ: Содержит важную информацию, включая информацию, которая более 
подробно поясняется далее в настоящем руководстве. 

ВНИМАНИЕ! Приводит очень важную информацию о действии, которое может причинить 
вред исследователю, прибору или привести к потере данных. 

X>Y Инструкции по выбору X и затем – Y на панели инструментов, в меню или окне 
программного обеспечения 

Информация по предупреждающим этикеткам, используемым в настоящем руководстве и размещенным на 
системах CFX96 Touch, CFX96 Touch Deep Well, CFX Connect или CFX384 Touch, приведена в разделе 
«Соблюдение правил техники безопасности и установленных норм» на стр. iii. 

http://www.bio-rad.com/
http://www.bio-rad.com/
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Соблюдение правил техники безопасности и 
установленных норм 

Для обеспечения безопасной работы систем CFX96 Touch, CFX96 Touch Deep Well, CFX Connect или CFX384 
Touch настоятельно рекомендуется строго следовать всем спецификациям, перечисленным в данном разделе 
и во всем руководстве. 

Предупреждающие этикетки 

Предупреждающие этикетки прикреплены к устройству, а в настоящем руководстве они предупреждают вас о 
травмоопасных или вредных источниках. Значение каждой этикетки с предупреждением об опасности смотри 
в таблице 3. 

Таблица 3. Смысловое содержание предупреждающих этикеток 
 

 

ОСТОРОЖНО! Биологическая опасность! Данный знак идентифицирует компоненты, которые 

могут содержать биологически опасные материалы. 

 

ОСТОРОЖНО! Возможно возникновение опасной ситуации! Этот знак указывает на 

компоненты, которые представляют опасность получения травмы или повреждения устройства 
в случае неправильного обращения с ним. Если указан этот знак, изучите данное руководство 
на предмет дополнительной информации прежде, чем продолжить выполнение операции. 

 

ОСТОРОЖНО! Горячая поверхность! Этот знак указывает на компоненты, которые 

представляют опасность получения травмы в связи с высокой температурой в случае 
неправильного обращения с ними. 
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Предупреждения об осторожности при обращении с прибором 

Предупреждения об осторожности при обращении с прибором, приведенные в Таблице 4, также размещены 
на приборах и касаются непосредственно безопасной эксплуатации систем CFX96 Touch, CFX96 Touch Deep 
Well, CFX Connect и CFX384 Touch. 

Таблица 4. Этикетки с предупреждением об опасности при обращении с устройством 
 

Знак Значение 

 

Предупреждение об опасности получения травмы или повреждения оборудования. 

Эксплуатация устройств CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch до 
ознакомления с настоящим руководством может подвергать оператора опасности получения 
травмы. Для обеспечения безопасности не используйте данный прибор каким-либо другим, не 
указанным в настоящем руководстве, образом. К работе с прибором допускается только 
квалифицированный персонал лаборатории, прошедший подготовку по безопасной 
эксплуатации электрического оборудования. Всегда с осторожностью обращайтесь со всеми 
компонентами системы; руки должны быть чистыми и сухими. 

 

Предупреждение об осторожности при работе с биологически опасными материалами 

При работе с биологически опасными образцами строго соблюдайте все правила техники 
безопасности и инструкции, а также местные инструкции и указания, принятые в вашей 
лаборатории. 

 

Предупреждение об опасности получения ожога. 

Термоциклер выделяет достаточно тепла, чтобы получить серьезные ожоги. Во время работы 
всегда используйте защитные очки или прочие средства защиты глаз. Перед открыванием 
крышки и извлечением образцов из блока с образцами следует подождать, пока блок не 
остынет до первоначальной температуры. Обеспечьте максимальное расстояние между вами и 
устройством во избежание случайных ожогов кожи. 

 

Предупреждение об опасности взрыва. 

В нормальном режиме работы блоки с образцами могут стать достаточно горячими, что может 
привести к кипению и разбрызгиванию жидкостей. 

ПРИМЕЧАНИЕ: Информация о термоциклере C1000 Touch™ приведена в руководстве по эксплуатации 
термоциклера C1000 Touch. 

Правила безопасной эксплуатации и соответствие требованиям 
безопасности 

Таблица 5 приводит правила безопасной эксплуатации систем CFX96 Touch, CFX96 Touch Deep Well, CFX 
Connect и CFX384 Touch. С данными устройствами необходимо использовать экранированные кабели для 
обеспечения соответствия требованиям Федеральной комиссии связи США в отношении приборов класса А. 

Таблица 5. Правила безопасной эксплуатации 
 

Требования к безопасной эксплуатации Технические характеристики 

Температура Использование в 
помещении 

Окружающая температура 15-31°C. Относительная влажность 
не более 80%, без конденсации 

Высота установки  До 2000 метров над уровнем моря 

СОБЛЮДЕНИЕ УСТАНОВЛЕННЫХ НОРМ 

Данное устройство прошло испытания и признано соответствующим всем действующим требованиям 
следующих стандартов по безопасности и электромагнитной совместимости: 

• IEC 61010-1:2001 (2-е изд.), EN61010-1:2001 (2-е изд.). Электрооборудование для проведения 
измерений, управления и лабораторного использования. Часть 1: Общие требования. 

• IEC 61010-2-010:2005, EN61010-2-010:2003. Электрооборудование для проведения измерений, 
управления и лабораторного использования. Требования безопасности. Часть 2-010: Особые 
требования к лабораторному оборудованию для нагревания материалов 
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• IEC 61010-2-081:2001+A1, EN61010-2-081:2002+A1. Электрооборудование для проведения 
измерений, управления и лабораторного использования. Требования безопасности. Часть 2-081: 
Особые требования к автоматическому и полуавтоматическому лабораторному оборудованию для 
анализа и прочих целей (включает Дополнение 1). 

• EN 61326-1:2006 (Класс A). Электрооборудование для проведения измерений, управления и 
лабораторного использования. Требования к электромагнитной совместимости, Часть 1: Общие 
требования. 

В дополнение к вышеприведенным стандартам безопасности и электромагнитной совместимости система 
CFX Connect прошла испытания и признана соответствующей требованиям IEC 61010-2-101: 
Электрооборудование для проведения измерений, управления и лабораторного использования. Часть 2-101: 
Частные требования к медицинскому оборудованию для диагностики in vitro (IVD). 

Настоящее оборудование создает, использует и может излучать радиочастотную энергию, а в случае его 
установки и эксплуатации без соблюдения требований, указанных в руководстве по эксплуатации, может 
создавать недопустимые помехи для средств радиосвязи. Эксплуатация данного оборудования в жилой зоне 
может вызывать помехи, и в этом случае пользователь должен устранить их за свой счет. 

Опасности 

Системы ПЦР реального времени с флуоресцентной детекцией CFX96 Touch, CFX96 Touch Deep Well, CFX 
Connect и CFX384 Touch рассчитаны на безопасную работу при условии эксплуатации ее в соответствии с 
инструкциями производителя. Если системы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect или CFX384 
Touch или любой из их компонентов используются не по назначению, предписанному производителем, 
уровень защиты, присвоенный системе, может быть снижен. Компания Bio-Rad Laboratories, Inc. не несет 
ответственность за повреждения, причиной которых стала эксплуатация данного оборудования образом, не 
предписанным производителем, или модификация прибора, произведенная лицом, не являющимся 
специалистом или уполномоченным представителем компании Bio-Rad. Обслуживание систем CFX96 Touch, 
CFX96 Touch Deep Well, CFX Connect или CFX384 Touch должно производиться только персоналом компании 
Bio-Rad. 

Биологическая опасность 

Системы ПЦР реального времени с флуоресцентной детекцией CFX96 Touch™, CFX96 Touch Deep Well™, 
CFX Connect™ и CFX384 Touch™ являются оборудованием, предназначенным для лабораторного 
использования. Тем не менее, при работе с биологически опасными образцами строго соблюдайте все 
правила техники безопасности и инструкции, а также местные инструкции и указания, принятые в вашей 
лаборатории. 

ОБЩИЕ ПРАВИЛА ТЕХНИКИ БЕЗОПАСНОСТИ 

• Всегда надевайте лабораторные перчатки, халаты и защитные очки с боковыми щитками или 
предохранительные очки 

• Не касайтесь руками рта, носа и глаз 

• Заклейте пластырем все царапины и ссадины перед работой с потенциально инфекционными 
материалами 

• После работы с потенциально инфекционными материалами, перед тем как покинуть лабораторию 
тщательно вымойте руки с мылом 

• Перед работой за лабораторным столом, снимите все украшения и наручные часы 

• Храните все инфекционные или потенциально инфекционные материалы в небьющихся герметичных 
контейнерах 

• Перед тем как покинуть лабораторию, снимите защитную одежду 

• Не пишите, не отвечайте на телефон, не включайте свет и не касайтесь никаких предметов руками в 
перчатках 

• Регулярно меняйте перчатки. При обнаружении на перчатках видимых загрязнений немедленно 
снимите их и выбросьте 

• Не подвергайте материалы, которые не могут быть продезинфицированы надлежащим образом, 
воздействия потенциально инфекционных материалов 

• По завершении работы с биологически опасными материалами продезинфицируйте рабочую зону 
соответствующим дезинфектантом (например, раствором хозяйственного отбеливателя 1:10) 
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• При нормальном режиме работы данного прибора биологически опасные вещества не выделяются 

ОЧИСТКА ПОВЕРХНОСТИ 

ВНИМАНИЕ! Для предотвращения удара электрическим током всегда выключайте и отключайте данный 

прибор от сети перед выполнением процедур очистки. 

Очистке любым бактерицидным, вируцидным или фунгицидным дезинфектантом для медицинского 
использования подлежат следующие поверхности: 

• Внешняя крышка и основание 
• Внутренняя поверхность и лунки блока для проведения реакций 
• Панель управления и дисплей 

Информация по подготовке и использованию дезинфицирующего средства приведена в инструкциях 
производителя продукции. Всегда несколько раз споласкивайте водой блок для проведения реакций и лунки 
блока для проведения реакций после использования дезинфектанта. После споласкивания тщательно 
вытрите блок и лунки блока. 

ВНИМАНИЕ! Не используйте абразивные или коррозионные детергенты или концентрированные щелочные 

растворы. Данные агенты могут поцарапать поверхность и повредить блок для проведения реакций, что 
приведет к снижению точности терморегуляции. 

УДАЛЕНИЕ БИОЛОГИЧЕСКИ ОПАСНЫХ МАТЕРИАЛОВ 

Системы ПЦР реального времени с флуоресцентной детекцией CFX96 Touch™, CFX96 Touch Deep Well™, 
CFX Connect™ и CFX384 Touch™ не содержат потенциально опасных химических материалов. Удаление 
нижеприведенных потенциально загрязненных материалов производите в соответствии с лабораторными, 
региональными и национальными нормами и правилами: 

• Клинические препараты 
• Реагенты 
• Использованные резервуары для проведения химических реакций или другие расходные материалы 

Химическая опасность 

Системы ПЦР реального времени с флуоресцентной детекцией CFX96 Touch™, CFX96 Touch Deep Well™, 
CFX Connect™ и CFX384 Touch™ не содержат потенциально опасных химических материалов. 

Опасность взрыва или воспламенения 

Системы CFX96 Touch™, CFX96 Touch Deep Well™, CFX Connect™ и CFX384 Touch™ не несут опасности 
взрыва или воспламенения при условии эксплуатации способом и в условиях, указанных компанией Bio-Rad 
Laboratories. 

Опасность поражения электрическим током 

Системы CFX96 Touch™, CFX96 Touch Deep Well™, CFX Connect™ и CFX384 Touch™ не несут опасности 
поражения электрическим током при условии правильной установки и эксплуатации, отсутствия внесенных 
физических изменений и подключения к источнику питания с надлежащими характеристиками. 
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Транспортировка 

Перед перемещением или транспортировкой термоциклера C1000 Touch или CFX Connect, или оптического 
реакционного модуля CFX96, CFX96 Deep Well, CFX Connect или CFX384 необходимо выполнить процедуры 
дезинфекции. Всегда перемещайте или транспортируйте основной блок термоциклера CFX Connect и 
оптический реакционный модуль CFX96, CFX96 Deep Well, CFX Connect или CFX384 в отдельных контейнерах 
с поставляемым упаковочным материалом для защиты оборудования от повреждений. Если соответствующие 
контейнеры отсутствуют, свяжитесь с местным представительством компании Bio-Rad. 

Хранение 

Хранение систем ПЦР реального времени с флуоресцентной детекцией CFX96 Touch™, CFX96 Touch Deep 
Well™, CFX Connect™ и CFX384 Touch™ производится в следующих условиях: 

• Диапазон температур: от -20 до 60°C 

• Относительная влажность: не более 80% 

Утилизация 

Системы ПЦР с флуоресцентной детекцией реального времени CFX96 Touch, CFX96 Touch Deep Well, CFX 
Connect и CFX384 Touch содержат электрооборудование; утилизация систем должна производиться отдельно 
в соответствии с требованиями к утилизации неотсортированных отходов, как указано в Директиве 
Европейского Союза об утилизации электрического и электронного оборудования 2002/96/CE (Директива 
WEEE). Перед утилизацией свяжитесь с местным представителем компании Bio-Rad для получения 
инструкций, ориентированных на конкретную страну. 



 

viii 

 



Руководство по эксплуатации систем ПЦР реального времени с флуоресцентной детекцией 
CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch 

ix 

Содержание 

Источники информации компании Bio-Rad. .............................................................................  ii 

Письменные условные обозначения, используемые в данном руководстве ........................  ii 

Соблюдение правил техники безопасности и установленных норм .....................................  iii 

Опасности...................................................................................................................................  v 

Содержание .....................................................................................................  ix 

Глава 1. Установка системы    .......................................................................  1 

Распаковка оптического реакционного модуля .......................................................................  1 

Системные требования .............................................................................................................  1 

Краткий обзор системы .............................................................................................................  2 

Установка и настройка системы ...............................................................................................  4 

Замена предохранителей .........................................................................................................  7 

Установка программного обеспечения CFX Manager .............................................................  8 

Файлы программного обеспечения ..........................................................................................  9 

Выполнение экспериментов....................................................................................................  10 

Глава 2. Программное обеспечение CFX Manager™ ...............................  13 

Главное окно программного обеспечения .............................................................................  14 

Мастер запуска Startup Wizard ................................................................................................  17 

Секция окна Detected Instruments (Обнаруженные приборы)...............................................  17 

Строка состояния .....................................................................................................................  19 

Окно Instrument Properties (Свойства прибора) .....................................................................  19 

Калькулятор Master Mix ...........................................................................................................  22 

Scheduler (Диспетчер) .............................................................................................................  23 

Глава 3. Выполнение экспериментов   ......................................................  27 

Окно Run Setup (Настройка параметров эксперимента) ......................................................  27 

Эксперименты PrimePCR ........................................................................................................  28 

Закладка Protocol (Протокол) ..................................................................................................  29 

Закладка Plate (Планшет) .......................................................................................................  29 

Закладка Start Run (Запустить эксперимент) .........................................................................  30 

Окно Run Details (Информация о ходе выполнения протокола) ..........................................  31 

Окно Instrument Summary (Сводка по приборам) ..................................................................  34 

Глава 4. Протоколы .......................................................................................  37 

Окно Protocol Editor (Редактор протоколов) ...........................................................................  37 

Элементы управления редактора протоколов ......................................................................  39 

Режим контроля температуры ................................................................................................  42 

Составитель протоколов Protocol AutoWriter  ........................................................................  43 



Содержание 

x 

Глава 5. Планшеты ........................................................................................  45 

Окно Plate Editor (Редактор планшетов) ................................................................................  45 

Мастер установки Setup Wizard ..............................................................................................  48 

Окно Select Fluorophores (Выбрать флуорофоры) ................................................................  50 

Опции загрузки лунок ..............................................................................................................  51 

Окно Experiment Settings (Настройки эксперимента) ............................................................  53 

Пункты контекстного меню селектора лунок .........................................................................  55 

Окно программы управления группами лунок Well Groups Manager ...................................  56 

Окно Plate Spreadsheet View (Электронная таблица планшета) ..........................................  57 

Глава 6. Автономная работа  .......................................................................  59 

Начальный экран .....................................................................................................................  60 

Run Setup (Настройка параметров эксперимента) ................................................................  60 

Экспорт данных для анализа ..................................................................................................  66 

Создание файла данных  ........................................................................................................  67 

Настройка параметров электронной почты ...........................................................................  67 

Глава 7. Краткое описание анализа данных .............................................  71 

Окно Data Analysis (Анализ данных) ......................................................................................  71 

Закладка Quantification (Количественный анализ) ................................................................  74 

Настройки анализа данных .....................................................................................................  75 

Селекторы лунок ......................................................................................................................  78 

Графики ....................................................................................................................................  81 

Электронные таблицы .............................................................................................................  82 

Экспорт .....................................................................................................................................  83 

Глава 8. Закладки окна Data Analysis  ........................................................  85 

Закладка Quantification (Количественный анализ) ................................................................  85 

Закладка Quantitation Data (Данные количественного анализа) ..........................................  89 

Закладка Melt Curve (Кривая плавления) ...............................................................................  92 

Закладка Melt Curve Data (Данные кривой плавления) .........................................................  93 

Закладка End Point (Конечная точка) .....................................................................................  96 

Закладка Allelic Discrimination (Дискриминация аллелей) .....................................................  98 

Закладка Custom Data View (Представление данных, задаваемое пользователем) .......  100 

Закладка QC (Контроль качества) ........................................................................................  101 

Закладка Run Information (Информация об эксперименте) ................................................  102 

Отчеты на основе файлов данных .......................................................................................  103 

Отчеты по группам лунок ......................................................................................................  106 



Руководство по эксплуатации систем ПЦР реального времени с флуоресцентной детекцией 
CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch 

xi 

Глава 9. Анализ экспрессии генов ............................................................  109 

Экспрессия генов .................................................................................................................... 109 

Задание параметров планшета для анализа экспрессии генов ......................................... 110 

Задание параметров планшета с инструкциями .................................................................. 110 

Гистограмма ............................................................................................................................ 111 

Кластерграмма ........................................................................................................................ 118 

Диаграмма рассеяния ............................................................................................................ 119 

График «вулкан» ..................................................................................................................... 120 

Карта нагрева .......................................................................................................................... 121 

Результаты .............................................................................................................................. 121 

Исследование генов ............................................................................................................... 122 

Окно Gene Study Report (Отчет об исследовании генов)..................................................... 124 

Расчеты экспрессии генов ..................................................................................................... 126 

Глава 10. Пользователи и установки   .....................................................  133 

Регистрация в системе или выбор пользователя  ............................................................... 133 

Окно User Preferences (Установки пользователя) ................................................................ 134 

User Administration (Управление пользователями) .............................................................. 142 

Глава 11. Ресурсы .......................................................................................  145 

Автоматическое обновление программного обеспечения и приборов ............................... 145 

Извлечение файлов данных из основного блока термоциклера ........................................ 146 

Интеграция системы LIMS ..................................................................................................... 146 

Программа калибровки Calibration Wizard ............................................................................ 151 

Техническое обслуживание прибора .................................................................................... 153 

Журнал приложения ............................................................................................................... 155 

Диагностика неисправностей ................................................................................................. 155 

Список литературы ................................................................................................................. 158 

Указатель ......................................................................................................  159 



Содержание 

xii 

 



Руководство по эксплуатации систем ПЦР реального времени с флуоресцентной детекцией 
CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch 

1 

1 Установка системы 

Ознакомьтесь с данной главой для получения информации по подготовке к работе и настройке 
системы CFX96 Touch™, CFX96 Touch Deep Well™, CFX Connect™ или CFX384 Touch™: 

• Распаковка оптического реакционного модуля (стр. 1) 

• Системные требования (стр. 1) 

• Краткий обзор системы (стр. 2) 

• Установка и настройка системы (стр. 4) 

• Установка программного обеспечения CFX Manager™ (стр. 8) 

• Файлы программного обеспечения (стр. 9) 

• Проведение экспериментов (стр. 10) 

Распаковка оптического реакционного модуля 

В комплект поставки оптического реакционного модуля CFX96™, CFX96 Deep Well™, CFX Connect 
или CFX384™ входят следующие компоненты: 

• Оптический реакционный модуль 

• USB-кабель 

• Установочный CD-диск с программным обеспечением CFX Manager 

• Руководство по эксплуатации 

• Инструкции по работе с программным обеспечением CFX Manager, включающие 
информацию по установке системы, работе с протоколами, анализу данных, анализу 
экспрессии генов и установке программного обеспечения qbase

PLUS
 

• Видеоруководство по работе с программным обеспечением CFX Manager 

Удалите весь упаковочный материал и храните его для использования в будущем. Если какая-
либо деталь отсутствует или повреждена, обратитесь в ваше региональное представительство 
компании Bio-Rad. 

Системные требования 

При эксплуатации системы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect или CFX384 Touch 
используйте источники питания и кабели со следующими характеристиками: 

• Входная мощность: 100-240 В перем. тока, 50-60 Гц 

• Использование в помещении: Окружающая температура: 15-31°C. Относительная 

влажность: макс. 80%, без конденсации 
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• USB-кабель: Если предусматривается управление системой с компьютера через USB-

кабель, кабель от Bio-Rad имеет надлежащее экранирование и подходит для 
использования в данных целях 

ПРИМЕЧАНИЕ: Полный перечень требований к безопасности и соответствию для данного 
прибора приведен в разделе «Соблюдение правил техники безопасности и установленных 
норм» на стр. iii. 

Краткий обзор системы 

Системы ПЦР реального времени с флуоресцентной детекцией CFX96 Touch™, CFX96 Touch 
Deep Well™, CFX Connect™ и CFX384 Touch™ состоят из двух компонентов: 

• Оптический реакционный модуль. Данный модуль включает оптическую систему для 

сбора данных флуоресценции и блок термоциклера. 

ПРИМЕЧАНИЕ: Серийные номера оптических реакционных модулей CFX96, CFX96 Deep 
Well, CFX Connect и CFX384 указаны на задней панели приборов. 

• Основной блок термоциклера C1000 Touch или CFX Connect. Основной блок 

термоциклера C1000 Touch включает пользовательский интерфейс для управления 
системой при работе в автономном режиме и кнопку и разъемы питания (на задней панели) 
для подключения к компьютеру. Основной блок термоциклера CFX Connect не оснащен 
пользовательским интерфейсом 

 

 

 

Светодиодный индикатор 

Кнопка открытия крышки 

Сенсорная панель 

Рис. 1. Система CFX96 Touch. Вид спереди 
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На Рис. 2 показаны компоненты систем CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и 
CFX384 Touch: 

 

Рис. 2. Система CFX96 Touch. Вид изнутри 
 

 

ВНИМАНИЕ! Избегайте контакта с внутренней крышкой или блоком: поверхности 

могут быть горячими. 

• Внутренняя крышка с нагревательной пластиной. Нагревательная крышка 

поддерживает температуру на поверхности расходных материалов для предотвращения 
испарения образца. Избегайте загрязнения нагревательной крышки касанием или каким-
либо другим способом. Не просовывайте что-либо через отверстия – это может повредить 
оптическую систему. 

• Блок. В блок загружаются образцы перед экспериментом. 

• Кнопка закрытия крышки. Нажмите данную кнопку для закрытия крышки, оснащенной 

электроприводом. 

ВНИМАНИЕ! Немедленно удаляйте все проливы для предотвращения загрязнения прибора 

и, ни при каких обстоятельствах, не проводите реакцию при открытой или имеющей утечку 
крышке. Информация по очистке и техническому обслуживанию прибора приведена в 
Разделе «Техническое обслуживание прибора» (стр. 153). 

Задняя панель основного блока термоциклера C1000 и CFX Connect включает следующие 
компоненты (Рис. 3): 

• Выключатель питания. Нажмите выключатель питания для включения питания системы 

• Разъем питания. Вставьте в разъем вилку шнура питания 

• Порт Ethernet. Подсоедините кабель Ethernet для отправки по электронной почте рабочих 

журналов и файлов автономных данных 

• USB-порты. Используйте данные порты для подключения системы CFX96 Touch, CFX96 

Touch Deep Well, CFX Connect или CFX384 Touch к компьютеру или для подключения 
термоциклера S1000™ (последнее невозможно для систем CFX Connect) 

 

Внутренняя крышка с 
нагревательной пластиной 

Блок 

Кнопка закрытия 
крышки 
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Рис. 3. Задняя панель термоциклера серии С1000 Touch 

 

ВНИМАНИЕ! Не касайтесь задней панели термоциклера C1000 Touch во время работы 

системы. 

Установка и настройка системы 

Систему ПЦР реального времени с флуоресцентной детекцией CFX96 Touch, CFX96 Touch Deep 
Well, CFX Connect или CFX384 Touch необходимо устанавливать на чистую, ровную, сухую, 
хорошо вентилируемую поверхность. Работа систем CFX96 Touch, CFX96 Touch Deep Well и 
CFX384 Touch осуществляется в двух режимах: в автономном и программно-управляемом. 
Система CFX Connect работает только в программно-управляемом режиме. При эксплуатации 
прибора в режиме управления с помощью программного обеспечения убедитесь в том, что во 
время настройки имеется достаточно места для компьютера. 

Для установки оптического реакционного модуля в отсек для модулей основного блока 
термоциклера C1000 Touch или CFX Connect выполните следующие действия: 

1. Установите основной блок системы C1000 Touch или CFX Connect на подготовленное место 
задвижкой вниз. Демонтируйте ранее установленные реакционные модули. 

 
 

Выключатель 
питания 

Разъем 
питания 

Порт 
Ethernet USB-порты 
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2. Поднимите оптический реакционный модуль, взяв его за выемки для рук над боковыми 
вентиляционными отверстиями (Рис. 4). 

 

Рис. 4. Установка оптического реакционного модуля в отсек для модулей 
основного блока термоциклера C1000 Touch 

3. Установите оптический реакционный модуль в отсек для модулей основного блока 
термоциклера C1000 Touch или CFX Connect, оставив впереди около 2 см свободного 
пространства. При правильной установке модуля в отсек логотип компании Bio-Rad на 
верхней передней панели основного блока термоциклера C1000 Touch или CFX Connect 
будет скрыт. 

 

Оптический 
реакционный 
модуль CFX96 

Основной блок 
термоциклера 
C1000 Touch 



Установка системы 

6 

4. Потяните на себя запорную планку в задней части основного блока термоциклера C1000 
Touch или CFX Connect, пока она не окажется на одном уровне с боковыми сторонами 
отсека. Модуль переместится вперед и зафиксируется (Рис. 5). 

 

Рис. 5. Фиксация оптического реакционного модуля 

5. Убедитесь в правильной и ровной посадке модуля в отсеке основного блока термоциклера 
C1000 Touch или CFX Connect. Проверьте зазор по периметру основания модуля. Между 
модулем и основным блоком не должно быть дополнительного пространства; зазор между 
модулем и основным блоком должен быть равномерным. 

6. Подключите шнур питания к разъему питания на задней панели основного блока 
термоциклера C1000 Touch или CFX Connect (Рис. 3) и к соответствующей электрической 
розетке. 

7. Нажмите выключатель питания на задней панели термоциклера C1000 Touch или CFX 
Connect для включения системы. 

8. Руководствуясь инструкциями на передней панели термоциклера C1000 Touch или на 
экране программного обеспечения CFX Manager (для системы CFX Connect), выньте 
красный транспортировочный крепежный винт из внутренней крышки. 

• Откройте крышку оптического модуля, нажав на кнопку под логотипом компании Bio-Rad. 

• Поверните винт против часовой стрелки для извлечения его из отверстия внутренней 
нагревательной крышки, расположение которого соответствует расположению лунки A1 для 
модулей CFX96, CFX96 Deep Well и CFX Connect или лунки, расположенной слева от B1, 
для модуля CFX384. 

9. Снимите с блока термоциклера транспортировочную платформу. 

10. Закройте крышку оптического модуля, нажав на кнопку, расположенную в передней части 
блока. 

11. Нажмите на кнопку Screw Removed (Винт извлечен) для подтверждения извлечения винта. 

ПРИМЕЧАНИЕ: Если на данном этапе транспортировочный винт не будет извлечен, это 
будет отражено на экране программного обеспечения CFX Manager. Выполните инструкции 
по снятию винта (стр. 20). 

СОВЕТ: Транспортировочный винт должен быть на месте при транспортировке модуля. 
Храните винт в безопасном месте до следующей транспортировки. 

 

Запорная планка 
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Замена предохранителей 

Предохранители, установленные в системах ПЦР реального времени с флуоресцентной 
детекцией CFX, предназначены для сгорания в случае резких скачков напряжения или 
возникновения других причин короткого замыкания. Данная функция защищает как пользователя, 
так и устройства от избыточного электрического разряда. 

Если система не включается, сначала необходимо убедиться, что шнур питания подключен к 
работающему источнику питания. Убедитесь, что спецификации шнура питания и источника 
питания соответствуют спецификациям прибора (см. бюллетень 6075 для CFX96 Touch, 
бюллетень 6238 для CFX96 Touch Deep Well, бюллетень 6102 для CFX Connect и бюллетень 6072 
для CFX384 Touch). Для замены шнура питания свяжитесь со службой технической поддержки 
компании Bio-Rad. 

В конце проверьте, что предохранители исправны. Системы ПЦР реального времени с 
флуоресцентной детекцией CFX оснащены двумя предохранителями. Для извлечения и проверки 
предохранителей выполните следующие действия: 

 

ВНИМАНИЕ! Для предотвращения удара электрическим током всегда отключайте и 

выключайте прибор из сетевой розетки перед проверкой предохранителей. 

1. Откройте крышку отсека для предохранителей небольшой отверткой с плоским жалом. 

2. Выньте красную коробку плавких предохранителей, осторожно вставив отвертку в верхнюю 
часть и мягко потянув на себя. Извлеките весь отсек. 

3. Если предохранитель повреждѐн, замените его новым предохранителем того же типа и 
закройте отсек. Перегоревший предохранитель имеет разрыв или прогар в металле. 
Исправный предохранитель имеет целостную металлическую поверхность. Убедитесь, что 
предохранитель вставлен двумя металлическими контактами к тыльной стороне отсека для 
предохранителей, но не вперед. 

 

Рис. 6. Коробка плавких предохранителей 

 

Коробка плавких 
предохранителей 
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Установка программного обеспечения CFX Manager 

Программное обеспечение CFX Manager работает на персональном компьютере (ПК) под 
управлением операционной системы Windows XP, Windows 7 или Windows 8 и используется для 
анализа данных ПЦР реального времени, полученных от системы CFX96 Touch, CFX96 Touch 
Deep Well, CFX Connect или CFX384 Touch. Программное обеспечение может также 
использоваться для управления системами в программно-управляемом режиме. В Таблице 6 
перечислены системные требования к программному обеспечению. 

Таблица 6. Системные требования к программному обеспечению CFX Manager 
 

Система Минимальные Рекомендуемые 

Операционная 
система 

Windows XP Professional SP2 и 
выше или Windows 7 Home 
Premium и выше 

Windows XP Professional SP3, Windows 7 
или Windows 8 

Дисковод CD-ROM CD-RW 

Жесткий диск 10 ГБ 20 ГБ (40 ГБ для Windows 7 и Windows 8) 

Тактовая частота 
процессора 

2.0 ГГц 2.0 ГГц, Dual Core 

Оперативная 
память 

1 ГБ RAM (2 ГБ для Windows 7) 2 ГБ RAM (4ГБ для Windows 7 и 
Windows 8) 

Разрешение экрана 1024 x 768 с 24-битовым 
кодированием цвета 

1280 x 1024 с 24-битовым кодирование 
цвета 

USB Высокоскоростной порт USB 2.0 Высокоскоростной порт USB 2.0 

Программное 
обеспечение 

PDF Reader Adobe PDF Reader и Win 8 PDF Reader, 
Microsoft Office Suite 2003/ 
2007/2010/2013 

Локализация Все ОС Windows 32/64-бит на 
английском, китайском и русском 
языках 

Все ОС Windows 32/64-бит на 
английском, китайском и русском языках 

Для установки программного обеспечения CFX Manager: 

1. Отключите от компьютера все приборы реального времени. 

2. Производить установку программного обеспечения на компьютер может только 
пользователь с правами администратора. Зарегистрируйтесь в системе как администратор. 

3. Поместите CD-диск с программным обеспечением CFX Manager в дисковод. 

4. Автоматически отобразится экран запуска программного обеспечения. Дважды щелкните на 
кнопке Install Software (Установить программное обеспечение) (Рис. 7). 

СОВЕТ: Щелкните на кнопке Documentation (Документация) для поиска PDF-копий 

руководств по эксплуатации прибора и другой документации. 

5. Выполните инструкции по установке на экране. По завершении на рабочем столе появится 
значок программного обеспечения CFX Manager. 

6. Если экран запуска не отобразился, дважды щелкните на (CD drive):\Bio-Rad CFX, откройте 

и выполните инструкции, приведенные в файле Readme.txt. См. «Установка программного 
обеспечения в ручном режиме» на стр. 156. 
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Рис. 7. Экран установки программного обеспечения 

Установка драйверов 

Если предполагается использование системы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect 
или CFX384 Touch в программно-управляемом режиме, необходимо произвести установку 

драйверов. Установка драйверов производится автоматически при использовании операционных 
систем Windows 7 и Windows 8. 

Для установки системных драйверов для Windows XP: 

1. Подключите основной блок термоциклера C1000 Touch или CFX Connect к компьютеру, 
подсоединив USB-кабель (с надлежащим экранированием, обеспечивающим защиту от 
потери данных) к USB-порту 2.0 A на задней панели основного блока термоциклера (Рис. 3) 
и к USB-порту 2.0 В компьютера. 

2. Если прибор еще не включился, включите систему, используя выключатель питания на 
задней панели основного блока термоциклера. 

3. Выполните инструкции на экране Found New Hardware Wizard (Обнаружено новое 
устройство), который отобразится после того, как прибор будет детектирован 

программным обеспечением. Выберите все представленные опции по умолчанию. 

ПРИМЕЧАНИЕ: Если система реального времени не появилась в секции окна Detected 
Instrument(s) (Обнаруженные приборы), проверьте USB-соединение и переустановите 
драйверы, выбрав Tools > Reinstall Instrument Drivers (Инструменты > Переустановить 
драйверы прибора) в меню главного окна программного обеспечения. 

Файлы программного обеспечения 

Программное обеспечение CFX Manager хранит данные экспериментов в специальных файлах 
(Таблица 7): 

Таблица 7. Откройте данные файлы программного обеспечения CFX Manager. 
 

Тип файла Расширение Инструкции по просмотру и редактированию файла 

Файл протокола .prcl Выберите файл в Run Setup (Настройка параметров 
эксперимента) и отредактируйте его в Protocol Editor 
(Редактор протоколов) 

Файл планшета .pltd Выберите файл в Run Setup и отредактируйте его в Plate 
Editor (Редактор планшетов) 

Файл данных .pcrd Просмотрите и проанализируйте файл в окне Data Analysis 
(Анализ данных) 

Файл PrimePCR .csv Содержит протокол и схему планшета для планшетов 
PrimePCR 



Установка системы 

10 

Таблица 7. Откройте данные файлы программного обеспечения CFX Manager (продолжение) 
 

Тип файла Расширение Инструкции по просмотру и редактированию файла 

Файл данных генных 
исследований 

.mgxd Просмотрите и проанализируйте файл в окне Gene Study 
(Генные исследования) 

Файл данных 
автономного 
анализа 

.zpcr Содержит данные флуоресценции автономного анализа, 
преобразованные в файл данных 

Файл LIMS .plrn Содержит настройки планшета и данные протокола, 
необходимые для выполнения LIMS-совместимого протокола 

Выполнение экспериментов 

Рекомендуемые расходные пластики 

Для получения оптимальных результатов компания Bio-Rad рекомендует использовать следующие 
расходные материалы для системы CFX384 Touch (каталожные номера выделены жирным 
шрифтом): 

• HSP-3805. Низкопрофильные 384-луночные планшеты Hard-Shell
®
 с прозрачной оболочкой 

и белыми лунками 

• HSP-3866. Низкопрофильные 384-луночные планшеты Hard-Shell
®
 с черной оболочкой и 

белыми лунками 

Системы CFX96 Touch, CFX 96 Touch Deep Well и CFX Connect совместимы с низкопрофильными 
планшетами и пробирками 2,0 мл. Для получения оптимальных результатов компания Bio-Rad 
рекомендует использовать следующие расходные материалы: 

• MLL-9601. Низкопрофильные 96-луночные планшеты с прозрачными лунками, без юбки 

• MLL-9651. Низкопрофильные 96-луночные планшеты с белыми лунками, без юбки 

• HSP-9601. 96-луночные планшеты Hard-Shell с белой оболочкой и прозрачными лунками, с 

юбкой 

• HSP-9655. 96-луночные планшеты Hard-Shell с белой оболочкой и белыми лунками, с юбкой 

• TLS-0801. Низкопрофильные стрипы на 8 пробирок 0,2 мл без крышек, прозрачные лунки 

• TLS-0851. Низкопрофильные стрипы на 8 пробирок 0,2 мл без крышек, белые лунки 

• TCS-0803. Оптически плоские стрипы с 8 крышками для пробирок и планшетов 0,2 мл 

ПРИМЕЧАНИЕ: С системой CFX96 Touch Deep Well также можно использовать 
высокопрофильные планшеты. 

Уплотнители для планшетов: 

• MSB-1001. Клейкие уплотнители Microseal
®
 'B', прозрачные (самоклеющиеся) 

• MSC-1001. Оптические уплотнители Microseal 'C', прозрачные (активируемые давлением) 

Приспособление для заклеивания планшетов: 

• 181-4000. Приспособление для заклеивания ПЦР-планшетов PX1™ 

Загрузка блока 

Для загрузки реагентов в блок: 

• Щелкните на кнопке Open Lid (Открыть крышку) в закладке Start Run (Запустить 

программу анализа) (см. «Закладка Start Run (Запустить эксперимент)» на стр. 30) или 
нажмите на кнопку открытия крышки на передней панели системы (Рис. 1) для открытия 
моторизованной крышки. 

• Поместите микропланшет или стрипы с пробирками 0,2 мл в блок. Убедитесь в 
герметичности крышек пробирок для предотвращения утечки. 
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Для достижения оптимальных результатов загружайте в систему CFX96 Touch или CFX 
Connect образцы объемом 10-25 мкл, в систему CFX96 Touch Deep Well – объемом 10-125 
мкл и в систему CFX384 Touch – объемом 5-20 мкл 

ПРИМЕЧАНИЕ: Для обеспечения точного анализа данных убедитесь, что реагенты 
расположены в блоке в соответствии со схемой загрузки планшета в закладке Plate 
(Планшет) (см. «Закладка Plate (Планшет)» на стр. 29). При необходимости отредактируйте 
схему загрузки планшета до, в течение или после анализа. 

ВНИМАНИЕ! При работе с системой CFX96 Touch, CFX96 Touch Deep Well или CFX Connect 

всегда обеспечивайте сбалансированность системы (Рис. 8). Например, при использовании 
одного стрипа в левой части блока устанавливайте в правой части стрип с пустыми 
пробирками (с крышками) для обеспечения равномерности давления, создаваемого 
нагретой крышкой. 

 

Стрип с 
заполненными 

пробирками 
 

 

Стрип с пустыми 
пробирками для 
балансировки 
 

Рис. 8. Уравновешивание нагрузки в блоке 

ВНИМАНИЕ! Убедитесь, что ничто не мешает закрытию крышки. Несмотря на то, что 

прибор оснащен предохранительным устройством, предотвращающим закрытие крышки 
при детектировании препятствия на пути закрытия, не помещайте что-либо на пути 
закрытия крышки. 

Выключение системы 

Для выключения системы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect или CFX384 Touch 
выполните следующие инструкции: 

• После эксперимента щелкните на кнопке открытия крышки (кнопка Open Lid в закладке Start 
Run) на передней панели системы для получения доступа к образцам, загруженным в 
термоциклер. 

• Выньте образцы и щелкните на кнопке закрытия крышки (Close Lid) для закрытия крышки 
системы. 

Нажмите выключатель питания на задней панели основного блока термоциклера C1000 Touch или 
CFX Connect для выключения системы. 
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2 Программное обеспечение 
CFX Manager

TM
 

В данной главе приведена информация по подготовке к работе с программным обеспечением 
CFX Manager. 

• Главное окно программного обеспечения (стр. 14) 

• Мастер запуска Startup Wizard (стр. 17) 

• Секция окна Detected Instruments (Обнаруженные приборы) (стр. 17) 

• Строка состояния (стр. 19) 

• Окно Instrument Properties (Свойства прибора) (стр. 19) 

• Калькулятор Master Mix (стр. 22) 

• Программа-диспетчер (стр. 23) 
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Главное окно программного обеспечения 

На Рис. 9 представлены функции главного окна программного обеспечения. 

 

Рис. 9. Главное окно программного обеспечения 

Строка меню 

В Таблице 8 перечислены пункты меню главного окна программного обеспечения. 

Таблица 8. Пункты меню главного окна программного обеспечения 
 

Пункт меню Команда Функция 

File (Файл) New (Новый) Создание нового протокола, планшета, эксперимента 
или программы исследования генов 

Open (Открыть) Открытие существующих файлов, включая файлы 
протоколов (.prcl), планшетов (.pltd), данных (.pcrd), 
файлов генных исследований (.mgxd), файлов LIMS 
(.plrn), файлов автономных анализов (.zpcr) и файлов 
анализов PrimePCR™ (.csv) 

Recent Data Files 
(Последние файлы 
данных) 

Просмотр перечня последних по времени 
просмотренных файлов данных и выбор одного из 
них для открытия в окне Data Analysis 

Repeat a Run 
(Повторить эксперимент) 

Открытие окна Run Setup с протоколом и планшетом 
прошлого эксперимента для быстрого повторного 
выполнения эксперимента 

Exit (Выход) Выход из программного обеспечения 
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Таблица 8. Пункты меню главного окна программного обеспечения (продолжение) 
 

Пункт меню Команда Функция 

View (Вид) Application Log 
(Журнал приложения) 

Отображение журнала приложения для программного 
обеспечения 

Run Reports (Отчеты о 
выполнении протоколов) 

Отображение списка отчетов о выполнении протоколов для 
выбора и просмотра требуемого отчета 

Startup Wizard (Мастер 
запуска Startup Wizard) 

Открытие программы запуска Startup Wizard 

Run Setup… (Настройка 
параметров эксперимента) 

Открытие окна Run Setup 

Instrument Summary 
(Сводка по приборам) 

Открытие окна Instrument Summary 

Detected Instruments 
(Обнаруженные приборы) 

Отображение или скрытие секции окна Detected Instruments 

Toolbar 
(Панель инструментов) 

Отображение или скрытие панели инструментов главного 
окна программного обеспечения 

Status Bar (Строка состояния) Отображение или скрытие строки состояния главного окна 
программного обеспечения 

Show (Отобразить) Открытие окна Block Status (Статус термоциклера), папки 
данных приложения, папки данных пользователя, папки с 
файлом LIMS, папки PrimePCR, статистики эксперимента 
или окна, отображающего свойства всех подключенных 
приборов 

User 
(Пользователь) 

Select User 
(Выбрать пользователя) 

Открытие окна Select User для смены пользователей 
программного обеспечения 

Change Password 
(Сменить пароль) 

Смена пароля пользователя 

User Preferences 
(Установки пользователя) 

Открытие окна User Preferences 

User Administration 
(Управление пользователями) 

Открытие окна User Administration для настройки доступа 
пользователей 

Run 
(Запустить 
протокол) 

User-defined Run 
(Эксперимент, определяемый 
пользователем) 

Открытие окна Run Setup для задания параметров 
эксперимента, определяемого пользователем 

PrimePCR Run 
(Эксперимент PrimePCR) 

Открытие окна Run Setup с заданным по умолчанию 
протоколом PrimePCR и схемой планшета, загруженной для 
выбранного прибора 

End Point Only Run 
(Анализ флуоресценции по 
конечной точке) 

Открытие окна Run Setup с заданным по умолчанию 
протоколом анализа флуоресценции по конечной точке 

Qualification Plate Run…  
(Протокол планшета для 
качественного анализа) 

Открытие окна Run Setup с заданным по умолчанию 
протоколом планшета для качественного анализа и схемой 
планшета, загруженной для выбранного прибора 

Инструменты Scheduler (Диспетчер) Открытие программы-диспетчера для резервирования 
прибора для использования 

Master Mix Calculator 
(Калькулятор Master Mix) 

Открытие калькулятора для подготовки общей реакционной 
смеси 

Protocol AutoWriter 
(Составитель протоколов 
Protocol AutoWriter) 

Открытие окна Protocol AutoWriter для создания нового 
протокола 

Ta Calculator (Калькулятор 
температуры отжига) 

Открытие окна Ta Calculator для расчета температуры 
отжига праймеров 

Dye Calibration Wizard 
(Программа калибровки 
Calibration Wizard) 

Открытие окна Dye Calibration для калибровки прибора для 
нового флуорофора 

Reinstall Instrument Drivers 
(Переустановить драйверы 
прибора) 

Переустановка драйверов, контролирующих связь с 
системами ПЦР реального времени Bio-Rad 

Zip Data and Log Files 
(Zip-данные и 
регистрационные файлы) 

Выбор и сжатие выбранных файлов в заархивированный 
файл для хранения или отправки по электронной почте 

Batch Analysis 
(Анализ партии) 

Задание параметров для режима одновременного анализа 
более одного файла данных 

Options (Опции) Конфигурирование настроек электронной почты и LIMS  
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Таблица 8. Пункты меню главного окна программного обеспечения (продолжение) 
 

Пункт меню Команда Функция 

Windows (Окна) Cascade 
(Расположить каскадом) 

Расположение окон на экране каскадом 

Tile Vertical (Расположить 
мозаикой по вертикали) 

Выстраивание в ряд всех открытых окон сверху вниз 

Tile Horizontal (Расположить 
мозаикой по горизонтали) 

Выстраивание в ряд всех открытых окон справа налево 

Close All (Закрыть все) Закрытие всех открытых окон программного обеспечения 

Help (Справка) Contents (Содержание) Открытие окна Help программного обеспечения, 
содержащего подробную информацию о текущей ПЦР и 
ПЦР реального времени 

Index (Указатель) Просмотр справочной информации в окне Help в виде 
списка 

Search (Поиск) Поиск справочной информации 

qPCR Applications & 
Technologies Web Site 
(Веб-сайт, посвященный 
областям применения и 
методам проведения 
количественной ПЦР) 

Открытие веб-сайта для поиска информации об анализах 
методом ПЦР реального времени 

PCR Reagents Web Site 
(Веб-сайт, посвященный 
реагентам для ПЦР) 

Просмотр веб-сайта, содержащего перечень реагентов для 
ПЦР и ПЦР реального времени от компании Bio-Rad 

PCR Plastic Consumables 
Website (Веб-сайт, 
посвященный пластиковым 
расходным материалам для 
ПЦР) 

Просмотр веб-сайта, предоставляющего перечень 
расходных материалов Bio-Rad для экспериментов с 
использованием ПЦР и ПЦР реального времени 

Software Web Site 
(Веб-сайт, посвященный 
программным средствам) 

Просмотр веб-сайта, содержащего перечень программного 
обеспечения для амплификации для ПЦР и ПЦР реального 
времени от компании Bio-Rad 

Check For Updates 
(Проверка обновлений) 

Проверка обновлений программного обеспечения или 
прибора 

About (О программе) Открытие окна для просмотра версии программного 
обеспечения 

Кнопки панели инструментов 

Кнопки панели инструментов главного окна программного обеспечения (Таблица 9) обеспечивают 
быстрый доступ к командам, реализуемым программным обеспечениям. 

Таблица 9. Кнопки панели инструментов главного окна программного обеспечения 
 

Кнопка Название кнопки Функция 

 

Открыть файл данных 
или файл данных 
исследований генов 

Открытие окна программы ускоренного просмотра для 
локализации файла данных (*.pcrd) и открытие файла в 
окне Data Analysis или локализации файла генных 
исследований (.mgxd) и открытие его в окне Gene Study 

 

Диспетчер Открытие программы-диспетчера для резервирования 
прибора для ПЦР 

 

Калькулятор Master Mix Открытие программы-калькулятора для задания 
параметров реакционных смесей 

 

Настройки эксперимента, 
определяемые 
пользователем 

Открытие окна Run Setup для задания параметров 
эксперимента 

 

Настройки эксперимента 
PrimePCR 

Открытие окна Run Setup с заданным по умолчанию 
протоколом PrimePCR и схемой планшета, загруженной 
для выбранного прибора 
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Таблица 9. Кнопки панели инструментов главного окна программного обеспечения 
(продолжение) 

 

Кнопка Название кнопки Функция 

 

Мастер запуска Startup 
Wizard 

Открытие программы Startup Wizard для подготовки, 
запуска и повтора эксперимента или анализа файла 
данных 

Мастер запуска Startup Wizard 

Мастер запуска Startup Wizard появляется автоматически после первого открытия программного 
обеспечения CFX Manager. Если программа не запустилась, щелкните на кнопке Startup Wizard 

панели инструментов главного окна программного обеспечения. 

Опции программы запуска Startup Wizard: 

• Run Setup (Настройка параметров эксперимента). Выберите соответствующий прибор в 

ниспадающем списке, отвечающий требованиям настроек планшета по умолчанию 
• User-defined (Определяемый пользователем) – задание параметров протокола и 

планшета для нового эксперимента в окне Run Setup (стр. 27) 
• PrimePCR – открытие окна Run Setup с заданным по умолчанию протоколом PrimePCR и 

схемой планшета (для выбранного прибора). Схемы планшетов для экспериментов 
PrimePCR могут использоваться во время выполнения эксперимента (стр. 34) или после 
завершения эксперимента (стр. 71) 

 

• Repeat Run (Повторить протокол). Задание параметров эксперимента с протоколом и 

схемой планшета проведенного эксперимента. При необходимости можно отредактировать 
параметры нового эксперимента 

• Analyze (Анализировать). Открытие файла данных для анализа результатов одного 

эксперимента (стр. 71) или файла исследования генов для анализа результатов нескольких 
экспериментов по исследованию генов (стр. 122) 

Секция окна Detected Instruments (Обнаруженные 
приборы) 

Подключенные приборы отображаются в секции окна Detected Instruments (Обнаруженные 
приборы) (Рис. 10). Данная секция приводит перечень приборов в виде значков, 

сопровождающихся серийными номерами (по умолчанию). Перечень приборов также отображает 
отдельные блоки (Блок A и Блок B) для каждого реакционного модуля с двойными блоками, 
установленного на термоциклере C1000 Touch™ или S1000™. 

Рис. 10 отображает четыре обнаруженных прибора: 

• один термоциклер C1000 (C48FSIM00) с двойным реакционным модулем 48/48 лунками 

• один термоциклер S1000 (S96FSIM01) с блоком на 96 лунок, подключенный к термоциклеру 
C1000 под именем C48FSIM00 

• одна система CFX384™(CFX384SIM03) 
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• одна система CFX96™ (CFX96SIM02) 

 

Рис. 10. Приборы, обнаруженные программным обеспечением и отображенные в секции 
окна Detected Instruments 

Щелкните правой кнопкой мыши на значке прибора или блока для выбора одной из следующих 
опций: 

• View Status (Отобразить статус). Откройте окно Run Details для проверки состояния 

выбранного блока прибора 

• Flash Block Indicator (Мигающий индикатор блока). Запускает режим мигания 

светодиодного индикатора выбранного прибора 

• Open Lid (Открыть крышку). Открывает моторизованную крышку выбранного блока 

прибора 

• Close Lid (Закрыть крышку). Закрывает моторизованную крышку выбранного блока 

прибора 

• Rename (Переименовать). Изменение имени прибора 

• Properties (Свойства). Открывает окно Instrument Properties 

• Collapse All (Свернуть все). Сворачивает перечень приборов в секции окна Detected 

Instruments 

• Expand All (Развернуть все). Разворачивает перечень приборов в секции окна Detected 

Instruments 

Вы также можете контролировать блок, щелкнув на значке блока прибора в секции окна Detected 
Instrument и затем – на кнопке в секции окна Selected Instrument (Выбранный прибор) (Рис. 11). 

 

Рис. 11 Кнопки в нижней части секции окна Detected Instruments 

• Щелкните на View Status для открытия окна Run Details для проверки состояния 

выбранного блока прибора 

• Щелкните на Open Lid для открытия моторизованной крышки выбранного прибора 

• Щелкните на Close Lid для закрытия моторизованной крышки выбранного прибора 

• Щелкните на View Summary (Отобразить сводку) для открытия окна Instrument Summary 
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Если обнаружен только один прибор, кнопка View Summary не отображается. Для просмотра 
информации по одному прибору в окне Instrument Summary выберите View > Instrument Summary 
(Вид > Сводка по приборам). 

Строка состояния 

В левой части строки состояния в нижней части главного окна программного обеспечения 
отображается текущее состояние всех подключенных приборов. Правая часть строки состояния 
содержит имя текущего пользователя, дату и время. Щелкните кнопкой мыши и «перетащите» 
нижний правый угол строки состояния для изменения размера главного окна. 

Окно Instrument Properties (Свойства прибора) 

Для открытия окна Instrument Properties, содержащего информацию о приборе, щелкните правой 
кнопкой мыши на значке прибора в секции окна Detected Instruments (Рис. 10). Окно содержит три 
закладки (Рис. 12): 

• Properties (Свойства). Отображает серийные номера и название термоциклера C1000 

Touch или CFX Connect 

• Shipping Screw (Транспортировочный винт). Удалите транспортировочный винт для 

работы с прибором или установите транспортировочный винт, если предусматривается 
транспортировка прибора 

• Calibrated Dyes (Калиброванные красители). Отображение перечня калиброванных 

флуорофоров 

 

Рис. 12. Окно Instrument Properties (Свойства прибора) 

Закладка Properties (Свойства) 

Именем прибора по умолчанию является серийный номер термоциклера C1000 Touch или CFX 
Connect, который отображается во многих местах, включая секцию окна Detected Instruments 
(Рис. 10). 

Для переименования прибора для облегчения идентификации выполните следующие инструкции: 
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• В закладке Instrument Properties введите имя в поле Rename в верхней части закладки и 
нажмите кнопку Rename для сохранения нового имени. 

Закладка Properties отображает важные серийные номера для подключенного прибора, включая 
термоциклер и реакционный модуль. Также отображаются версии встроенного программного 
обеспечения. 

Закладка Shipping Screw (Транспортировочный винт) 

Закладка Shipping Screw содержит инструкции по установке или демонтажу красного 
транспортировочного винта. Для предотвращения повреждения оптических реакционных модулей 
всегда устанавливайте транспортировочный винт при транспортировке системы CFX96 Touch, 
CFX96 Touch Deep Well, CFX Connect или CFX384 Touch. 

ПРИМЕЧАНИЕ: Если транспортировочный винт детектируется программным обеспечением, 
автоматически открывается окно Instrument Properties с выделенной закладкой Shipping 
Screw. Выполните инструкции по удалению винта. 

Информация в данной закладке меняется в зависимости от того, установлен транспортировочный 
винт или снят. Например, для установки транспортировочного винта щелкните на кнопке Install 
Shipping Screw (Установить транспортировочный винт) и выполните инструкции (Рис. 13). 

 

Рис. 13. Инструкции по установке транспортировочного винта 
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Закладка Calibrated Dyes (Калиброванные красители) 

Откройте закладку Calibrated Dyes для просмотра перечня калиброванных флуорофоров и 
планшетов для выбранного прибора (Рис. 14). Щелкните на кнопке Info (Информация) для 

отображения подробной информации о калибровке. 

 

Рис. 14 Закладка Calibrated Dyes (Калиброванные красители) 
в окне Instrument Properties (Свойства прибора) 
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Калькулятор Master Mix 

Для открытия калькулятора Master Mix щелкните на кнопке калькулятора Master Mix на панели 
инструментов (Таблица 9) или выберите Tools > Master Mix Calculator (Инструменты > 
Калькулятор Master Mix) в главном окне. 

 

Рис. 15. Окно Master Mix Calculator 

Для настройки калькулятора: 

1. Выберите метод детектирования с использованием или красителей SYBR
®
 Green/EvaGreen, 

или зондов. 

2. Отредактируйте имя мишени по умолчанию, выделив имя мишени в ниспадающем списке и 
набрав новое имя в поле Target (Мишень), после чего нажмите клавишу Enter на 

клавиатуре. 

3. Введите начальную и конечную концентрации для прямого и обратного праймеров и зондов. 

4. Дополнительные мишени добавляются щелчком кнопкой мыши на кнопке New (Новый). 

Для удаления мишеней выберите мишень из ниспадающего списка и щелкните на кнопке 
Remove (Удалить). 
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ВНИМАНИЕ! Удаление мишени из списка мишеней также удалит ее из расчетов, 

произведенных калькулятором. 

5. Отредактируйте параметры Supermix Concentration (Концентрация образцовой смеси), 
Reaction Volume Per Well (Объем реакционной смеси на лунку), Excess Reaction Volume 
(Избыточный объем реакционной смеси), Template Volume (Объем ДНК-мишени) и Number 
of Reactions (Количество реакций). 

6. Выберите кнопку-флажок рядом с мишенью (может быть выбрана только одна для общей 
реакционной смеси с красителями SYBR

®
 Green/ EvaGreen) или мишенями (для 

реакционных смесей для мультиплексных анализов с зондами). Рассчитанные объемы 
компонентов, необходимые для общей реакционной смеси, перечислены. 

7. Для распечатки таблицы расчетов щелкните на Print. 

8. Щелкните на кнопке Set as Default (Задать по умолчанию) для задания количества в 

секциях Target (Мишень) и Master Mix Setup (Параметры общей реакционной смеси) в 
качестве новых значений по умолчанию. 

9. Для сохранения настроек окна Master Mix Calculator щелкните на кнопке OK. 

Scheduler (Диспетчер) 

Для резервирования доступа к прибору (приборам) используйте программу диспетчера. Для 
открытия программы диспетчера щелкните на кнопке диспетчера на панели инструментов 
(Таблица 9) или выберите Tools > Scheduler (Инструменты > Диспетчер) в главном окне. 

 

Рис. 16. Главное окно программы диспетчера 
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Для установки диспетчера 

1. Первый раз при открытии диспетчера из программного обеспечения CFX Manager 
импортируются настройки пользователя, прибора и электронной почты SMTP. 

2. Для добавления нового прибора выберите View > Instrument Details (Вид > Информация о 
приборе) или щелкните на кнопке Manage Instruments (Управлять приборами) под 

перечнем Instruments (Приборы) (Рис. 16) в главном окне диспетчера. В окне Instrument 
Details (Информация о приборе) введите имя прибора в столбце Name (Имя). Выберите 
модель в ниспадающем меню или оставьте поле пустым для включения в него не 
перечисленных типов приборов. Ввод серийных номеров основного блока и оптического 
реакционного модуля является опциональным. 

3. Для добавления нового пользователя выберите View > User Details (Вид > Информация о 
пользователе) или щелкните на кнопке Manage Users (Управлять пользователями) под 

списком Users (Пользователи). В окне User Details (Информация о пользователе) (Рис. 17) 
введите новое имя пользователя в столбце Name. Можно ввести адрес электронной почты 
для возможности отправки электронных уведомлений. 

ПРИМЕЧАНИЕ: Требуется настройка SMTP-сервера для обеспечения возможности обмена 
электронными уведомлениями. 

 

Рис. 17. Окно User Details программы диспетчера 

4. Для удаления прибора или пользователя откройте соответствующее окно информации и 
выберите соответствующую кнопку-флажок в столбце Delete (Удалить). 

ВНИМАНИЕ! Все события, связанные с удаляемым прибором или пользователем, будут 

удалены из календаря. 

Строка меню диспетчера 

Пункты меню программы диспетчера перечислены в Таблице 10. 
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Таблица 10. Пункты меню диспетчера 
 

Пункт меню Команда Функция 

File (Файл) Print Preview 
(Предварительный 
просмотр перед 
печатью) 

Открытие окна предварительного просмотра для 
регулировка настроек печати 

 Print (Печатать) Печать изображения календаря с экрана 

 Exit (Выход) Выход из программы 

View (Вид) Instrument Details 
(Информация о 
приборе) 

Открытие окна Instrument Details для просмотра, 
редактирования, добавления или удаления имени, 
модели или серийного номера основного блока или 
оптического реакционного модуля 

 User Details 
(Информация о 
пользователе) 

Открытие окна User Details для просмотра, 
редактирования, добавления или удаления 
пользователей программы диспетчера 

 Log File 
(Регистрационный 
файл) 

Просмотр журнала операций программы диспетчера 

Tools 
(Инструменты) 

Import from CFX 
Manager 
(Импортировать из ПО 
CFX Manager) 

Импорт приборов, пользователей или настроек 
электронной почты SMTP из программного обеспечения 
CFX Manager 

 Cleanup Events 
(Очистить события) 

Удаление из календаря событий, срок хранения которых 
превысил период времени, заданный в окне Options 

 Options (Опции) Открытие окна для задания настроек календаря, 
создания значка рабочего стола, выбора функции 
запуска диспетчера при запуске системы или 
определения параметров календаря 

Планирование событий 

Для планирования события: 

1. Дважды щелкните кнопкой мыши на соответствующей ячейке календаря или щелкните 
правой кнопкой мыши и выберите New Event (Новое событие). 

2. Выберите прибор и пользователя из ниспадающего списка (Рис. 18). 

3. Отрегулируйте время начала и завершения. Как только событие заносится в календарь, его 
можно передвинуть в другой период времени щелчком и «перетаскиванием» события в 
новое место на календаре. 

4. Назначьте событию цвет (опционально). 

5. Для включения средства оповещения по электронной почте или всплывающего средства 
оповещения, которое будет появляться в заданное время до начала события, выберите 
кнопку-флажок Reminder (Средство оповещения) и выберите период времени 

предварительного уведомления в ниспадающем списке. 

ВНИМАНИЕ! Средства оповещения активны только при запущенной программе диспетчера. 

Уменьшение окна диспетчера позволит средству оповещения по электронной почте или 
всплывающему средству оповещения появляться в запланированное время. Для выхода из 
программы выберите Close (Закрыть). 
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Рис. 18. Окно планирования нового события программы диспетчера 

Очистка событий 

Выберите Tools > Cleanup Events (Инструменты > Очистить события) для удаления из 

календаря событий, срок хранения которых превысил период времени, заданный в окне Options 
(Рис. 19). 

ВНИМАНИЕ! Будут удалены все события старше указанной даты. 

Опции диспетчера 

Выберите Tools > Options (Инструменты > Опции) для определения экрана диспетчера, очистки 
и активации настроек. Щелкните на Restore Defaults (Восстановить исходные параметры) для 

восстановления настроек по умолчанию. 

 

Рис. 19. Окно Options программы диспетчера 
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3 Выполнение экспериментов 

В данной главе приведена информация о проведении экспериментов под управлением 
программного обеспечения CFX Manager: 

• Окно Run Setup (Настройка параметров эксперимента) (стр. 27) 

• Эксперименты PrimePCR™ (стр. 28) 

• Закладка Protocol (Протокол) (стр. 29) 

• Закладка Plate (Планшет) (стр. 29) 

• Закладка Start Run (Запустить эксперимент) (стр. 30) 

• Окно Run Details (Информация о ходе выполнения протокола) (стр. 31) 

• Окно Instrument Summary (Сводка по приборам) (стр. 34) 

Окно Run Setup (Настройка параметров эксперимента) 

Окно Run Setup предоставляет быстрый доступ к файлам и настройкам, необходимым для 
подготовки и выполнения эксперимента. Открыть окно Run Setup можно с помощью одной из 
следующих опций: 

• Щелкните на кнопке User-defined (Определяемый пользователем) или PrimePCR в 
закладке Run Setup программы Startup Wizard (стр. 17) 

• Щелкните на кнопке Настройки эксперимента, определяемые пользователем, или 
Настройки эксперимента PrimePCR на главной панели инструментов программного 

обеспечения (стр. 16) 

• Выберите File > New > User-defined Run (Файл > Новый > Определяемый 
пользователем) или PrimePCR Run (Эксперимент PrimePCR) главного меню 

программного обеспечения (стр. 14) 

Окно Run Setup содержит три закладки: 

• Protocol (Протокол). Щелкните на данной закладке для выбора существующего протокола 

для выполнения или редактирования или для создания нового протокола в окне Protocol 
Editor (стр. 37) 

• Plate (Планшет). Щелкните на данной закладке для выбора существующего планшета для 

использования в эксперименте или редактирования или для создания нового планшета в 
окне Plate Editor (стр. 45) 

• Start Run (Запустить эксперимент). Щелкните на данной закладке (стр. 30) для проверки 

настроек, выбора одного или нескольких блоков приборов и запуска эксперимента 

ПРИМЕЧАНИЕ: Если текущий протокол, выбранный в закладке Protocol, не включает этап 
прочтения планшета для анализа методом ПЦР реального времени, значит, закладка Plate 
скрыта. Для отображения закладки Plate выберите кнопку-флажок Plate Read (стр. 39) не 
менее чем для одного этапа протокола. 

ПРИМЕЧАНИЕ: Запустите новый эксперимент с предыдущим протоколом, выбрав File > 
Repeat a Run (Файл > Повторить эксперимент) в главном меню программного 
обеспечения или Repeat Run (Повторить эксперимент) в программе Startup Wizard. 

Выберите файл данных (.pcrd) для эксперимента, который Вы хотите повторить. 
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Откроется окно Run Setup с закладкой Protocol на первом плане (Рис. 20). Для открытия другой 
закладки выберите закладку или используйте кнопки Prev (Предыдущий) и Next (Следующий) в 

нижней части окна. 

 

Рис. 20. Окно Run Setup с закладками Protocol, Plate и Start Run 

Эксперименты PrimePCR 

Эксперименты PrimePCR используют реагенты, специфичные для конкретных заболеваний и 
метаболических путей, одобренные для использования при проведении экспериментов на 
практике и оптимизированные, поставляемые компанией Bio-Rad в следующих форматах: 

• Готовые панели. Планшеты с реагентами, специфичными для конкретных заболеваний 

или метаболических путей 

• Планшеты, конфигурируемые пользователем. Планшеты, конфигурируемые 

пользователем, с возможностью выбора реагентов для исследуемых мишеней, контролей и 
эталонов 

• Отдельные наборы. Пробирки с индивидуальными наборами праймеров для 

использования в реакциях реального времени 

Для запуска эксперимента PrimePCR выберите одну из следующих опций: 

• PrimePCR в закладке Run setup окна Startup Wizard 

• PrimePCR run (Эксперимент PrimePCR) из списка Recent Runs (Недавние эксперименты) 
закладки Repeat Run (Повторить эксперимент) окна Startup Wizard 

• File > New > PrimePCR run (Файл > Новый > Эксперимент PrimePCR) в главном окне 

• File > New > PrimePCR Run File (Файл > Новый > Файл PrimePCR) в главном окне 

• «Перетаскивание» файла PrimePCR в главное окно программного обеспечения CFX 
Manager 

После выбора эксперимента PrimePCR откроется окно Run Setup закладки Start Run с заданным 

по умолчанию протоколом эксперимента PrimePCR и схемой планшета для выбранного типа 
прибора. 

Для сокращения времени эксперимента можно удалить этап плавления, отменив выбор кнопки-
флажка рядом с Include Melt Step (Включить этап плавления) в закладке Protocol (протокол). 

Любые другие изменения протокола эксперимента PrimePCR не рекомендуются. Протокол по 
умолчанию использовался для валидации реагентов. Любые отклонения от данного протокола 
могут повлиять на результаты. Изменения протокола будут отмечены в закладке Run Information 
(Информация об эксперименте) результирующего файла данных и во всех создаваемых 

отчетах. 
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Для импорта информации по планшетам PrimePCR в схему планшета выберите Plate Setup > 
Apply PrimePCR File (Настройки планшета > Применить файл PrimePCR) в закладке Real-time 
Status (Статус ПЦР реального времени) (стр. 33) или в окне Data Analysis (Анализ данных) 

(стр. 71) и выберите соответствующий файл (.csv). Выберите данный файл поиском в папке 
PrimePCR по части имени файла или с помощью функции быстрого просмотра директории 
компьютера, в которую файл был загружен с веб-сайта Bio-Rad во время заказа планшета. 

Закладка Protocol (Протокол) 

Закладка Protocol отображает файл протокола, загруженный в окне Run Setup (Рис. 20). Файл 
протокола содержит данные по температуре прибора и опции прибора, контролирующие скорость 
изменения температуры и температуру крышки. 

Ниже приведены опции для выбора существующего протокола, создания нового протокола или 
редактирования текущего выбранного протокола: 

• Кнопка Create New (Создать новый). Открытие окна Protocol Editor для создания нового 

протокола 

• Кнопка Select Existing (Выбрать существующий). Открытие окна ускоренного просмотра 

для выбора и загрузки файла существующего протокола (.prcl) в закладку Protocol 

• Раскрывающееся меню Express Load (Быстрая загрузка). Быстрый выбор протокола для 

загрузки в закладку Protocol 

СОВЕТ: Для добавления или удаления протоколов в меню Express Load добавьте или 
удалите файлы (.prcl) в папку/из папки Express Load. Для доступа к папке выберите Tools > 
Show > User Data Folder (Инструменты> Отобразить > Папка данных пользователя) в 

главном меню программного обеспечения 

• Кнопка Edit Selected (Редактировать выбранный). Открытие текущего выбранного 

протокола в программе Protocol Editor 

Закладка Plate (Планшет) 

Закладка Plate отображает файл протокола, загруженный в окне Run Setup (Рис. 21). 
В экспериментах с использованием ПЦР реального времени файл планшета содержит данные по 
содержимому каждой лунки, режиму сканирования и типу планшета. Программное обеспечение 
CFX Manager использует эту информацию для сбора и анализа данных. 

Ниже приведены опции для выбора существующего планшета, создания нового планшета или 
редактирования текущего выбранного планшета: 

• Кнопка Create New (Создать новый). Открытие окна Plate Editor для создания нового 

планшета 

• Кнопка Select Existing (Выбрать существующий). Открытие окна ускоренного просмотра 

для выбора и загрузки файла существующего планшета (.prcl) в закладку Plate 

• Раскрывающееся меню Express Load (Быстрая загрузка). Быстрый выбор планшета для 

загрузки в закладку Plate 

СОВЕТ: Для добавления или удаления планшетов в меню Express Load добавьте или 
удалите файлы (.prcl) в папку/из папки Express Load. Для доступа к папке выберите Tools > 
Show > User Data Folder (Инструменты> Отобразить > Папка данных пользователя) в 

главном меню программного обеспечения. 
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• Кнопка Edit Selected (Редактировать выбранный). Открытие текущего выбранного 

планшета в программе Plate Editor 

 

Рис. 21. Экран закладки Plate 

Закладка Start Run (Запустить эксперимент) 

Закладка Start Run (Рис. 22) включает область для проверки данных протокола перед его 
запуском, включая выбранные файлы протокола и планшета, а также область для выбора блока 
прибора. 

• Секция окна Run Information (Информация об эксперименте). Данная закладка 

позволяет просматривать файлы протокола и планшета, а также настройки режима 
сканирования для сбора данных. Введите опциональные примечания относительно 
эксперимента в поле Notes (Примечания) 

• Секция окна Start Run on Selected Block(s) (Запустить анализ на выбранном блоке 
(блоках). Выберите один или несколько блоков, отредактируйте параметры анализа (при 
необходимости) и щелкните на кнопке Start Run для запуска эксперимента 
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Рис. 22. Закладка Start Run 

ПРИМЕЧАНИЕ: Вы можете обойти параметр Sample Volume (Объем образца), загруженный 
в файл протокола, выбрав объем в ячейке электронной таблицы и задав новый объем. 

ПРИМЕЧАНИЕ: Идентификатор анализа для каждого блока можно ввести, выбрав ячейку и 
набрав идентификатор или выбрав ячейку и отсканировав штрих-код при помощи 
считывателя штрих-кода. 

Для добавления или удаления параметров эксперимента в электронную таблицу/из электронной 
таблицы в секции Start Run on Selected Block(s) щелкните правой кнопкой мыши на списке и 

выберите опцию в меню. Выберите значение, которое Вы хотите изменить, щелкнув на тексте в 
ячейке (текст будет выделен) и вводом другого значения или выбором нового параметра из 
раскрывающегося меню. Редактируемые параметры: 

• Lid Temperature (Температура крышки). Выбор температуры крышки. Измените 

температуру крышки, заданную по умолчанию, выделив текст и набрав в ячейке новое 
значение температуры 

Кнопки управления прибором 

Для дистанционного управления выбранным прибором используйте следующие кнопки закладки 
Start Run: 

• Start Run (Запустить эксперимент). Запуск эксперимента на выбранных блоках 

• Flash Block Indicator (Мигающий индикатор блока). Запускает режим мигания 

светодиодного индикатора выбранного блока прибора 

• Open Lid (Открыть крышку). Открывает моторизованную крышку выбранных блоков прибора 

• Close Lid (Закрыть крышку). Закрывает моторизованную крышку выбранных блоков прибора 

Окно Run Details (Информация о ходе выполнения 
протокола) 

При щелчке на кнопке Start Run программное обеспечение CFX Manager выводит сообщение с 

информацией о необходимости сохранить имя файла данных и открывает окно Run Details. 
Информация, приведенная в данном окне, позволяет контролировать ход выполнения протокола. 

• Закладка Run Status (Статус протокола) Выберите текущий статус протокола, откройте 

крышку и приостановите эксперимент, добавьте повторы, пропустите этапы или остановите 
эксперимент 

• Закладка Real-Time Status (Статус ПЦР реального времени) Позволяет просматривать 

данные флуоресценции ПЦР по мере их сбора 

• Закладка Time Status (Время) Полноэкранный таймер обратного отсчета времени 

выполнения протокола 
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На Рис. 23 отображены функции окна Run Details. 

 

Рис. 23. Окно Run Details с закладкой Run Status 

Закладка Run Status (Статус протокола) 

Закладка Run Status (Рис. 23) отображает текущий статус выполняемого протокола в окне Run 
Details и содержит кнопки (ниже) управления крышкой и изменения выполняемого протокола. 

• Секция окна Run Status (Статус протокола). Отображает ход выполнения протокола 

• Кнопки секции окна Run Status. Щелкните на одной из кнопок для дистанционного 

управления прибором или прерывания текущего протокола 

• Секция окна Run Information (Информация об эксперименте). Отображает информацию 

об эксперименте 

Кнопки закладки Run Status 

Щелкните на одной из кнопок, перечисленных в Таблице 11, для управления прибором 
посредством программного обеспечения или изменения выполняющегося протокола. 
ПРИМЕЧАНИЕ: Изменение протокола во время его выполнения, например, добавление повторов, 
не изменяет файл протокола, связанный с выполняемым анализом. Все изменения 
регистрируются в рабочем журнале. 

Таблица 11. Кнопки закладки Run Status и их функции 
 

Кнопка Функция 

 

Открывает крышку с электроприводом выбранных приборов 
ВНИМАНИЕ! Открытие крышки во время выполнения протокола 

приостанавливает текущий этап протокола и может повлечь за 
собой изменение данных. 

 

Закрывает крышку с электроприводом выбранных приборов 

 

Добавляет повторы в текущий этап GOTO протокола. Данная 
кнопка активна только во время выполнения этапа GOTO. 
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Таблица 11. Кнопки закладки Run Status и их функции (продолжение) 
 

Кнопка Функция 

 

Пропускает текущий этап протокола. При пропуске этапа GOTO 
программное обеспечение подтверждает, что Вы хотите 
пропустить весь цикл GOTO и перейти к следующему этапу 
протокола. 

 

Переключает светодиодный индикатор выбранного прибора на 
режим мигающей индикации для идентификации выбранных 
блоков 

 

Приостанавливает выполнение протокола 
 
ПРИМЕЧАНИЕ: Данное действие регистрируется в рабочем 
журнале. 

 

Возобновляет выполнение приостановленного протокола 

 

Останавливает выполнение протокола до завершения анализа; 
может повлечь за собой изменение данных 

Закладка Real-Time Status (Статус ПЦР реального времени) 

Закладка Real-time Status (Рис. 24) отображает данные ПЦР реального времени, собранные в 
каждом цикле в ходе выполнения протокола после двух первых прочтений планшета. 

 

Рис. 24. Закладка Real-time Status отображает данные в ходе выполнения протокола 
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Редактирование настроек планшета 

Настройки планшета можно просмотреть и отредактировать в ходе эксперимента, выбрав 
View/Edit Plate (Отобразить/Редактировать планшет) в ниспадающем меню Plate Setup 
закладки Real-time Status (Рис. 24). Откроется окно Plate Editor, в котором можно будет 

отредактировать планшет в соответствии с инструкциями, приведенными в Главе 5 («Планшеты»). 

ПРИМЕЧАНИЕ: В окне Plate Editor также можно отредактировать внешний вид данных с 
отображением всех изменений на графике данных амплификации (в закладке Real-time 
Status). 

Замена файла планшета 

Замена файла планшета в процессе выполнения протокола производится выбором одного из 
нижеприведенных пунктов ниспадающего меню Plate Setup в закладке Real-time Status: 

• Replace Plate file (Заменить файл планшета) – Выберите новый файл планшета (.pltd) из 

списка в программе ускоренного просмотра 

• Apply PrimePCR file (Применить файл PrimePCR) – найдите файл протокола, из которого 

можно получить схему планшета, используя функцию Smart Search или щелкнув на кнопке 
Browse для поиска файла, загруженного с веб-сайта Bio-Rad и не находящегося в папке 

PrimePCR 

ПРИМЕЧАНИЕ: Программное обеспечение производит проверку режима сканирования и 
размера планшета для каждого файла планшета; они должны соответствовать настройкам, 
активированным во время эксперимента. 

СОВЕТ: Замена файла планшета – опция, особенно полезная, когда эксперимент 
выполняется с файлом быстрого доступа к данным планшета в папке Express Load. 

Закладка Time Status (Время) 

Закладка Time Status отображает таймер обратного отсчета времени выполнения текущего 
протокола. 

Окно Instrument Summary (Сводка по приборам) 

Окно Instrument Summary отображает перечень обнаруженных приборов и их статусы. Откройте 
закладку Instrument Summary, щелкнув на кнопке View Summary (Отобразить сводку) (Рис. 11 на 

стр. 18) в секции окна Detected Instrument. Щелкните правой кнопкой мыши в окне Instrument 
Summary для вывода на экран перечня опций. 

На Рис. 25 представлено окно Instrument Summary, содержащее закладку Block Name (Имя блока) 
с перечнем приборов и текущим состоянием каждого обнаруженного прибора. Выберите один или 
несколько блоков и с помощью кнопок на панели инструментов измените статус каждого прибора. 

 

Рис. 25. Окно Instrument Summary 
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Панель инструментов окна Instrument Summary 

Панель инструментов окна Instrument Summary содержит кнопки, функции которых перечислены в 
Таблице 12. 

Таблица 12. Кнопки панели инструментов окна Instrument Summary 
 

Кнопка Название кнопки Функция 

 

Задать параметры 
эксперимента 

Задание параметров эксперимента для 
выбранного блока в окне Run Setup 

 

Стоп Останавливает текущий протокол на 
выбранных блоках 

 

Приостановка Приостанавливает текущий протокол на 
выбранных блоках 

 

Возобновить Возобновляет выполнение протокола на 
выбранных блоках 

 

Мигающий индикатор 
блока 

Запускает режим мигания светодиодного 
индикатора на крышках выбранных блоков 

 

Открыть крышку Открывает крышку с электроприводом 
выбранного блока 

 

Закрыть крышку Закрывает крышку с электроприводом 
выбранного блока 

 

Скрыть выбранные блоки Скрывает выбранные блоки в перечне окна 
Instrument Summary 

 

Отобразить все блоки Отображает выбранные блоки в перечне 
окна Instrument Summary 

 

Отобразить Выберите, какие блоки будут отображены в 
перечне. Выберите одну из опций для 
отображения всех обнаруженных блоков, 
всех незадействованных блоков, всех 
блоков, с которыми работает текущий 
пользователь, или всех задействованных 
блоков 
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4 Протоколы 

В данной главе приведена информация по созданию и редактированию файлов протоколов: 

• Окно Protocol Editor (Редактор протоколов) (стр. 37) 

• Элементы управления программы Protocol Editor (стр. 39) 

• Режим контроля температуры (стр. 42) 

• Программа Protocol AutoWriter (Составитель протоколов) (стр. 43) 

Окно Protocol Editor (Редактор протоколов) 

Протокол содержит настройки, в соответствии с которыми прибор осуществляет контроль этапов 
температурных градиентов, температуры крышки и других параметров. Откройте окно Protocol 
Editor для создания нового протокола или редактирования текущего протокола, выбранного в 
закладке Protocol. После создания или редактирования протокола щелкните на кнопке OK для 

загрузки файла протокола в окно Experiment Setup и запуска протокола. 

Открытие редактора протоколов 

Открыть редактор протоколов можно с помощью одной из следующих опций: 

• Для создания нового протокола выберите File > New > Protocol (Файл > Новый > 
Протокол) или щелкните на кнопке Create New (Создать новый) в закладке Protocol 

(стр. 29) 

• Для открытия существующего протокола выберите File > Open > Protocol (Файл > Открыть 
> Протокол) или щелкните на кнопке Open Existing (Открыть существующий) в закладке 

Protocol (стр. 29) 

• Для редактирования текущего протокола в закладке Protocol щелкните на кнопке Edit 
Selected (Редактировать выбранный) в закладке Protocol (стр. 29) 

СОВЕТ: Для изменения настроек по умолчанию в окне Protocol Editor введите изменения в 
закладке Protocol окна User Preferences (стр. 136) 

Окно Protocol Editor (Редактор протоколов) 

Окно Protocol Editor (рис. 26) включает следующие функции: 

• Строка меню. Выбор настроек для протокола 

• Панель инструментов. Выбор опций для редактирования протокола 

• Protocol (Протокол). Просмотр выбранного протокола в графическом (сверху) и текстовом 

(снизу) представлениях. Для ввода значения щелкните на температуре или времени 
задержки на графическом или текстовом представлении любого этапа 
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• Кнопки редактора протокола. Редактирование протокола с помощью кнопок слева от 

текстового представления 

 

Рис. 26. Окно Protocol Editor с кнопками редактирования протоколов 

Строка меню редактора протоколов 

В Таблице 13 перечислены пункты меню окна Protocol Editor. 

Таблица 13. Строка меню редактора протоколов 
 

Пункт меню Команда Функция 

File (Файл) Save (Сохранить) Сохранение текущего протокола 

 Save As 
(Сохранить как…) 

Сохранение текущего протокола под новым именем или в 
новом местоположении 

 Close (Закрыть) Закрытие редактора протоколов 

Settings 
(Настройки) 

Lid Settings 
(Настройки 
крышки) 

Открытия окна Lid Settings для изменения или задания 
температуры крышки 

Tools 
(Инструменты) 

Gradient 
Calculator 
(Калькулятор 
температурного 
градиента) 

Выбор типа блока для этапа температурного градиента 

 Run time 
Calculator 
(Калькулятор 
времени 
выполнения 
эксперимента) 

Выбор количества лунок и режима сканирования для расчета 
предполагаемого времени выполнения эксперимента в окне 
Run Setup 
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В Таблице 14 перечислены функции кнопок панели инструментов редактора протоколов. 

Таблица 14. Кнопки панели инструментов редактора протокола 
 

Кнопка панели 
инструментов и 
меню 

Название Функция 

 

Save (Сохранить) Сохранение текущего файла протокола 

 

Print (Печатать) Печать выбранного окна 

 

Insert Step 
(Вставить этап) 

Выбор After (После) или Before (Перед) для вставки 

этапа относительно текущего выделенного этапа 

 

Объем образца Ввод объема образца от 0 до 50 мкл (для 96-луночного 
планшета) или от 0 до 30 мкл (для 384-луночного 
планшета). 
Объем образца определяет режим контроля температуры 
(стр. 42). Введите ноль (0) для выбора режима блока 

 
Est. Run Time 
(Предполагаемое 
время 
выполнения 
протокола) 

Отображение предполагаемого времени выполнения 
эксперимента, рассчитанного на основании этапов 
протокола и скорости линейного изменения температуры 

 

Help (Справка) Открытие справки для получения более подробной 
информации о протоколе 

Элементы управления редактора протоколов 

Окно Protocol Editor содержит кнопки для редактирования протоколов. Сначала выберите и 
выделите этап протокола щелчком на нем левой кнопкой мыши. Затем щелкните на одной из 
кнопок редактора протокола в нижней левой части окна Protocol Editor для изменения протокола. 
Место вставки нового этапа перед (Before) или после (After) текущего выбранного этапа 
определяется статусом поля Insert Step на панели инструментов. 

Кнопка Insert Step (Вставить этап) 

Для вставки этапа изменения температуры перед или после текущего выбранного этапа: 

1. Щелкните на кнопке Insert Step. 

2. Отредактируйте температуру или время выдержки, щелкнув кнопкой мыши на значении по 
умолчанию на графическом или текстовом представлении протокола, и набрав новое 
значение. 

3. (Опционально) Щелкните на кнопке Step Options (Опции этапов) для получения доступа к 

дополнительным опциям (стр. 42). 

Добавление или удаление этапа прочтения планшета 

Для добавления этапа прочтения планшета в этап или удаление из этапа: 

1. Выберите этап, щелкнув на нем на графическом или текстовом представлении протокола. 
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2. Щелкните на кнопке Add Plate Read to Step (Добавить прочтение планшета в этап) для 

добавления этапа прочтения планшета в выбранный этап. Если этап уже включает 
прочтение планшета, текст на кнопке изменится на Remove Plate Read (Удалить 
прочтение планшета). Щелкните на данной кнопке для удаления прочтения планшета из 

выбранного этапа. 

Кнопка Insert Gradient (Вставить температурный градиент) 

Для вставки этапа температурного градиента перед или после текущего выбранного этапа: 

1. Вставьте этап температурного градиента, щелкнув на кнопке Insert Gradient. 

2. Убедитесь, что размер планшета с учетом этапа градиента соответствует типу планшета 
прибора, 96-луночный или 384-луночный. Выберите размер планшета для градиента, 
выбрав Tools > Gradient Calculator (Инструменты > Калькулятор температурного 
градиента) в меню редактора протоколов. 

3. Отредактируйте диапазон температурного градиента, щелкнув кнопкой мыши на значении 
температуры по умолчанию на графическом или текстовом представлении протокола, и 
набрав новое значение температуры. Или щелкните на кнопке Step Options (Опции 
этапов) для ввода диапазона градиента в окне Step Options (Опции этапов) (стр. 42). 

4. Отредактируйте время выдержки, щелкнув кнопкой мыши на значении по умолчанию на 
графическом или текстовом представлении протокола, и набрав новое значение времени. 

Рис. 27 изображает вставленный этап температурного градиента. Температуры каждого ряда в 
градиенте нанесены на график в правой части окна. 

 

Рис. 27. Протокол с вставленным этапом температурного градиента 

Кнопка Insert GOTO (Вставить GOTO) 

Для вставки этапа GOTO перед или после текущего выбранного этапа: 

1. Щелкните на кнопке Insert GOTO. 
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2. Отредактируйте количество этапов GOTO, или количество повторов GOTO, щелчком 
кнопкой мыши на значении по умолчанию на графическом или текстовом представлении 
протокола и вводом нового значения. 

На Рис. 27 показано, что этап GOTO вставлен в конце протокола. Заметьте, что цикл GOTO 
включает этапы со 2 по 4. 

Кнопка Insert Melt Curve (Вставить кривую плавления) 

Для вставки этапа построения кривой плавления перед или после текущего выбранного этапа: 

1. Щелкните на кнопке Insert Melt Curve. 

2. Отредактируйте диапазон температур плавления или время повышения температуры, 
щелкнув кнопкой мыши на значении по умолчанию на графическом или текстовом 
представлении протокола и набрав новое значение. Или щелкните на кнопке Step Options 
(Опции этапов) для ввода диапазона градиента в окне Step Options (Опции этапов) 

(стр. 42). 

ПРИМЕЧАНИЕ: Этап построения кривой плавления не может быть вставлен в цикл GOTO. 

ПРИМЕЧАНИЕ: Этап построения кривой плавления включает 30 секунд выдержки в начале 
этапа, не отображаемых в протоколе. 

На Рис. 28 показано, что этап построения кривой плавления добавлен после этапа 6. 

 

Рис. 28. Протокол с вставленным этапом построения кривой плавления 

Опции этапов 

Для изменения опции выбранного этапа: 

1. Выберите этап, щелкнув на нем на графическом или текстовом представлении протокола. 

2. Щелкните на кнопке Step Options для открытия окна Step Options. 

3. Добавьте или удалите опции посредством ввода количества, редактирования количества 
или выбора кнопки-флажка. 

СОВЕТ: Для ввода бесконечного времени выдержки введите ноль (0.00). 
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На Рис. 29 отображен выбранный этап с температурным градиентом 10°C. Обратите внимание, 
что некоторые опции недоступны для выбора на этапе температурного градиента. Этап 
температурного градиента не может включать изменение скорости повышения или линейного 
изменения температуры. 

 

Рис. 29. Опции этапа температурного градиента 

ПРИМЕЧАНИЕ: На этапе температурного градиента в передней части планшета 
преобладает самая низкая температура (ряд H), а в тыльной части – самая высокая (ряд A). 

Окно Step Options содержит следующие опции, которые могут быть добавлены или удалены из 

этапов: 

• Plate Read (Прочтение планшета). Выберите данную кнопку-флажок для включение 

прочтения планшета 

• Temperature (Температура). Введите целевую температуру для выбранного этапа 

• Gradient (Температурный градиент). Введите диапазон температурного градиента для 

этапа 

• Increment (Повышение). Введите значение, на которое будет повышена температура 

выбранного этапа; данное значение будет добавляться к целевой температуре с каждым 
циклом 

• Ramp Rate (Скорость линейного изменения). Введите скорость для выбранного этапа; 

диапазон зависит от размера блока 

• Time (Время). Введите время выдержки для выбранного этапа 

• Extend (Продлить). Введите время, на которое будет продлен выбранный этап. Время 

продления добавляется к времени выдержки с каждым циклом 

• Beep (Звуковой сигнал). Выберите данную кнопку-флажок для подачи звукового сигнала в 

конце каждого этапа 

СОВЕТ: При вводе значения, не входящего в диапазон опций, программное обеспечение 
заменяет значение на ближайшее, входящее в заданный диапазон. 

Кнопка Delete Step (Удалить этап) 

Для удаления этапа протокола: 

1. Выберите этап на графическом или текстовом представлении протокола. 

2. Щелкните на кнопке Delete Step для удаления выбранного этапа. 

ВНИМАНИЕ! Отменить удаление невозможно. 

Режим контроля температуры 

Для определения момента достижения образцом целевой температуры прибор использует один из 
двух режимов контроля температуры. 

СОВЕТ: Объем образца можно изменить до начала эксперимента, отредактировав 
параметр Sample Volume в закладке Start Run (см. «Закладка Start Run (Запустить 
эксперимент)» на стр. 30). 

Введите объем образца в редакторе протоколов для выбора режима контроля температуры: 
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• Режим расчета температуры. При задании объема образца от 1 до 50 мкл (96-луночный 

планшет) или от 1 до 30 мкл (384-луночный планшет) термоциклер рассчитывает 
температуру образца на основании объема. Это стандартный режим 

• Режим температуры блока. Если значение объема образца составляет 0 (ноль) мкл, 

термоциклер регистрирует температуру образца как измеренную температуру блока 

Составитель протоколов Protocol AutoWriter 

Откройте составитель протоколов для быстрого составления протоколов экспериментов методом 
ПЦР и ПЦР реального времени. Открыть составитель протоколов можно с помощью одной из 
следующих опций: 

• Щелкните на кнопке Protocol AutoWriter на панели инструментов главного окна 

программного обеспечения 

• Выберите Tools > Protocol AutoWriter в меню главного окна программного обеспечения 

На Рис. 30 представлен протокол (в нижней части окна), составленный программой Protocol 
AutoWriter. 

 

Рис. 30. Окно Protocol AutoWriter с новым протоколом 

Создание протокола с помощью программы Protocol 
AutoWriter 

Для создания нового протокола с помощью программы Protocol AutoWriter выполните следующие 
действия: 

1. Щелкните на кнопке Protocol AutoWriter на панели инструментов для открытия окна 

Protocol AutoWriter. 

2. Введите температуру отжига в поле Annealing Temperature (Ta) (Температура отжига (Ta)) 
и длину ампликона в поле Amplicon Length (Длина ампликона) в области окна Enter Target 

Values/Enzymes (Ввести целевые значения/ферменты). Если вы не знаете температуру 
отжига для праймеров, щелкните на кнопке Ta Calculator (Калькулятор температуры 
отжига) для ввода последовательности праймера и расчета температуры отжига. 

Информация по расчетам с помощью калькулятора температуры отжига приведена в 
публикации Breslauer et al.1986. 
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3. Выберите тип фермента из списка (iTaq, DNA polymerase (ДНК-полимераза), или Other 
(Другой)). 

4. Добавьте параметры в области окна Additional Parameters (Optional) (Дополнительные 
параметры (опционально), если Вы хотите добавить в протокол диапазон температурного 

градиента (поле Gradient Range), температуру включения режима пуска из горячего 
состояния (поле Hot Start Activation) или время конечной элонгации (поле Final Extension). 

5. Выберите скорость выполнения протокола (Standard (Стандартная), Fast (Высокая) или 
Ultrafast (Сверхвысокая)) в области Type. По мере перемещения Вами ползунка 
программное обеспечение регулирует общее время выполнения протокола. Выберите Real-
time PCR (ПЦР реального времени) для программирования системы на сбор данных 

флуоресценции. 

6. Проверьте протокол в области Preview (Предварительный просмотр) и общее время 
выполнения протокола. Внесите необходимые изменения. 

СОВЕТ: Перед редактированием параметров в закладке Start Run введите температуру 
крышки и объем образца (см. «Закладка Start Run (Запустить эксперимент)» на стр. 30). 

7. Щелкните на OK для сохранения нового протокола или щелкните на Cancel (Отмена) для 

закрытия окна без сохранения протокола. 

СОВЕТ: Для редактирования протокола, составленного программой Protocol AutoWriter, 
откройте файл протокола (.prcl) в окне Protocol Editor (стр. 37). 

ПРИМЕЧАНИЕ: Компания Bio-Rad Laboratories не гарантирует, что выполнение протокола, 
составленного с помощью программы Protocol AutoWriter, всегда будет завершаться 
получением продукта ПЦР. 
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5 Планшеты 

В данной главе приведена информация по созданию и редактированию файлов планшетов: 

• Окно Plate Editor (Редактор планшетов) (стр. 45) 

• Мастер запуска Setup Wizard (стр. 48) 

• Окно Select Fluorophores (Выбрать флуорофоры) (стр. 50) 

• Опции загрузки лунок (стр. 51) 

• Окно Experiment Settings (Настройки эксперимента) (стр. 53) 

• Пункты контекстного меню селектора лунок (стр. 55) 

• Окно Well Groups Manager (Программа управления группами лунок) (стр. 56) 

• Окно Spreadsheet View (Электронная таблица планшета) (стр. 57) 

Окно Plate Editor (Редактор планшетов) 

Файл планшета содержит параметры анализа, такие как режим сканирования и флуорофоры, а 
также содержимое лунок, и приводит инструкции по анализу данных. Откройте окно Plate Editor 
для создания нового планшета или редактирования текущего планшета, выбранного в закладке 
Plate. После создания или редактирования файла планшета в окне Plate Editor щелкните на кнопке 
OK для загрузки файла планшета в окно Run Setup и запуска протокола. 

Для выполнения эксперимента методом ПЦР реального времени необходимо загрузить в 
программу Plate Editor минимальное требуемое количество необходимой информации. Как 
минимум одна лунка должна содержать загруженный образец соответствующего типа и 
флуорофор. 

СОВЕТ: Изменять содержание лунок можно до, в течение и после эксперимента. Тем не 
менее, режим сканирования и размер планшета не подлежат изменению в ходе или после 
выполнения анализа. 

Открытие редактора планшетов Plate Editor 

Открыть окно Plate Editor (Рис. 31) можно с помощью одной из следующих опций: 

• Для создания нового планшета выберите File > New > Plate (Файл > Новый > Планшет) 
или щелкните на кнопке Create New (Создать новый) в закладке Plate (стр. 29) 

• Для открытия существующего планшета выберите File > Open > Plate (Файл > Открыть > 
Планшет) или щелкните на кнопке Select Existing (Выбрать существующий) в закладке 

Plate (стр. 29) 

• Для редактирования текущего планшета в закладке Plate щелкните на кнопке Edit Selected 
(Редактировать выбранный) в закладке Plate (стр. 29) 

• Для открытия планшета, связанного с файлом данных, щелкните на Plate Setup на панели 
инструментов окна Data Analysis (стр. 71) и выберите View/Edit Plate 
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Рис. 31. Окно Plate Editor 

Строка меню редактора планшетов 

В Таблице 15 перечислены пункты меню окна Plate Editor. 

Таблица 15. Строка меню редактора планшетов 
 

Пункт меню Команда Функция 

File (Файл) Save (Сохранить) Сохранение файлов планшетов 

 Save As 
(Сохранить как…) 

Сохранение планшета под новым именем 

 Close (Закрыть) Закрытие редактора планшетов 

Settings 
(Настройки) 

Plate Size 
(Размер планшета). 

Выбор размера планшета, соответствующего размеру 
блока прибора. Выберите 384-луночный формат для 
системы CFX384 Touch™ или 96-луночный формат 

для системы CFX96 Touch™, CFX96 Touch Deep 
Well™ или CFX Connect™. ПРИМЕЧАНИЕ: Размер 
планшета должен соответствовать размеру блока 
прибора, в котором происходят реакции. 

 Plate Type 
(Тип планшета) 

Выбор типа лунок планшета, в которых размещаются 
образцы, включая белые и прозрачные. Для 
обеспечения точности анализа данных тип планшета 
должен соответствовать типу лунок планшета, 
используемых в эксперименте. ПРИМЕЧАНИЕ: Новые 
типы планшетов подлежат калибровке (стр. 151). 

 Number Convention 
(Правило концентрации) 

Выберите или отмените выбор экспоненциального 
представления единиц измерения концентрации 
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Таблица 15. Строка меню редактора планшетов (продолжение) 
 

Пункт меню Команда Функция 

 Units 
(Единицы измерения) 

Выберите единицы измерения, которые будут 
отображаться в электронных таблицах во время 
количественного анализа неизвестных образцов в 
сравнении со стандартной кривой 

Editing Tools 
(Инструменты 
редактирования) 

Setup Wizard 
(Мастер установки 
Setup Wizard) 

Определение схемы планшета и параметров анализа 
экспрессии генов 

 Spreadsheet 
View/Importer 
(Вид электронной 
таблицы/Импортер) 

Просмотр или импорт информации о мишени/образце 
посредством электронной таблицы 

 Flip Plate 
(Перевернуть планшет) 

Переворот содержимого планшета на 180° 

 

Help (Справка) Открытие справки для получения более подробной 
информации о планшетах 

Панель инструментов редактора планшетов 

Панель инструментов окна Plate Editor предоставляет быстрый доступ к важным функциям 
загрузки планшета: Таблица 16 содержит перечень доступных функций панели инструментов окна 
Plate Editor. 

Таблица 16. Кнопки панели инструментов редактора планшетов 
 

Кнопка панели 
инструментов и меню 

Название Функция 

 

Save (Сохранить) Сохранение текущего файла планшета 

 

Zoom 
(Изменить 
масштаб) 

Увеличение или уменьшение размера изображения 
планшета 

 

Режим 
сканирования 

Выберите режим сканирования для задания каналов, 
в которых будет производиться сбор данных 
флуоресценции в ходе выполнения эксперимента. 
Выберите All Channels (по умолчанию), SYBR/FAM 
only или FRET 

 

Well Groups 
(Группы лунок) 

Открытие окна программы управления группами лунок 
Well Groups Manager и задание групп лунок для 
текущего планшета 

 

Trace Styles 
(Внешний вид 
данных) 

Выбор цвета и графического обозначения данных 
амплификации 

 

Spreadsheet 
View/Importer 
(Электронная 
таблица/ 
Импортер) 

Просмотр или импорт информации о мишени/образце 
посредством электронной таблицы 

 

Plate Loading Guide 
(Руководство по 
загрузке планшета) 

Инструкции по заданию параметров планшета и 
загрузке лунок 
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Тип и размер планшета 

Программное обеспечение применяет следующие настройки ко всем лункам в ходе выполнения 
эксперимента: 

• Plate Size (Размер планшета). Выберите размер планшета, соответствующий размеру 

блока реакционного модуля вашего прибора. Выбор типа прибора (CFX96, CFX96 Deep 
Well, CFX Connect или CFX384) в ниспадающем меню в программе Startup Wizard изменит 
размер планшета, заданный по умолчанию в закладке Plate окна Run Settings. В окне Plate 
Editor выберите размер планшета в меню Settings (Таблица 15). Размер планшета не 
подлежит изменению в процессе или после выполнения эксперимента. 

• Plate Type (Тип планшета). Выберите Clear Wells (Прозрачные лунки) или White Wells 
(Белые лунки) под пунктом Plate Type в меню Settings. Убедитесь, что флуорофор, 

используемый в эксперименте, откалиброван под выбранный тип планшета. 

ПРИМЕЧАНИЕ: Приборы CFX96, CFX96 Deep Well, CFX Connect и CFX384 откалиброваны 
на заводе-изготовителе под множество комбинаций флуоресцентных красителей и 
планшетов. Калибровка специфична для прибора, красителя и типа планшета. Для 
калибровки прибора под новую комбинацию красителя и планшета выберите Tools > 
Calibration Wizard (см. «Программа калибровки Calibration Wizard» на стр. 151) 

Режим сканирования 

Системы CFX96 Touch и CFX96 Touch Deep Well возбуждают и детектируют флуорофоры в шести 
каналах. Система CFX Connect возбуждает и детектирует флуорофоры в трех каналах. Система 
CFX384 Touch возбуждает и детектирует флуорофоры в пяти каналах. Все системы используют 
множество режимов сканирования каналов сбора данных для сбора данных флуоресценции в 
ходе выполнения анализа. 

Выберите один из режимов сканирования на панели инструментов окна Plate Editor: 

• All Channels (Все каналы). Включает каналы с 1 по 5 на системах CFX96 Touch и CFX96 

Touch Deep Well, каналы 1 и 2 на системе CFX Connect и каналы с 1 по 4 на системе 
CFX384 Touch 

• SYBR/FAM only (Только SYBR/FAM). Включает только канал 1 и обеспечивает быстрое 

сканирование 

• FRET. Включает только канал FRET и обеспечивает быстрое сканирование 

Внешний вид данных 

Во время задания параметров планшета и проведения эксперимента можно изменить цвет данных 
амплификации. Цвета отображаются по мере сбора данных, и выделенные цветом кривые можно 
увидеть в окне Real-time Status. Более подробная информация приведена на стр. 86. 

Мастер установки Setup Wizard 

Программа установки Setup Wizard может использоваться для ввода информации о схеме 
планшета, необходимой для анализа нормализованной экспрессии генов, до, во время или после 
эксперимента. В данном окне можно ввести имена мишени и образца, и задать их позиции на 
планшете, а также ввести референсный ген и контрольный образец. 



Руководство по эксплуатации систем ПЦР реального времени с флуоресцентной детекцией 
CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch 

49 

Программу Setup Wizard (Рис. 32) можно открыть, выбрав Editing Tools > Setup Wizard 
(Инструменты редактирования > Setup Wizard) в меню окна Plate Editor. 

 

Рис. 32. Закладка Auto layout (Автоматическое конфигурирование планшета) 
окна Setup Wizard 

Создайте схему планшета, руководствуясь следующими инструкциями: 

1. Закладка Auto layout (Автоматическое конфигурирование планшета). Выберите на 

планшете зону расположения образцов, щелкнув на линии границы лунки и «перетащив» 
рамку, охватывая требуемое количество лунок. Введите количество мишеней и образцов, 
которые будут загружены. Если введенные количества не соответствуют выбранной 
области, необходимо их уменьшить или увеличить область. Можно выбрать ориентацию 
компонентов на планшете и сгруппировать их. 

ПРИМЕЧАНИЕ: Если Ваша схема планшета не имеет регулярной структуры, используйте 
закладку Target names (Имена мишеней) для размещения мишеней на планшете в ручном 

режиме. Выберите несколько лунок щелчком кнопкой мыши и «перетаскиванием» рамки. 

2. Закладка Target names (Имена мишеней). Щелкните на группе мишеней и введите ее имя 

в поле. Можно выбрать несколько групп мишеней щелчком кнопкой мыши и 
«перетаскиванием». 

СОВЕТ: После ввода имени нажмите Tab для перехода к следующей группе справа или 
Enter для перехода следующей группе снизу. 

3. Закладка Sample names (Имена образцов). Щелкните на группе образцов и введите ее 

имя в поле. Можно выбрать несколько групп образцов щелчком кнопкой мыши и 
«перетаскиванием». 

СОВЕТ: При вводе имен мишеней или образцов для выбора групп лунок, не являющихся 
соседними, щелкните кнопкой мыши и удерживайте клавишу CTRL. 

4. Закладка Reference targets (Референс-мишени). Щелкните на одной или нескольких 

мишенях для использования их в качестве референс-мишеней для нормализованной 
экспрессии генов. 
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5. Закладка Control sample (Контрольный образец). Щелкните на образце для 

использования его в качестве контроля для расчетов относительной экспрессии генов. 

6. Щелкните на OK для подтверждения введенных данных. Отредактировать схему планшета 
можно с помощью программы Plate Editor. 

ПРИМЕЧАНИЕ: Возврат к закладке Auto layout произведет сброс настроек схемы 
планшета. Сброс настроек схемы планшета также можно произвести, выбрав Tools > Clear 
Plate (Инструменты > Очистить планшет). 

СОВЕТ: Для обеспечения удобочитаемости текста в лунках схемы планшета 
воспользуйтесь опцией Zoom plate (Изменить масштаб изображения). 

Окно Select Fluorophores (Выбрать флуорофоры) 

Окно Select Fluorophores содержит перечень флуорофоров, которые могут быть выбраны для 
задания параметров загрузки планшета. Для открытия окна Select Fluorophores щелкните на 
кнопке Select Fluorophores в правой части окна Plate Editor. 

ПРИМЕЧАНИЕ: Перечисленные флуорофоры зависят от режима сканирования; при выборе 
режима SYBR/FAM only в окне Select Fluorophores будут отображены только флуорофоры 
для канала 1. 

ПРИМЕЧАНИЕ: Добавление флуорофоров к перечню или удаление их из перечня 
невозможно; сначала необходимо выполнить калибровку новых флуорофоров с помощью 
программы калибровки Calibration Wizard (стр. 151). После калибровки новые флуорофоры 
будут добавлены в окно Select Fluorophore. 

Выберите или отмените выбор кнопки-флажка Selected (Выбранный) рядом с именем 

флуорофора в правой части окна Plate Editor для добавления в список или удаления из списка 
флуорофоров. 

В данном примере из списка доступных флуорофоров выбраны несколько красителей (Рис. 33). 

 

Рис. 33. Окно выбора флуорофоров Select Fluorophores 

• Щелкните на окошке под заголовком Color (Цвет) рядом с именем флуорофора и выберите 

новый цвет представления флуорофора в окне Plate Editor и на графиках окна Data Analysis. 

ПРИМЕЧАНИЕ: Перед началом эксперимента программное обеспечение произведет 
проверку всех флуорофоров, указанных в планшете, на предмет калибровки. Если планшет 
содержит флуорофоры, откалиброванные на другом приборе, программное обеспечение не 
запустит эксперимент. 
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Опции загрузки лунок 

Файл планшета содержит информацию о содержимом каждой лунки с образцом. После 
эксперимента программное обеспечение свяжет содержимое лунок с данными флуоресценции, 
собранными в ходе выполнения протокола, и произведет соответствующие анализы в окне Data 
Analysis. Например, лунки, содержащие стандартные образцы, используются для построения 
стандартной кривой. 

При задании параметров анализа экспрессии генов руководствуйтесь следующими инструкциями 
по загрузке лунок: 

• Target Name (Имя мишени). Одна или несколько мишеней (гены или последовательности) 

в каждой загруженной лунке. Каждая мишень назначается одному флуорофору 

• Sample Name (Имя образца). Один идентификатор или состояние, соответствующее 

образцу в каждой лунке, такие как 0 hr, 1 hr или 2 hr 

СОВЕТ: Имена мишеней и имена образцов должны согласовываться между лунками для 
обеспечения возможности сравнения данных в закладке Gene Expression окна Data Analysis. 
Все имена должны иметь одинаковую пунктуацию и пробелы. Например, «Actin» (актин) – не 
то же самое, что «actin», и «2hr» и «2 hr» - разные имена. Для обеспечения согласованности 
в именах введите их в библиотеки имен мишеней и образцов в закладке Plate окна User 
Preferences (стр. 137) 

• Biological Set Name (Имя биологического набора). Выберите View > Show Biological Set 
Name (Вид > Отобразить имя биологического набора) для отображения данной секции в 

опциях загрузки лунок и затем введите имена для одной или нескольких лунок 

Выберите лунку для загрузки в нее содержимого, щелкнув левой кнопкой мыши на изображении 
планшета. Для выбора нескольких лунок: удерживая кнопку мыши, «перетащите» границы, 
охватывая требуемое количество лунок. Кнопки и списка в правой части изображения планшета 
выключают все опции, необходимые для загрузки лунок (Таблица 17). 

Таблица 17. Опции загрузки планшета и лунок в окне Plate Editor 
 

Опция Функция 

 

После выбора лунок необходимо сначала выбрать тип 
образца. Выберите Sample Type (Тип образца) из 

ниспадающего меню для загрузки образца 
соответствующего типа в выбранные лунки, включая 
Unknown (Неизвестный), Standard (Стандарт), NTC (ДНК-
мишень отсутствует), Positive Control (Положительный 
контроль), Negative Control (Отрицательный контроль) и NRT 
(Обратная транскриптаза отсутствует). 

 

Выберите кнопку-флажок Load (Загрузить) для добавления 

флуорофора в выбранные лунки; каждый флуорофор 
соответствует имени мишени. Для добавления 
флуорофоров в список Load выберите их в окне Select 
Fluorophores. 
 
Для анализа экспрессии генов или проведения различия 
между мишенями выберите имя в ниспадающем меню 
Target Name (Имя мишени) и нажмите клавишу Enter для 

загрузки имени мишени в лунку. Для удаления имени 
мишени выберите имя, нажмите клавишу Delete и затем – 
клавишу Enter. 
 
СОВЕТ: Для добавления нового имени мишени в 
ниспадающее меню (только для текущего планшета) 
введите имя в ниспадающий список и нажмите клавишу 
Enter. 
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Таблица 17. Опции загрузки планшета и лунок в окне Plate Editor (продолжение) 
 

Опция Функция 

 

Для анализа экспрессии генов или проведения различия 
между образцами выберите имя образца из ниспадающего 
меню для загрузки его в выбранные лунки. Для удаления 
имени образца выберите его в меню, нажмите клавишу 
Delete и затем – клавишу Enter. 
 
СОВЕТ: Для добавления нового имени образца в 
ниспадающее меню (только для текущего планшета) 
введите имя в ниспадающий список и нажмите клавишу 
Enter. 

 

Для загрузки количества дубликатов выбранные лунки 
должны иметь идентичное содержимое. Если это не так, 
программное обеспечение деактивирует данную опцию. 
 
Выберите кнопку-флажок Load для добавления количества 
дубликатов к выбранным лункам. Щелкните на Clear 
Replicate # (Удалить дубликат №) для удаления номеров 

дубликатов из выбранных лунок. 
 
СОВЕТ: Для загрузки множества номеров дубликатов в ряд 
лунок щелкните на кнопке Replicate Series (Ряд 
дубликатов). 

 

В области Replicate Series (Ряд дубликатов) Вы можете 

добавить ряд дубликатов к множеству выбранных лунок. 
Введите размер группы дубликатов в поле Replicate Group 
Size (Размер группы дубликатов), выбрав количество, 

соответствующее количеству образцов (лунок) в каждой 
группе дубликатов. Выберите Starting Replicate # 
(Дубликат №) для добавления дубликатов. 
 
ПРИМЕЧАНИЕ: Вы можете загрузить группы дубликатов с 
номерами дубликатов в порядке возрастания слева направо 
(Horizontal) или сверху вниз (Vertical). 

 

Введите концентрацию в выбранные лунки со стандартными 
образцами, отредактировав или набрав значение в поле 
Concentration (Концентрация). Для назначения 

концентрации одному флуорофору в лунке выберите один 
флуорофор в ниспадающем меню (<AII>) под полем 
Concentration. Для удаления значения концентрации 
выберите его в меню, нажмите клавишу Back Space и затем 
– клавишу Enter. 
 
Выберите лунки со стандартными образцами для активации 
кнопки Dilution Series (Серия разведений). 
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Таблица 17. Опции загрузки планшета и лунок в окне Plate Editor (продолжение) 
 

Опция Функция 

 

Щелкните на кнопке Dilution Series для ввода количества 

разведений для выбранной концентрации стандартных 
образцов и загрузите стандартную кривую. 
 
Введите начальную концентрацию в поле Starting 
Concentration (Начальная концентрация) для серии 
разведений, начальный номер дубликата в поле Replicates 
from (Начать с), конечный номер дубликата в поле to (по) и 
коэффициент разведения в поле Dilution Factor 
(Коэффициент разведения) (значение изменения 

концентрации с каждой группой дубликатов). Выберите 
Increasing (Увеличение) для увеличения количества 
разведений или Decreasing для уменьшения количества 

разведений. В конечном итоге выберите флуорофор в 
ниспадающем меню, используемый для серии разведений, и 
щелкните на Apply (Применить). 

 

Выберите Well Notes (Примечания к лункам) в нижней 

части для отображения секции ввода примечаний к лункам. 
Введите примечания к одной или нескольким лункам, 
выбрав лунки и набрав примечания в ниспадающем меню. 
Все добавляемые примечания появляются в электронной 
таблице в закладке Quantitation Data (Данные 
количественного анализа). 

 

Выберите Biological Set Name (Имя биологического 
набора) в нижней части для отображения данной секции. 

Введите информацию по биологическому набору одной или 
нескольких лунок, выбрав лунки и набрав имя набора в 
ниспадающем меню. Ввод имен биологических наборов 
позволяет осуществлять анализ образцов в одной из 
четырех конфигураций, определенных функцией Biological 
Set Analysis Options (Опции анализа на основании 
биологических наборов). 

 

Щелкните на кнопке Experiment Settings для открытия окна 

Experiment Settings, предоставляющего опции управления 
списками мишеней и образцов, и задания параметров 
анализа экспрессии генов. 

 

Щелкните на Clear Replicate # (Удалить дубликат №) для 

удаления номеров дубликатов из выбранных лунок. 

 

Щелкните на Clear Wells (Очистить лунки) для удаления 

всего содержимого выбранных лунок. 

ПРИМЕЧАНИЕ: Содержимое лунок также можно копировать и «вставлять» в другие лунки. 
Для этого выделите лунку, содержимое которой Вы хотите скопировать (за один раз можно 
скопировать содержимое только одной лунки), щелкните правой кнопкой мыши и выберите 
Copy Well (Копировать лунку). Выделите лунки, в которые Вы хотите «вставить» 
содержимое, и выберите Paste Well (Вставить в лунку). Нажмите и удерживайте клавишу 

CTRL для выбора раздельных лунок. 

Окно Experiment Settings (Настройки эксперимента) 

Открыть окно Experiment Settings можно с помощью одной из следующих опций: 

• В окне Plate Editor щелкните на кнопке Experiment Settings (Настройки эксперимента) 

• В процессе анализа данных в окне Data Analysis щелкните на кнопке Experiment Settings в 
закладке Gene Expression (Экспрессия генов) 
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Откройте окно Experiment Settings для просмотра или изменения списков мишеней и образцов 
(Рис. 34) или задания группы образцов для анализа экспрессии генов, если к лункам добавлены 
имена биологических наборов. 

• Targets (Мишени). Список имен мишеней для каждой ПЦР, таких как исследуемые гены или 

последовательности. Щелкните на столбце Reference (Референсный) для включения в 
эксперимент референсных генов 

• Samples (Образцы). Список имен образцов, индицирующих источник мишени, такой как 

образец, взятый за 1 час (1 hr), или взятый у конкретного индивидуума («mouse1»). 
Щелкните на столбце Control (Контроль) для обеспечения контроля эксперимента 

На Рис. 34 представлена закладка Targets (Мишени) с настройками параметров анализа. 

 

Рис. 34. Закладка Targets окна Experiment Settings 

На Рис. 35 представлена закладка Samples (Образцы) с настройками параметров анализа. 

 

Рис. 35. Закладка Samples окна Experiment Settings 

Для редактирования списков данных закладок используйте следующие функции: 

• Добавьте имя мишени или образца, набрав имя в поле New (Новый) и щелкнув на кнопке 
Add (Добавить) 

• Удалите имя мишени или образца, щелкнув на Select to Remove (Выбрать для удаления) 
для соответствующего ряда, а затем – на кнопке Remove checked item(s) (Удалить 
выбранный пункт(ы) 
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• Выберите мишень в качестве эталонной для анализа экспрессии генов, щелкнув в ячейке 
столбца Reference напротив имени мишени 

• Выберите образец в качестве контрольного для анализа экспрессии генов, щелкнув в 
ячейке столбца Control напротив имени образца 

Щелкните на Show Analysis Settings (Отобразить настройки параметров анализа) в окне 

Experiment Settings для просмотра или изменения параметров анализа, приведенных в закладке 
Gene Expression. 

Для редактирования параметров мишени: 

• Щелкните на ячейке столбца Color для изменения цвета мишеней на графике экспрессии 

генов (график Gene Expression) 

• Введите значение оценки эффективности мишени. Программное обеспечение рассчитает 
относительную эффективность для мишени с помощью функции Auto Efficiency 
(Автоматическая настройка эффективности), если данные мишени включают 

стандартную кривую. Или введите ранее определенное значение эффективности 

Для изменения настроек параметров образца в закладке Samples: 

• Щелкните на ячейке столбца Color для изменения цвета образцов на графике экспрессии 

генов (график Gene Expression) 

• Выберите кнопку-флажок в столбце Show Graph (Отображать график) для отображения 

данных образца на графике Gene Expression с помощью цветовой кодировки, выбранной в 
столбце Color 

Пункты контекстного меню селектора лунок 

Щелкните правой кнопкой мыши на любой лунке для выбора пунктов, перечисленных в 
нижеприведенной таблице. 

Таблица 18. Пункты контекстного меню окна Well Selector 
 

Пункт меню Функция 

Copy Well 
(Копировать лунку) 

Копирование содержимого лунки для «вставки» в другую лунку 
или лунки 

Paste Well 
(Вставить лунку) 

«Вставка» скопированного содержимого лунки в другую лунку или 
лунки 

Copy to Clipboard 
(Копировать в буфер) 

Копирование текста из лунки в буфер промежуточного хранения 
для последующей вставки в документ 

Copy as Image 
(Копировать как изображение) 

Копирование представления инструмента выбора лунок в виде 
изображения 

Print... (Печатать) Печать представления инструмента выбора лунок 

Print Selection… 
(Печатать выбранное) 

Печать текущих выбранных компонентов 

Export to Excel... 
(Экспортировать в Excel) 

Экспорт данных в электронную таблицу Excel 

Export to CSV... 
(Экспортировать в CSV) 

Экспорт данных в виде текстового документа 

Export to Xml 
(Экспортировать в Xml) 

Экспорт данных в виде документа формата .xml 

Export to Html 
(Экспортировать в Html) 

Экспорт данных в виде документа формата .html 

Find... (Найти) Поиск текста 

Export Well Info to Excel 
(Экспортировать информацию о 
лунке в Excel) 

Экспорт текстовых данных лунки в виде документа формата .xml 
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Окно программы управления группами лунок Well Groups 
Manager 

Группы лунок делят планшет на подгруппы лунок, которые могут быть проанализированы 
независимо в окне Data Analysis. После создания групп лунок выберите одну из них в окне Data 
Analysis для анализа данных независимой группы. Например, задайте параметры групп лунок для 
анализа в нескольких экспериментах на одном планшете или для анализа каждой группы лунок с 
разными стандартными кривыми. 

ПРИМЕЧАНИЕ: Группа лунок по умолчанию – All Wells (Все лунки). 

Создание групп лунок 

Для создания групп лунок в окне Well Groups Manager выполните следующие инструкции: 

1. Щелкните на кнопке Well Groups (Группы лунок) на панели инструментов окна Plate Editor 
или на кнопке Manage Well Groups на панели инструментов окна Data Analysis. 

2. Щелкните на Add (Добавить) для создания новой группы. Ниспадающее меню отобразит 
имя первой группы как Group 1 (Группа 1). 

3. Выберите на представлении планшета лунки, которые будут входить в состав группы лунок, 
щелчком кнопкой мыши и «перетаскиванием» рамки. Цвет выбранных лунок поменяется на 
синий (Рис. 36). 

4. (Опционально) Измените имя группы, выбрав ее имя в ниспадающем меню и набрав новое 
имя. 

5. (Опционально) Создайте большее количество групп лунок, повторив шаги 1 и 2. 

6. (Опционально) Удалите группы лунок, выбрав имя группы в ниспадающем списке и щелкнув 
на кнопке Delete. 

7. Щелкните на кнопке OK для завершения процедуры и закрытия окна или на кнопке Cancel 

для закрытия окна без сохранения изменений. 

 

Рис. 36. Цвет выбранных лунок в окне Well Group Manager 
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Окно Plate Spreadsheet View (Электронная таблица 
планшета) 

Окно Plate Spreadsheet View отображает содержимое планшета, сконфигурированного редактором 
планшетов. Откройте окно Plate Spreadsheet View (Рис. 37), щелкнув на кнопке Spreadsheet 
View/Importer (Электронная таблица/Импортер) на панели инструментов редактора планшетов. 

 

Рис. 37. Окно отображения электронной таблицы планшета Plate Spreadsheet View 

Откройте электронную таблицу для импорта или экспорта содержимого лунок в файл формата 
Excel или другого формата с разделителями и табуляцией. 

• Щелкните на Import Template (Импортировать шаблон) для экспорта шаблона 

электронной таблицы в файл формата Excel (.csv). Данный шаблон может быть 
отредактирован и использован для импорта информации о содержимом лунок 

• Щелкните на Import для импорта содержимого лунок из файла с разделителями-запятыми 

• Отсортируйте или отредактируйте столбец, выбрав его и используя следующие методы: 
 

• Отсортируйте электронную таблицу в соответствии с данными в одном столбце, 
щелкнув на «ромбике» рядом с именем столбца 

• Отредактируйте содержимое столбца со «звездочкой» (*) вверху, щелчком кнопкой 
мыши и вводом данных в каждую лунку 

ПРИМЕЧАНИЕ: Выберите единицы измерения для данных стандартной кривой в столбце 
Quantity, открыв программу Plate Editor и выбрав Settings > Units (Настройки > Единицы 
измерения) в строке меню. После запуска планшета данные этих стандартных кривых 

появятся на графике Standard Curve (Стандартная кривая) закладки Quantitation 
(Количественный анализ) (окно Data Analysis) с выбранными вами единицами измерения. 

Щелкните правой кнопкой мыши на электронной таблице для выбора одной из этих опций в меню, 
вызываемом правой кнопкой мыши: 

• Copy (Копировать). Копирование всей электронной таблицы 

• Copy as Image (Копировать как изображение). Копирование электронной таблицы в виде 

файла изображения 

• Print (Печатать). Печать электронной таблицы 

• Print Selection (Печатать выбранное). Печать только выбранных ячеек электронной 

таблицы 
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• Export to Excel (Экспортировать в Excel). Экспорт данных в электронную таблицу Excel 

• Export to Text (Экспортировать в текст). Экспорт файла как текстового файла 

• Export to Xml (Экспортировать в Xml). Экспорт перечня в виде файла формата xml 

• Export to Html (Экспортировать в Html). Экспорт перечня в виде файла формата html 

• Find (Найти). Поиск текста в электронной таблице 

• Sort (Сортировать). Сортировка электронной таблицы посредством выбора до трех 

столбцов данных в окне Sort 
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6 Автономная работа 

В данной главе приведена информация о работе системы CFX96 Touch™, CFX96 Touch Deep 
Well™ или CFX384 Touch™ в автономном режиме: 

• Начальный экран (стр. 60) 

• Настройка параметров эксперимента (стр. 60) 

• Экспорт данных для анализа (стр. 66) 

• Создание файла данных (стр. 67). 

• Настройка параметров электронной почты (стр. 67) 

ПРИМЕЧАНИЕ: Если Вы используете основной блок термоциклера C1000™, свяжитесь со 
службой технической поддержки для получения руководства по эксплуатации системы в 
формате .pdf. 



Автономная работа 

60 

Начальный экран 

При запуске системы CFX96 Touch, CFX96 Touch Deep Well и CFX384 Touch производят 
самодиагностику для проверки функций, после чего отображается начальный экран. Используйте 
начальный экран для начала работы с прибором. Начальный экран предоставляет доступ ко всем 
операциям системы, отображает дату и время, имя работающего в системе пользователя, статус 
системы, название термоциклера, а также все подключенные термоциклеры S1000™ (Рис. 38). 

ПРИМЕЧАНИЕ: Для переименования термоциклера коснитесь Tools > About > Rename 
"Serial Number" (Инструменты > О приборе > Переименовать «Серийный номер»). 

 

Рис. 38. Начальный экран системы C1000 Touch™ 

Для включения функций на начальном экране нажмите соответствующие кнопки: 

• New Protocol (Новый протокол). Создание нового протокола. 

• Protocol AutoWriter (Составитель протоколов Protocol AutoWriter). Создание протокола 

с помощью программы Protocol AutoWriter и калькулятора температуры отжига. 

• Saved Files (Сохраненные файлы). Копирование, переименование, редактирование и 

экспорт файлов. 

• Incubate (Инкубировать). Инкубация образцов при заданной температуре. 

• Tools (Инструменты). Функции включают доступ к информации о системе, настройкам 

электронной почты и функциям обновления встроенного программного обеспечения. 
В зависимости от прав пользователя, зарегистрированного в системе, предоставляется 
доступ к различным инструментам. 

ПРИМЕЧАНИЕ: Сенсорным экраном можно пользоваться в перчатках или без них, без 
сенсорного карандаша. Списки, превышающие размер окна, можно скручивать касанием и 
«перетаскиванием» списка вверх или вниз или с помощью кнопок со стрелками. 

Настройка параметров эксперимента 

Системы CFX96 Touch, CFX96 Touch Deep Well и CFX384 Touch способны выполнять 
эксперименты, задействующие ПЦР реального времени, без компьютера. Данные флуоресценции, 
собранные в ходе выполнения эксперимента, можно экспортировать с помощью флэш-накопителя 
USB или отправлять по электронной почте, если основной блок термоциклера C1000 Touch 
подключен к сети Интернет (см. «Экспорт данных по электронной почте» на стр. 66). Для анализа 
данных требуется программное обеспечение CFX™ Manager. 
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Для создания нового протокола: 

1. Выберите New Protocol (Новый протокол) на начальном экране для открытия нового 

шаблона протокола (Рис. 39). 

 

Рис. 39. Протокол ПЦР реального времени по умолчанию 

ПРИМЕЧАНИЕ: По умолчанию, шаблон протокола включает этап прочтения планшета, 
когда оптический реакционный модуль системы CFX96™, CFX96 Deep Well™ или CFX384™ 
установлен в основной блок термоциклера C1000 Touch. 

2. Для изменения целевой температуры и времени выдержки на этапе изменения 
температуры коснитесь соответствующей кнопки. Введите новое значение, используя 
появившуюся на экране клавиатуру. Коснитесь кнопки OK для подтверждения введенного 

значения. 

СОВЕТ: В качестве альтернативного способа навигации можно подключить оптическую 
мышь через USB –порт термоциклера C1000 Touch. 

3. (Опционально) Для вставки нового этапа выберите этап и коснитесь кнопки Insert 
(Вставить). К этапам, которые можно вставить, относятся Temperature (Температура), 

Gradient (Температурный градиент), Goto, Plate Read (Прочтение планшета) и Melt Curve 
(Кривая плавления). Для удаления этапа коснитесь кнопки Delete (Рис. 39). 

4. (Опционально) Для смены опций этапа выберите этап и коснитесь кнопки Options (Опции) 
(Рис. 39). В окне Step Options (Опции этапов) можно изменять параметры таких этапов, 

как Temperature (Температура), Time (Время), Gradient (Температурный градиент), Ramp 
Rate (Скорость линейного изменения), Increment (Повышение), Extension (Продление) и Add/ 
Remove a Plate Read (Добавить/Удалить прочтение планшета) (Рис. 40). 
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Рис. 40. Окно Step Options 

ПРИМЕЧАНИЕ: Ввод температурного градиента допускается в диапазоне от 1 до 24°C. 
Если включен этап температурного градиента, Вы можете отредактировать градиент с 
помощью кнопок повышения и понижения температуры на графическом представлении без 
открытия экрана Step Options. 

5. Если включен этап GOTO, термоциклер производит повтор ряда этапов для создания 
циклов ПЦР-анализа. Выберите этап GOTO и коснитесь соответствующей кнопки для 

изменения этапа или количества повторов. 

Изменение параметров эксперимента 

• Для изменения объема образца коснитесь поля Volume (Рис. 39). Введите новый объем 
образца в микролитрах. Введенный объем образца определяет режим контроля 
температуры в ходе эксперимента. 

СОВЕТ: Ввод объема образца от 1 до 50 мкл для системы CFX96 Touch, от 1 до 125 мкл 
для системы CFX96 Touch Deep Well или от 1 до 30 мкл для системы CFX384 Touch 
производит выбор режима контроля температуры, являющегося стандартным режимом. 
Введите ноль (0) для выбора режима блока. Рекомендуется использовать режим контроля 
температуры, так как он более точно отображает фактическую температуру образца. 

• Для изменения температуры крышки коснитесь поля Lid (Крышка) и введите новое 

значение температуры (Рис. 39). Температура по умолчанию для модулей CFX96 и CFX384 
составляет 105°C и 95°C, соответственно. 

Сохранение протокола 

• После создания протокола необходимо его сохранить. При касании кнопки Save 
(Сохранить) появится окно Save As (Сохранить как), в котором необходимо указать имя, 
место сохранения и папку (Рис. 41). Коснитесь кнопки OK для сохранения протокола. 
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Рис. 41. Окно Save As 

Выполнение протокола 

1. Для выполнения протокола коснитесь кнопки Run в окне Edit Protocol (Рис. 39). 

2. Проверьте температуру крышки (Lid Temp), объем образца (Volume) и имя файла (File 
Name (.zpcr)), который будет использоваться для регистрации протокола (Рис. 42). Перед 

началом эксперимента создается имя файла данных автономного анализа по умолчанию. 

 

Рис. 42. Экран подтверждения выбранного протокола 

3. Выберите Scan Mode (Режим сканирования) для задания каналов, в которых будет 

производиться сбор данных флуоресценции. Режимы сканирования обеспечивают 
детектирование калиброванных флуорофоров в следующих каналах: 
• SYBR/FAM. Сбор данных только из канала 1 с быстрым сканированием 
• All Channels (Все каналы). Сбор данных из каналов с 1 по 5 на системах CFX96 Touch и 

CFX96 Touch Deep Well или из каналов с 1 по 4 на системе CFX384 Touch 
• FRET. Сбор данных только из канала FRET с быстрым сканированием 

 

4. (Опционально) Окно Additional Settings (Дополнительные настройки) позволяет вводить 
имя пользователя (поле User Name), адрес электронной почты (поле Email Address), 
идентификатор образца (поле Sample ID), скорость линейного изменения (поле Ramp Rate) 

и предоставляет возможность проводить эксперимент со скоростью линейного изменения 
термоциклера DNA Engine. 

5. Коснитесь кнопки OK для запуска протокола. 
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Выполнение ранее сохраненного протокола 

• Для выполнения существующего протокола коснитесь кнопки Saved Files (Сохраненные 
файлы) на начальном экране. После выбора местоположения, папки и файла коснитесь 
кнопки Run (Рис. 43). 

 

Рис. 43. Выбор сохраненного протокола 

• Для изменения параметров существующего протокола выберите протокол и коснитесь 
кнопки Edit (Редактировать). Протокол может быть запущен немедленно без сохранения 
изменений касанием кнопки Run или сохранен касанием кнопки Save. 

Контроль выполнения протокола 

После запуска эксперимента появляется окно Status. Информация, приведенная в данном окне, 

позволяет контролировать ход выполнения протокола. 

• Status (Статус). Экран Status отображает ход выполнения протокола и предоставляет 

опции View Clock (Отобразить время), View Curves (Отобразить кривые), Pause 
(Приостановить), Skip (Пропустить) и Cancel (Отменить) (Рис. 44) 

 

Рис. 44. Контроль хода выполнения протокола на экране Status 

• View Clock (Отобразить время). Нажмите кнопку View Clock для отображения на экране 

таймера обратного отсчета времени выполнения текущего протокола. Коснитесь кнопки 
View Status (Отобразить статус) для возврата к экрану Status или кнопки View Curves 
(Отобразить кривые) для перехода к экрану кривой амплификации. 

• View Curves (Отобразить кривые). Коснитесь кнопки View Curves для отображения 

трассировки данных в реальном времени (Рис. 45). Если сбор данных производится из 
нескольких каналов, выберите канал для вывода его на экран с помощью кнопок Channel 
(Канал). 
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На экран выводятся данные только одного канала. Если протокол включает несколько 
этапов сбора данных, можно отобразить данные отдельного этапа, выбрав этап из 
ниспадающего меню Step (Этап). 

 

Рис. 45. Трассировка данных реального времени на экране кривых 

Для отображения данных конкретных лунок коснитесь кнопки Select Wells (Выбрать лунки). 

Выбранные лунки будут представлены в виде закрашенных кружков. Настройка по умолчанию – 
все выбранные лунки. Для отмены выбора или выбора лунки коснитесь соответствующей лунки на 
сетке селектора лунок (Well Selector) (Рис. 46). Для отмены выбора или выбора целых рядов или 
столбцов коснитесь заголовков столбцов или рядов. Можно выбрать или отменить выбор всех 
лунок планшета, коснувшись «звездочки» (*) в любом верхнем углу сетки экрана Well Selector. 

 

Рис. 46. Окно Well Selector 

При работе с системой CFX96 Touch или CFX96 Touch Deep Well на экране отображается 96-
луночный планшет. При работе с системой CFX384 Touch планшет представлен в виде одного 
квадранта 96-луночного планшета (Рис. 46). Можно выбрать отдельные квадранты, коснувшись 
соответствующего квадрата. Представление 384-луночного планшета, содержащего все четыре 
квадранта, можно вывести на экран, коснувшись кнопки Preview Plate (Предварительный 
просмотр планшета). 

ПРИМЕЧАНИЕ: Относительная шкала флуоресценции по оси Y составляет от 1 до 1 500. 
Как только интенсивность флуоресценции превышает верхний предел, система производит 
автоматическое масштабирование данных оставшегося периода эксперимента. 
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Экспорт данных для анализа 

После завершения анализа данные флуоресценции подлежат передаче на компьютер, 
работающий под управлением ПО CFX Manager, для анализа. Автономный файл данных (.zpcrd) 
автоматически сохраняется в папку Real-Time Data в столбце Location (Местоположение) окна 
Saved Files (Сохраненные файлы). 

ПРИМЕЧАНИЕ: Термоциклер C1000 Touch способен хранить до 100 анализов ПЦР 
реального времени. 

Экспорт данных с использованием флэш-накопителя USB 

Если к USB-порту термоциклера C1000 Touch подключен флэш-накопитель USB, данные (.zpcr) 
автоматически будут сохранены в корневой директории флэш-накопителя USB по завершении 
эксперимента. 

Если на момент завершения протокола флэш-накопитель USB отсутствует, выполните следующие 
инструкции: 

1. Коснитесь Saved Files на начальном экране для доступа к папкам с файлами (Рис. 47). 

2. В столбце Location выберите Real-Time Data (Данные реального времени). 

3. Выберите файл для экспорта в столбце File. Информация о выбранном файле появится в 

секции окна Preview (Предварительный просмотр). 

4. Для экспорта файла нажмите кнопку File Options (Опции файла). 

5. Коснитесь кнопки OK для сохранения файла на подключенный флэш-накопитель USB. 

 

Рис. 47. Выбор файла данных ПЦР реального времени для экспорта 
на флэш-накопитель USB 

Экспорт данных по электронной почте 

Вы можете отправить данные по электронной почте непосредственно с термоциклера 
C1000 Touch после завершения эксперимента, сконфигурировав настройки электронной почты 
(см. «Настройка параметров электронной почты» на стр. 67). 

Для отправки электронного письма с прикрепленными данными (.zpcr) по завершении 
эксперимента введите адрес электронной почты в окне Additional Settings перед началом 
эксперимента. 
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Создание файла данных 

Файл данных автономного анализа (.zpcr) подлежит конвертированию в файл данных (.pcrd) 
программным обеспечением CFX Manager для последующего анализа. Выполните 
нижеприведенные инструкции по созданию файла данных из автономного анализа: 

1. Щелкните кнопкой мыши и «перетащите» файл .zpcr из директории флэш-накопителя USB в 
главное окно программного обеспечения или выберите Select File > Open > Stand-alone 
Run (Выбрать файл > Открыть > Автономный анализ) в опциях меню главного окна 

программного обеспечения для выбора имени файла. 

2. Программное обеспечение выберет планшет по умолчанию, соответствующий режиму 
сканирования и размеру планшета и применит его к файлу .zpcr для создания файла .pcrd. 
После выбора места сохранения файла откроется окно Data Analysis; на данном этапе 
можно отредактировать схему планшета, выбрав Plate Setup на панели инструментов и 

необходимое действие из ниспадающего меню. 

Настройка параметров электронной почты 

После завершения эксперимента отчет и файл .zpcr могут быть отправлены по электронной почте 
для обеспечения доступа к ним с любого компьютера, подключенного к сети Интернет. Для 
настройки исходящих почтовых сообщений, отправляемых с термоциклера серии С1000 Touch, 
выполните следующие действия: 

1. Подключите кабель Ethernet к порту на задней панели основного блока термоциклера 
C1000 Touch. 

2. Нажмите кнопку Log In в главном меню для входа в систему термоциклера в качестве 
Администратора. 

ПРИМЕЧАНИЕ: имя пользователя, вошедшего в систему, появляется слева от кнопки 
Log Out при возврате в режим главного меню. 

3. Нажмите кнопку Tools в главном меню для запуска меню инструментов. 

4. Нажмите кнопку Email Settings (Настройки электронной почты) в меню Admin 

(Администратор). 

Настройка сервера Gmail 

ПРИМЕЧАНИЕ: перед настройкой сервера Gmail устройства должна быть создана учѐтная 
запись Gmail с именем пользователя и паролем. 

1. Выберите сервер Gmail в ниспадающем списке Mail Servers. 

2. Введите имя пользователя и пароль учѐтной записи Gmail. 

3. Поставьте флажок в пункте Set as Default (Установить по умолчанию) (рис. 48). 
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Рисунок 48. Сервер Gmail выбран, имя пользователя и пароль введены, и сервер выбран в 
качестве сервера по умолчанию 

4. Нажмите кнопку Save (Сохранить) для сохранения текущих настроек сервера. 

5. Нажмите кнопку Test Email (Тестовая электронная почта). 

6. Коснитесь поля Test Email Address (Тестовый адрес электронной почты) и введите 

адрес электронной почты с помощью всплывающей буквенно-цифровой клавиатуры. 

7. Коснитесь поля Attachment Size in MB (Размер вложения в Мб) и введите размер 

тестового вложения. 

 ПРИМЕЧАНИЕ: Максимально допустимый размер вложения задан сервером вашего 
учреждения. Мы рекомендуем ввести размер вложения в диапазоне от 0,5 до 5 Мб. 

8. Нажмите кнопку Send Email (Отправить письмо по электронной почте). Тестовое 

электронное письмо будет отправлено на тестовый адрес электронной почты. 

9. Нажмите кнопку Cancel (Отмена) для возврата в меню настроек сервера. 

10. Нажмите кнопку Back (Назад) для возврата в меню инструментов. 

Настройка собственного сервера 

1. Нажмите кнопку New Server (Новый сервер) (рис. 48). 

2. Нажмите кнопку Mail Server Address (Адрес почтового сервера) и введите адрес 

электронной почты с помощью всплывающей буквенно-цифровой клавиатуры. 

3. Нажмите кнопку Mail Server Port (Порт почтового сервера) и введите адрес электронной 

почты с помощью всплывающей буквенно-цифровой клавиатуры. 

4. Поставьте флажок в пункте Set As Default (Установить по умолчанию). 

5. Введите дополнительную информацию (Authentication required (Требуется аутентификация), 
Use SSL (Использовать SSL), User Name (Имя пользователя) и Password (Пароль)) только в 
том случае, если это требуется сервером. 

 СОВЕТ: Для уточнения требований сервера свяжитесь с вашим администратором сети. 

6. Нажмите кнопку Save. Новый сервер появится в ниспадающем списке Mail Servers 
(Серверы электронной почты). 

7. Повторите действия, указанные в пунктах 5-10 в разделе «Настройка сервера Gmail» 
(стр. 67). 
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Удаление сервера 

1. Выберите сервер Gmail в ниспадающем списке Mail Servers. 

2. Коснитесь кнопки Remove Server (Удалить сервер). 

3. Коснитесь кнопки Yes (Да) для подтверждения выполняемого действия удаления 

выбранного сервера. 
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7 Краткое описание анализа данных 

В данной главе приведена информация об анализе данных: 

• Окно Data Analysis (Анализ данных) (стр. 71) 

• Закладка Quantification (Количественный анализ) (стр. 74) 

• Настройки анализа данных (стр. 75) 

• Селекторы лунок (стр. 78) 

• Графики (стр. 81) 

• Электронные таблицы (стр. 82) 

• Экспорт (стр. 83) 

Окно Data Analysis (Анализ данных) 

В процессе анализа данных изменение способа отображения данных посредством изменения 
содержимого лунок в окне Plate Editor, ни при каких обстоятельствах, не изменит данные 
флуоресценции, собранные с каждой лунки во время анализа. Как только модуль произвел сбор 
данных флуоресценции, эти данные не подлежат удалению, но можно убрать их для просмотра и 
анализа. 

Для изменения содержимого лунок после эксперимента выберите одну из следующих опций, 
нажав кнопку Plate Setup в верхней части окна Data Analysis: 

• View/Edit Plate (Отобразить/Редактировать планшет). Откройте программу Plate Editor 

для внесения изменений в схему планшета в ручном режиме 

• Replace Plate file (Заменить файл планшета). Выберите ранее сохраненный файл 

планшета для замены текущей схемы планшета 

• Apply PrimePCR file (Применить файл PrimePCR). Выберите эксперимент PrimePCR™, из 

которого будет использована схема планшета 

СОВЕТ: Вы можете добавлять или редактировать информацию о содержимом лунок до, в 
течение и после завершения эксперимента методом ПЦР в реальном времени. Перед 
запуском эксперимента необходимо назначить режим сканирования и размер планшета, и 
данные параметры не могут быть изменены после выполнения протокола. 

Программное обеспечение CFX Manager автоматически обрабатывает данные ПЦР реального 
времени после выполнения каждого протокола и открывает окно Data Analysis с результатами. 
Выберите один из следующих методов открытия существующих файлов данных в окне Data 
Analysis: 

• Поместите «перетаскиванием» файл данных (расширение .pcrd) в главное окно 
программного обеспечения 

• Выберите закладку Analyze (Анализировать) в окне Startup Wizard и воспользуйтесь либо 
списком Recent Files (Недавние файлы), либо кнопкой Browse 
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• Выберите File > Open > Data File (Файл > Открыть > Файл данных) в главном окне 

программного обеспечения для выбора файла в браузере для Windows 

• Щелкните на кнопке Data Analysis на панели инструментов главного окна программного 

обеспечения для выбора файла в браузере для Windows 

• Выберите File > Recent Data Files (Файл > Последние файлы данных) для выбора файла 

из перечня из десяти файлов с самой свежей датой открытия 

Окно Data Analysis содержит множество закладок (Рис. 49); каждая закладка отображает 
проанализированные данные конкретного эксперимента или информацию об эксперименте. 
Закладки отображаются только в том случае, если данные, собранные во время эксперимента, 
доступны для данного типа анализа. 

 

Рис. 49. Закладки окна Data Analysis 

СОВЕТ: Выбрать отображаемые закладки можно в ниспадающем меню View главного окна. 
Для возврата к исходному формату выберите Settings > Restore Default Window Layout 
(Настройки > Восстановить исходную конфигурацию окна). 

Панель инструментов окна Data Analysis 

Панель инструментов окна Data Analysis (Рис. 50) предоставляет быстрый доступ к важным 
функциям анализа данных. 

 

Рис. 50. Панель инструментов окна Data Analysis 

Таблица 19 перечисляет функции кнопок панели инструментов. 

Таблица 19. Панель инструментов окна Data Analysis 
 

Кнопка Название Функция 

 

Plate Setup 
(Настройки планшета) 

View/Edit Plate (Отобразить/Редактировать планшет). 
Открытие редактора планшетов для просмотра и 
редактирования содержимого лунок. 
Замена файла планшета: выберите файл планшета для 
замены схемы планшета. 
Применение файла PrimePCR: выберите файл 
эксперимента для замены схемы планшета на схему для 
эксперимента PrimePCR 

 

Manage Well Groups 
(Управлять группами 
лунок) 

Открытие окна Well Groups Manager для создания, 
редактирования и удаления групп лунок 

 

Well Group (Группа 
лунок) 

Выбор существующей группы лунок из ниспадающего меню. 
Группа лунок по умолчанию – All Wells (Все лунки). Группа 
по умолчанию отображается только при наличии созданных 
групп лунок. 

 

Analysis Mode (Режим 
анализа) 

Выбор режима анализа данных: режим Fluorophore 
(Флуорофор) или Target (Мишень) 

 

Help (Справка) Открытие справки программного обеспечения для 
получения дополнительной информации об анализе данных 

Строка меню окна Data Analysis 

В Таблице 20 перечислены пункты меню окна Data Analysis. 
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Таблица 20. Пункты меню окна Data Analysis 
 

Пункт меню Команда Функция 

File (Файл) Save (Сохранить) Сохранение файла 

Save As (Сохранить как…) Сохранение файла под новым именем 

Repeat Run (Повторить протокол) Извлечение протокола и файла планшета 
текущего эксперимента для повторного 
выполнения протокола 

Close (Закрыть) Закрытие окна Data Analysis 

View (Вид) Run Log (Рабочий журнал) Открытие окна Run Log для просмотра 
рабочего журнала текущего файла данных 

Quantification (Количественный 
анализ), Melt Curve (Кривая 
плавления), Gene Expression 
(Экспрессия генов), End Point 
(Конечная точка), Custom Data View 
(Представление данных, 
задаваемое пользователем), QC 
(Контроль качества), Run 
Information (Информация об 
эксперименте) 

Выбор закладок, отображаемых в окне Data 
Analysis. Необходимо выбрать не менее одной 
закладки 

Settings 
(Настройки) 

Cq Determination Mode 
(Режим определения Cq) 

Выбор режима Regression (Регрессия) или 
Single Threshold (Один пороговый уровень) для 
определения, каким образом будут 
рассчитываться значения Cq для каждой 
кривой 

Baseline Setting 
(Настройка базовой линии) 

Выбор метода вычитания базовой линии для 
выбранной группы лунок 

Analysis Mode (Режим анализа) Выбор режима анализа данных: режим 
Fluorophore (Флуорофор) или Target (Мишень) 

Cycles to Analyze 
(Циклы для анализа) 

Выбор циклов, подлежащих анализу 

Baseline Thresholds 
(Базовая линия/Пороговые уровни) 

Открытие окна Baseline Thresholds для 
регулировки базовой линии или порогового 
уровня 

Trace Styles (Внешний вид данных) Открытие окна Trace Styles 

Plate Setup (Настройки планшета) Открытие редактора планшетов для просмотра 
и редактирования планшета; замена текущего 
планшета одним из файлов определяемого 
пользователем планшета или файлом 
эксперимента PrimePCR 

Include All Excluded Wells 
(Включить все исключенные лунки) 

Включение в анализ всех исключенных лунок 

Mouse Highlighting (Выделение 
мышью) 

Включите или выключите функцию 
одновременного выделения данных с 
помощью курсора мыши 
 
СОВЕТ: Если данная функция выключена, 
удерживайте клавишу CTRL для временного ее 
включения 

Restore Default Window Layout 
(Восстановить конфигурацию окна 
по умолчанию) 

Восстановление исходных конфигураций окон 

Export (Экспорт) Export All Data Sheets to Excel 
(Экспортировать все таблицы 
данных в Excel) 

Экспорт всех представлений электронных 
таблиц из каждой закладки в отдельный файл 
формата Excel 

Export RDML File 
(Экспортировать файл RDML) 

Выбор версии RDML (1.1 или 1.0) для открытия 
окна Save As и задания имени и 
местоположения файла RDML 

 Custom Export (Экспортировать 
индивидуальный отчет) 

Открытие окна Custom Export для задания 
полей для экспорта и формата файла 
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Таблица 20. Пункты меню окна Data Analysis (продолжение) 
 

Пункт меню Команда Функция 

 Export to LIMS Folder... 
(Экспортировать в папку LIMS) 

Открытие окна для сохранения данных в 
предопределенном формате в папку LIMS 

Tools 
(Инструменты) 

Reports (отчеты) Открытие отчета для текущего файла данных 

Well Group Reports... 
(Отчеты по группам лунок) 

Открытие окна Well Group Report для 
генерации отчетов по указанным группам 
лунок 

Import Fluorophore Calibration… 
(Импортировать файл калибровки 
флуорофоров) 

Выбор файла калибровки для применения к 
текущему файлу данных 

qbase+ Запуск установленного программного 
обеспечения qbase+ v2.5 непосредственно из 
текущего файла 

Закладка Quantification (Количественный анализ) 

Каждая закладка окна Data Analysis отображает данные в виде графиков и электронных таблиц 
для конкретного метода анализа с помощью селектора лунок, позволяющего выбирать данные, 
которые Вы хотите отобразить. Окно Data Analysis открывается с выделенной закладкой 
Quantification (Рис. 51). Для определения настроек анализа результатов эксперимента необходимо 
использовать данные графика амплификации (график Amplification) данной закладки. 

 

Рис. 51. Закладка Quantification окна Data Analysis с выбранной Группой 1 (Group 1) 

ПРИМЕЧАНИЕ: Программное обеспечение связывает данные в секциях окон каждой 
закладки анализа данных. Например, выделение лунки помещением курсора мыши поверх 
лунки в селекторе лунок выделяет данные во всех других секциях. 
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Селектор номера этапа 

Системы CFX96 Touch™, CFX96 Touch Deep Well™, CFX Connect™ и CFX384 Touch™ могут 
производить сбор данных флуоресценции на множестве этапов протокола; программное 
обеспечение осуществляет независимую поддержку данных, собранных на каждом этапе. Если 
протокол содержит более одного этапа сбора данных, программное обеспечение выводит на экран 
селектор количества этапов (Step Number) под стандартной кривой в закладке Quantitation. Когда 

вы выбираете этап, программное обеспечение применяет его ко всем данным, отображаемым в 
окне Data Analysis. На Рис. 52 показано, что выбрано 3 этапа сбора данных для всех данных. 

 

Рис. 52. Выбор номера этапа в окне Data Analysis 

Просмотр групп лунок в окне Data Analysis 

Лунки планшета могут быть подразделены на подгруппы для независимого анализа групп лунок. 
Когда вы создаете группы лунок в окне Well Groups Manager редактора планшетов (стр. 56), 

имена групп появляются в окне Data Analysis в ниспадающем списке Well Groups (Группы лунок) на 
панели инструментов. 

СОВЕТ: Для редактирования, создания и удаления групп лунок щелкните на кнопке Manage 
Well Groups панели инструментов. 

При первом открытии окна Data Analysis отображается группа лунок с именем All Wells; данные 

всех лунок и их содержимое отображаются на графиках и в электронных таблицах. 

ПРИМЕЧАНИЕ: Если группы лунок не были созданы, ниспадающий список Well Groups не 
появится на панели инструментов. 

На Рис. 51 продемонстрировано, что в меню Well Groups выбрана группа 1 (Group 1). В селекторе 
лунок отображаются только лунки группы лунок, и данные только этих лунок включены в расчеты 
данных. 

Настройки анализа данных 
Данные графика Amplification в закладке Quantification демонстрируют относительную 

флуоресценцию (RFU (ОЕФ)) для каждой лунки с каждым циклом. Каждый след на графике 
представляет данные от одного флуорофора в одной лунке. Эти данные используются для 
получения значений Cq для каждой лунки для каждого флуорофора. Программное обеспечение 
может использовать один из двух режимов определения значений Cq: 

• Regression (Регрессия). Данный режим применяет к отдельным следам лунок 

многомерную модель нелинейной регрессии и затем на основании данной модели 
производит расчет оптимального значения Cq. 

• Single Threshold (Один пороговый уровень). Данный режим использует одно пороговое 

значение для расчета значения Cq на основании точки превышения порога отдельных 
следов флуоресценции. 

Выберите Settings > Cq Determination Mode (Настройки > Режим определения Cq) для выбора 

режима определения Cq. 

Регулировка порогового уровня 

В режиме Single Threshold пороговый уровень для флуорофора можно отрегулировать, щелкнув на 
пороговой линии графика Amplification и переместив курсор мыши вертикально. Или укажите 
точное значение превышения порогового уровня для выбранного флуорофора, следуя следующим 
инструкциям: 

1. Выберите один флуорофор в селекторе флуорофоров закладки Quantification (Рис. 51), 
выбрав кнопку-флажок рядом с именем флуорофора под графиком амплификации. 
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2. Выберите Settings > Baseline Thresholds в строке меню для открытия окна Baseline 

Thresholds. 

3. Отрегулируйте пересекающий пороговый уровень (Рис. 53) для флуорофора, щелкнув на 
User Defined (Определяемый пользователем) и набрав значение порогового уровня. 

 

Рис. 53. Окно Baseline Thresholds (Базовая линия/Пороговые уровни) 

4. Щелкните на кнопке OK для подтверждения изменений и закройте окно. 

СОВЕТ: Для применения одного значения порогового уровня ко всем файлам данных 
задайте соответствующие настройки в закладке Data Analysis окна User Preferences. 

Данное значение будет применено ко всем созданным в дальнейшем файлам данных. 

Настройки базовой линии 

Программное обеспечение автоматически задает базовую линию отдельно для каждой лунки. 
Выберите Baseline Setting (Настройка базовой линии) для определения метода вычитания базовой 
линии для всех кривых флуоресценции. Выберите Settings > Baseline Setting для выбора одной 

из трех опций: 

• No Baseline Subtraction (Без вычитания базовой линии). Программное обеспечение 

отображает данные в виде относительных кривых флуоресценции. Некоторые анализы не 
могут быть выполнены в данном режиме, и поэтому программное обеспечение не 
отображает закладки Gene Expression (Экспрессия генов), End Point (Конечная точка) и 
Allelic Discrimination (Дискриминация аллелей) 

• Baseline Subtracted (Вычитание базовой линии). Программное обеспечение отображает 

данные в виде кривых без учета базовой линии для каждого флуорофора в лунке. 
Программное обеспечение должно вычесть данные по базовой линии для определения 
циклов количественного анализа, построения стандартных кривых и определения 
концентрации неизвестных образцов. Для генерации данных с вычтенной базовой линией 
(результирующих данных) программное обеспечение осуществляет подбор наилучшей 
прямой линии по зарегистрированным сигналам флуоресценции в каждой лунке во время 
циклов базовой линии, а затем вычитает наиболее соответствующие данные из 
результирующих данных в каждом цикле 

• Baseline Subtracted Curve Fit (Подбор результирующей кривой). Программное 

обеспечение отображает данные в виде результирующих следов с вычтенной базовой 
линией и сглаживает результирующую кривую с помощью центрированного фильтра 
среднего значения. Данный процесс осуществляется таким образом, что каждое значение 
Cq остается неизменным 

Наряду с двумя вышеприведенными опциями можно также выбрать следующие опции: 
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• Apply Fluorescent Drift Correction (Применить поправку на смещение флуоресценции). 

Для лунок, демонстрирующих чрезмерно смещенные значения ОЕФ в нескольких 
начальных циклах эксперимента, программное обеспечение извлекает номинальную 
базовую линию из соседних лунок, для которых была успешно сгенерирована 
горизонтальная базовая линия 

Регулировка базовой линии 

После выбора лунок для анализа проверьте настройки базовой линии в данных лунках. Откройте 
окно Baseline Thresholds (Рис. 53) для изменения базовой линии, заданной по умолчанию, для 
выбранных лунок. Для открытия данного окна: 

1. Выберите один флуорофор в закладке Quantification (Рис. 51), выбрав кнопку-флажок рядом 
с именем флуорофора под графиком амплификации. 

2. Выберите Settings > Baseline Thresholds для открытия окна Baseline Thresholds. 

Для регулировки начального и конечного цикла базовой линии для каждой лунки: 

1. В секции окна Baseline Cycles (Циклы базовой линии) выберите одну или несколько лунок 
щелчком кнопкой мыши на номере ряда, все лунки – щелчком в верхнем левом углу, 
множество отдельных лунок – удержанием клавиши CTRL и множество лунок в одном ряду 
– удержанием клавиши SHIFT. 

2. Отрегулируйте начальный цикл базовой линии (Baseline Begin) и конечный цикл базовой 
линии (Baseline End) для всех выбранных лунок или измените номера циклов в полях 
Begin и End в нижней части электронной таблицы (Рис. 53). 

3. Для возврата настроек к последним сохраненным значениям щелкните на Reset All User 
Defined Values (Восстановить все определенные пользователем значения). 

4. Щелкните на кнопке OK для подтверждения изменений и закройте окно. 

СОВЕТ: Для применения одного диапазона циклов, используемого для определения 
базовой линии, ко всем файлам данных задайте соответствующие настройки в закладке 
Data Analysis окна User Preferences. Данное значение будет применено ко всем 

созданным в дальнейшем файлам данных. 

Режим анализа 

Данные могут быть проанализированы и отображены группами или по имени флуорофора, или по 
имени мишени. Для выбора режима анализа данных выберите Settings > Analysis Mode 
(Настройки > Режим анализа) или выберите режим из ниспадающего меню панели инструментов. 

Если выбран режим Fluorophore (Флуорофор), трассировка данных будет производиться по 

флуорофору, как указано в настройках планшета для данного эксперимента (стр. 54). Отдельные 
данные флуорофора будут отображаться на графиках амплификации и стандартной кривой (если 
есть) после выбора соответствующих кнопок-флажков селектора флуорофоров под графиком 
амплификации. 
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Рис. 54. Выбран режим анализа по имени флуорофора 

Если выбран режим Target (Мишень), трассировка данных будет производиться по имени мишени, 

введенному на этапе настройки параметров планшета (Рис. 55). 

 

Рис. 55. Выбран режим анализа по имени мишени 

Выбор циклов для анализа 

Для ограничения анализа данных до определенного диапазона циклов выберите Settings > Cycles 
to Analyze (Настройки > Циклы для анализа). Выберите начальный и конечный циклы, используя 

кнопки со стрелками, или введите требуемые значения и нажмите Enter. Щелкните на кнопке 
Restore Defaults для восстановления настроек по умолчанию. 

ПРИМЕЧАНИЕ: Удаление циклов в начале эксперимента может существенно повлиять на 
выстраивание базовой линии. 

Селекторы лунок 

Щелчком кнопкой мыши на лунках в селекторе лунок можно отображать или скрывать данные на 
графиках или в электронных таблицах во всем окне Data Analysis: 

• Для скрытия одной лунки выделите отдельную лунку и щелкните на ней. Для отображения 
одной лунки выделите отдельную лунку и снова щелкните на ней 
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• Для скрытия множества лунок щелкните и «перетащите» курсор мыши по всем лункам, 
которые Вы хотите выбрать. Для отображения данных лунок щелкните и «перетащите» 
курсор мыши по всем лункам, которые Вы хотите отобразить 

• Для скрытия всех лунок щелкните в верхнем левом углу планшета. Для отображения всех 
лунок снова щелкните в верхнем левом углу планшета 

• Для скрытия лунок ряда или столбца щелкните на начале ряда или столбца. Для 
отображения лунок ряда или столбца снова щелкните на начале ряда или столбца 

С помощью селектора лунок могут быть выбраны только лунки с содержимым (введенным в 
программе Plate Editor), и выделенные лунки меняют цвет. Как показано на Рис. 56, селектор лунок 
отображает три типа лунок: 

• Выбранные и загруженные лунки (синий). Данные лунки содержат неизвестный образец 
(Unk). Данные этих лунок появляются в окне Data Analysis 

• Невыбранные загруженные лунки (светло-серый). Данные лунки содержат стандартный 
(Std) и положительный (Pos) образцы. Данные этих лунок не появляются в окне Data 

Analysis 

• Пустые лунки (темно-серый). Данные лунки не загружены в окне Plate Editor 

 

Рис. 56. Три цвета лунок в селекторе лунок 

Пункты контекстного меню селектора лунок 

Щелкните правой кнопкой мыши в любой области селектора лунок для выбора пунктов меню, 
перечисленных в Таблице 21. 

Таблица 21. Пункты контекстного меню селектора лунок 

Пункт меню Функция 

Well XX (Лунка XX) Просмотр только данной лунки, удаление данной лунки, задание 
цвета данной лунки или исключение данной лунки из анализа 

Selected Wells (Выбранные 
лунки) (щелкнуть правой 
кнопкой мыши и «перетащить») 

Просмотр только данных лунок, удаление данных лунок, задание 
цвета данных лунок или исключение данных лунок из анализа 

Copy (Копировать) Копирование содержимого лунки в буфер обмена, включая тип 
образца и опциональное количество дубликатов 

Copy as Image 
(Копировать как изображение) 

Копирование представления инструмента выбора лунок в виде 
изображения 

Print... (Печатать) Печать представления инструмента выбора лунок 

Print Selection… 
(Печатать выбранное) 

Печать текущих выбранных компонентов 

Export to Excel... 
(Экспортировать в Excel) 

Экспорт данных в электронную таблицу Excel 

Export to Csv... 
(Экспортировать в CSV) 

Экспорт данных в виде текстового документа 

Export to Xml 
(Экспортировать в Xml). 

Экспорт данных в виде документа формата .xml 

Well Labels (Метки лунок) Изменение меток лунок на «тип образца», «имя мишени» или 
«имя образца» 
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Временное исключение лунок из анализа 

Для временного исключения лунок из анализа: 

ОПЦИЯ МЕНЮ, ВЫЗЫВАЕМОГО ЩЕЛЧКОМ ПРАВОЙ КНОПКОЙ МЫШИ 

1. Щелкните правой кнопкой мыши на лунке в инструменте выбора лунок или на данных 
флуоресценции, или на точке, нанесенной на стандартную кривую. Для исключения 
множества лунок щелкните правой кнопкой мыши и «перетащите» рамку, выделив 
множество лунок, кривых или точек. 

2. В контекстном меню выберите соответствующую опцию: 
Well > Exclude Well (Лунка > Исключить лунку) 
Selected Wells > Exclude from Analysis (Выбранные лунки > Исключить из анализа) 
Selected Traces > Exclude these wells from Analysis (Выбранные кривые > Исключить 
данные лунки из анализа) 

 

Рис. 57. Щелкните правой кнопкой мыши для исключения лунок из анализа 

ПРИМЕЧАНИЕ: Для повторного включения исключенных лунок в анализ щелкните на 
соответствующей лунке в селекторе лунок, щелкните правой кнопкой мыши и выберите 
Include Well XX in Analysis (Включить лунку XX в анализ). 

ИСПОЛЬЗОВАНИЕ РЕДАКТОРА ЛУНОК 

1. В меню кнопки задания параметров планшета на панели инструментов окна Data Analysis 
выберите View/ Edit Plate.... 

2. Выберите одну или несколько лунок в селекторе лунок. 

3. Щелкните на Exclude Wells in Analysis (Исключить лунки из анализа) (Рис. 58) для 

исключения выбранных лунок. Данная кнопка-флажок расположена в нижней части секции 
элементов управления редактора планшетов в правой области окна. 
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Рис. 58. Кнопка-флажок Exclude Wells in Analysis в нижней части секции окна 

4. Исключенные лунки помечаются «звездочкой» (*) в окне Plate Editor. 

Для постоянного удаления лунок из анализа удалите содержимое лунок в редакторе планшетов, 
щелкнув на кнопке Clear Wells (Очистить лунки). 

ВНИМАНИЕ! Удаленное содержимое любой лунки подлежит повторному вводу. 

Графики 

Каждый график в окне Data Analysis отображает данные и содержит опции для регулировки 
данных. Для увеличения области графика выберите область щелчком и «перетаскиванием» 
мышью. Программное обеспечение изменит размеры графика и сцентрирует его в выбранной 
области. 

СОВЕТ: Возврат графика к полному обзору производится щелчком правой кнопкой мыши на 
графике и выбором пункта Set Scale to Default (Задать масштаб по умолчанию) в меню, 

вызываемом правой кнопкой мыши. 

Основные пункты меню, вызываемого правой кнопкой 
мыши, для графиков 

Пункты меню, вызываемого правой кнопкой мыши, доступны на всех графиках. Некоторые 
доступные пункты предоставляются для всех графиков и могут быть использованы для изменения 
способа отображения данных или экспорта данных из графика (Таблица 22). 

Таблица 22. Пункты меню, вызываемого правой кнопкой мыши, для графиков 
 

Пункт меню Функция 

Copy (Копировать) Копирование графика в буфер промежуточного хранения 

Save Image As... 
(Сохранить изображение как) 

Сохранение изображения с заданным размером и 
разрешением в виде файла изображения выбранного типа. 
Доступны следующие форматы: PNG (по умолчанию), GIF, 
JPG, TIF и BMP 

Page Setup… 
(Макет страницы) 

Предварительный просмотр и выбор параметров страницы 
для печати 

Print... (Печатать) Печать графика 

Set Scale to Default 
(Задать масштаб по умолчанию) 

Возврат представления графика к исходному масштабу после 
увеличения 

Chart Options... 
(Опции графика) 

Открытие окна Chart Options для изменения графика, включая 
изменение заголовка, выбор пределов для осей x и y, 
отображение линий сетки и незначительных пометок на осях 
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Графики можно скопировать в документы формата Microsoft Word или PowerPoint, щелкнув на значке 
в верхнем правом углу секции окна, «перетащив» и отпустив в требуемом месте. Разрешение 
изображения будет соответствовать разрешению экрана, с которого оно было получено. 

ПРИМЕЧАНИЕ: Описание пунктов меню, применяющихся к конкретным графикам, 
приведено в следующей главе «Закладки окна Data Analysis» (стр. 85). 

Электронные таблицы 

Электронные таблицы, отображаемые в окне Data Analysis, включают опции сортировки и 
передачи данных. Сортировка столбцов производится одним из следующих способов: 

• Щелчком кнопкой мыши и «перетаскиванием» столбца в новое положение в выбранной 
таблице 

• Щелчком кнопкой мыши на заголовке столбца для сортировки данных в восходящем или 
нисходящем порядке 

Для сортировки до трех столбцов данных в окне Sort (Сортировать) выполните следующие шаги: 

1. Щелкните правой кнопкой мыши на электронной таблице для открытия меню и выберите Sort. 

2. В окне Sort выберите первый столбец для сортировки щелчком кнопкой мыши на заголовке 
столбца. Отсортируйте данные в восходящем или нисходящем порядке. 

3. Выберите несколько заголовков в ниспадающем меню. Выберите Ascending (Восходящий) 
или Descending (Нисходящий) для сортировки столбца в нужном порядке. 

4. Щелкните на кнопке OK для сортировки данных или на кнопке Cancel для отмены или 

прекращения сортировки. 

Выделите данные на соответствующих графиках и инструмент выбора лунок, удерживая курсор 
мыши над ячейкой. Щелчком кнопкой мыши на ячейке вы можете скопировать содержимое для 
вставки в другую программу программного обеспечения. 

Основные пункты контекстного меню для электронных 
таблиц 

Щелкните правой кнопкой мыши в любой области инструмента выбора лунок для выбора пунктов 
меню, перечисленных в Таблице 23. 

Таблица 23. Пункты контекстного меню для электронных таблиц 
 

Пункт меню Функция 

Copy (Копировать) Копирование содержимого выбранных лунок в буфер 
промежуточного хранения с последующей вставкой содержимого 
в электронную таблицу формата Excel 

Copy as Image 
(Копировать как изображение) 

Копирование представления электронной таблицы в виде 
изображения и вставка его в файл, принимающий изображения, 
такой как текстовый файл, файл изображения или файл 
электронной таблицы 

Print... (Печатать) Печать текущего представления 

Print Selection… 
(Печатать выбранное) 

Печать текущих выбранных компонентов 

Export to Excel... 
(Экспортировать в Excel) 

Экспорт данных в электронную таблицу Excel  

Export to Text 
(Экспортировать в текст) 

Экспорт данных в текстовый редактор 

Export to Xml 
(Экспортировать в Xml). 

Экспорт данных в файл формата Xml 

Export to Html 
(Экспортировать в Html) 

Экспорт данных в файл формата Html 

Find... (Найти) Поиск текста 

Sort… (Сортировать) Сортировка данных до трех столбцов 

Select Columns… 
(Выбрать столбцы) 

Выбор столбцов, которые будут отображены в электронной 
таблице 
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Экспорт 

Ниспадающее меню Export предоставляет четыре опции экспорта. 

Export All Data Sheets to Excel (Экспортировать все 
таблицы данных в Excel) 

Выберите Export > Export All Data Sheets для экспорта всех представлений электронных таблиц 

из каждой закладки программного обеспечения CFX Manager в отдельные файлы. 

Экспорт файлов RDML 

Выберите Export > Export RDML Files (Экспорт > Экспортировать файлы RDML) и выберите 

версию 1.1 или 1.0 для открытия окна Save As и указания имени и расположения файла формата 
RDML (язык разметки данных ПЦР реального времени). RDML – это структурированный и 
универсальный стандарт обмена данными количественной ПЦР (qPCR). Стандарт данных - это 
текстовый файл в формате расширяемого языка разметки (.xml). Обратитесь в веб-сайту 
Международного консорциума по RDML (www.rdml.org) для получения дополнительной 
информации о формате обмена данными RDML. 

ПРИМЕЧАНИЕ: Сохраните файл RDML в версии 1.1, если Вы используете программное 
обеспечение qbase

PLUS
 версии 2.3 или выше. 

Экспорт индивидуальных отчетов 

Выберите Export > Custom Export (Экспорт > Экспортировать индивидуальный отчет) для 

открытия окна, из которого можно экспортировать поля и задать формат файла (Рис. 59). 

http://www.rdml.org/
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Рис. 59. Окно Custom Export 

1. Вберите формат экспорта: Text *.txt, CSV *.csv, Excel 2007 *.xlsx, Excel 2003 *.xls, XML *.xml, 
и HTML *.html. 

2. Выберите пункты, которые будут экспортированы, выбрав соответствующие кнопки-флажки. 

3. Щелкните на кнопке Customize Column Names (Изменить заголовки столбцов) для 

изменения заголовков столбцов. 

4. Щелкните на кнопке Export для открытия окна Save As для задания имени и расположения 

экспортируемого файла. 

Экспорт в папку LIMS 

Выберите Export > Export to LIMS Folder для открытия окна Save As (Сохранить как) и задания 

имени файла для LIMS-совместимого формата файла, который будет сохранен в 
предопределенном месте в папке LIMS. Более подробная информация по созданию, управлению 

и использованию файлов LIMS приведена в Разделе «Интеграция системы LIMS» (стр. 146). 
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8 Закладки окна Data Analysis 

В данной главе приведена подробная информация о закладках окна Data Analysis: 

• Закладка Quantification (Количественный анализ) (стр. 85) 

• Закладка Quantification Data (Данные количественного анализа) (стр. 89) 

• Закладка Melt Curve (Кривая плавления) (стр. 92) 

• Закладка Melt Curve Data (Данные кривой плавления) (стр. 93) 

• Закладка End Point (Конечная точка) (стр. 96) 

• Закладка Allelic Discrimination (Дискриминация аллелей) (стр. 98) 

• Закладка Custom Data View (Представление данных, задаваемое пользователем) (стр. 100) 

• Закладка QC (Контроль качества) (стр. 101) 

• Закладка Run Information (Информация об эксперимента) (стр. 102) 

• Отчеты на основе файлов данных (стр. 103) 

• Отчеты по группам лунок (стр. 106) 

ПРИМЕЧАНИЕ: Закладки, отображаемые в окне анализа данных, могут быть изменены 
пользователем после выбора в меню View. Даная конфигурация будет сохранена с 

файлом. 

Закладка Quantification (Количественный анализ) 

Используйте данные закладки Quantitation (Рис. 60) для задания условий анализа данных, включая 
настройки базовой линии для отдельных лунок и настройки порогового уровня. Закладка 
Quantitation отображает данные в следующих четырех представлениях: 

• График амплификации. Отображает относительные единицы флуоресценции (RFU/ОЕФ) 

для каждой лунки в каждом цикле. Каждый след на графике представляет данные от одного 
флуорофора в одной лунке 

• Стандартная кривая. Данный график отображается только если в эксперимент включены 

лунки, обозначенные как Sample Type Standard (Стандартный образец). Отображает 
стандартную кривую зависимости порогового цикла от логарифма начального количества. 
Легенда отображает эффективность реакции (E) для каждого флуорофора в лунках со 
стандартным образцом 

• Селектор лунок. Выбирает лунки с данными флуоресценции, которые Вы хотите 

отобразить 

• Электронная таблица. Отображает электронную таблицу данных, собранных в выбранных 

лунках 
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Рис. 60. Конфигурация окна Data Analysis с закладкой Quantification 

Селектор флуорофоров 

Для выбора данных флуорофоров, которые будут отображены на графиках и в электронных 
таблицах закладки Quantitation, щелкните на селекторе флуорофоров под графиком Amplification. 
Выберите/отмените выбор кнопки-флажка рядом с именем флуорофора для отображения или 
скрытия данных в окне анализа данных. 

Окно Trace Styles (Внешний вид данных) 

Откройте окно Trace Styles (Рис. 61) для регулировки внешнего вида данных на графиках 
амплификации и кривой плавления в закладках Quantitation и Melt Curve. 

Для открытия данного окна выполните следующие инструкции: 

1. Выберите только один флуорофор в полях выбора флуорофоров (рисунок 54 на стр. 78). 

2. Щелкните на кнопке Trace Styles на панели инструментов окна Data Analysis или выберите 
Settings > Trace Styles в строке меню окна Data Analysis, или щелкните правой кнопкой 
мыши на кривой и выберите Trace Styles. 
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Рис. 61. Окно Trace Styles 

Используйте инструменты окна Trace Styles для регулировки внешнего вида данных и 
предварительного просмотра изменений в инструменте выбора лунок в нижней части окна. 

• Выберите конкретный набор лунок с помощью инструмента выбора лунок. Или выберите 
лунки, содержащие один тип образца, в ниспадающем меню столбца Wells (Лунки) 

• Щелкните на окошке столбца Color (Цвет) для выбора цвета для лунок 

• Выберите символ из ниспадающего меню столбца Symbol (Символ) 

• Можно выбрать опцию Color Quick Set для окрашивания лунок одним из следующих 

способов: Random by Well (Произвольно по лунке), Random by Replicate (Произвольно по 
дубликату), Use Fluor Colors (Использовать цвета флуорофора), Use Target Colors 
(Использовать цвета мишени) или Use Sample Colors (Использовать цвета образца) 

• Выберите Well Labels (Метки лунок), щелкнув на Sample Type (Тип образца), Target Name 

(Имя мишени), Sample Name (Имя образца) или Symbol (Символ) 

Опция Log Scale (Логарифмическая шкала) 

Выберите кнопку-флажок Log Scale под графиком Amplification для отображения данных 

флуоресценции в полулогарифмическом масштабе, как показано на Рис. 62. 

 

Рис. 62. Выбранная опция Log Scale графика амплификации 

TIP: Для увеличения области графика выделите область щелчком и «перетаскиванием» 
мышью. Для возврата к полному обзору щелкните правой кнопкой мыши и выберите Set 
Scale to Default в меню. 



Закладки окна Data Analysis  

88 

Стандартная кривая 

Программное обеспечение создает график стандартной кривой (Standard Curve) (Рис. 63) в 
закладке Quantitation, если данные включают типы образцов, определенные как стандартные (Std) 
для одного флуорофора в эксперименте. 

 

Рис. 63. Стандартная кривая 

Стандартная кривая отображает следующую информацию: 

• Имя флуорофора или мишени для каждой кривой 

• Цвет каждого флуорофора или мишени 

• Реакционную эффективность (E). Используйте данную статистику для оптимизации 
мультиплексной реакции и уравнивания данных для стандартной кривой 

• ПРИМЕЧАНИЕ: Реакционная эффективность описывает количество мишеней, 
определяемых в каждом цикле протокола. Эффективность 100% означает, что Вы 
удваиваете количество мишеней с каждым циклом 

• Коэффициент определенности, R
2
, (записан как R^2). Используйте данную статистику для 

определения точности описания данных линией (точность подбора) 

• Наклон 

• Точка пересечения с осью Y 

Опции контекстного меню графика 

В дополнение к основным опциям меню для копирования, печати и экспорта графиков, Таблица 24 
приводит перечень опций меню, доступных только на графике амплификации. 

Таблица 24. Опции меню, вызываемого правой и левой кнопкой мыши, для графика 
амплификации 

 

Опция меню Функция 

Well XX, Fluor/Target 
(Лунка XX, 
Флуорофор/Мишень) 

Просмотр только данной лунки, удаление данной лунки, задание 
цвета данной лунки или исключение данной лунки из анализа. 

Selected Traces 
(Выбранные лунки) 

Просмотр только данных лунок, удаление данных лунок, задание 
цвета данных лунок или исключение данных лунок из анализа 

Show Threshold Values 
(Отобразить пороговые 
значения) 

Отображение порогового значения для каждой кривой 
амплификации на графике 
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Trace Styles 
(Внешний вид данных) 

Открытие окна Trace Styles для изменения внешнего вида 
данных, появляющихся в закладках Quantitation (Количественный 
анализ) и Melt Curve (Кривая плавления)  

Baseline Thresholds 
(Базовая линия/Пороговые 
уровни) 

Откройте окно Baseline Thresholds для изменения базовой линии 
или пороговых значений каждого флуорофора (изменения 
появляются на графике амплификации закладки Quantification) 

Электронная таблица закладки Quantification 

Таблиц 25 отображает тип данных электронной таблицы, расположенной в нижнем правом углу 
закладки Quantification: 

Таблица 25. Содержимое электронной таблицы закладки Quantification 
 

Информация Описание 

Well Позиция лунки на планшете 

Fluor Детектированный флуорофор 

Target Имя мишени, загруженной в лунки в окне Plate Editor 

Content Комбинация типа образца (обязательно) и количества 
дубликатов (опционально), загруженных в программу Plate Editor 

Sample Имя образца, загруженного в лунки в окне Plate Editor 

Cq Цикл количественного анализа для каждой лунки 

СОВЕТ: Для внесения изменений в столбцы Content, Target и Sample откройте окно Plate 
Editor, щелкнув на кнопке Plate Setup и выбрав View/Edit Plate. 

Закладка Quantitation Data (Данные количественного 
анализа) 

Закладка Full Results отображает электронные таблицы, содержащие данные, собранные с каждой 
лунки. Выберите одну из четырех опций для отображения данных в различных форматах: 

• Results (Результаты). Отображает данные в виде электронной таблицы 

• Standard Curve Results (Результаты стандартной кривой). Отображает данные 

стандартной кривой в виде электронной таблицы 

• Plate (Планшет). Отображает данные в каждой лунке в виде карты планшета 

• RFU (ОЕФ). Выберите данную электронную таблицу для отображения данных каждой лунки 

для каждого цикла в относительных единицах флуоресценции (ОЕФ) 

СОВЕТ: Вызов опций, включая опцию сортировки, производится щелчком правой кнопкой 
мыши на электронной таблице. 
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Электронная таблица Results (Результаты) 

Выберите электронную таблицу Results (Рис. 64) для отображения данных каждой лунки 

планшета. 

 

Рис. 64. Закладка Quantification Data с выбранной электронной таблицей Results 

ПРИМЕЧАНИЕ: Все расчеты среднеквадратических отклонений (Std.Dev) применяются к 
группам дубликатов, назначенных лункам в окне Plate Editor. Расчеты усредняют значение 
Cq для каждой лунки в группе дубликатов. 

Электронная таблица Results включает следующую информацию (Таблица 26). 

Таблица 26. Содержимое электронной таблицы Results 
 

Информация Описание 

Well Позиция лунки на планшете 

Fluor Детектированный флуорофор 

Target Имя мишени (гена) для амплификации 

Content Тип образца и число дубликатов 

Sample Описание образца 

Biological Set Name Имя биологического набора 

Cq Цикл количественного анализа 

Cq Mean Среднее значение цикла количественного анализа для группы 
дубликатов 

Cq Std. Dev Среднеквадратическое отклонение цикла количественного 
анализа для группы дубликатов 

Starting Quantity (SQ) Оценочное начальное количество мишени 

Log Starting Quantity Логарифм начального количества 

SQ Mean Среднее значение начального количества 

SQ Std. Dev Среднеквадратическое отклонение начального количества среди 
дубликатов 

Set Point Уставка температуры образца в лунке для этапа температурного 
градиента 

Электронная таблица Standard Curve Results (Результаты 
стандартной кривой) 

Выберите электронную таблицу Standard Curve Results (Рис. 65) для просмотра параметров 
вычисленной стандартной кривой. 
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Рис. 65. Электронная таблица Standard Curve Results закладки Quantification Data 

Данные значения можно скопировать и вставить в документ, щелкнув правой кнопкой мыши и 
выбрав Copy, или создать файл, выбрав одну из опций Export. 

Таблица 27. Содержимое электронной таблицы Standard Curve Results 
 

Информация Описание 

Fluor (or Target) Детектированный флуорофор (или мишень) 

Efficiency % Реакционная эффективность 

Slope Наклон стандартной кривой 

Y-intercept Точка пересечения кривой с осью Y 

R^2 Коэффициент определенности 

Электронная таблица Plate (Планшет) 

Выберите электронную таблицу Plate для отображения карты планшета с данными для одного 

флуорофора. Выберите отдельные флуорофоры щелчком кнопкой мыши на закладке в нижней 
части электронной таблицы. На Рис. 66 представлена электронная таблица Plate в виде карты 
планшета. 

 

Рис. 66. Электронная таблица Plate закладки Quantification Data 
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Электронная таблица RFU (ОЕФ) 

Выберите электронную таблицу RFU для просмотра показаний в относительных единицах 
флуоресценции для каждой лунки, собранных в каждом цикле эксперимента. Выберите отдельные 
флуорофоры щелчком кнопкой мыши на закладке в нижней части электронной таблицы. Над 
каждым столбцом отображается номер лунки, а номер цикла отображается слева от каждого ряда 
(Рис. 67). 

 

Рис. 67. Электронная таблица RFU закладки Quantification Data 

Закладка Melt Curve (Кривая плавления) 

Для ДНК-связывающих красителей и нерасщепляемых гибридизационных зондов флуоресценция 
более яркая при отжиге двух цепочек ДНК. Поэтому, по мере приближения температуры к точке 
плавления (Tm) интенсивность флуоресценции понижается с постоянной скоростью (постоянный 
наклон). В точке Tm наблюдается резкое снижение интенсивности флуоресценции с заметным 
изменением наклона. Скорость данного изменения определяется построением графика 
зависимости отрицательной регрессии флуоресценции от температуры ((-d(ОЕФ)/dT). Наивысшая 
скорость изменения интенсивности флуоресценции демонстрируется видимыми пиками и 
представляет температуру плавления комплексов с двухцепочечной ДНК. 

Программное обеспечение размещает на графике данные ОЕФ, собранные в момент построения 
кривой плавления, в зависимости от температуры. Для анализа данных пика плавления 
программное обеспечение назначает каждому пику начальную и конечную температуру, 
перемещая пороговую линию. Нижняя планка площади пика задается положением пороговой 
линии. Действительный пик может иметь минимальную высоту относительно расстояния между 
пороговой линией и высотой самого большого пика. 

Откройте закладку Melt Curve (Рис. 68) для определения температуры плавления (Tm) 
амплифицированных продуктов ПЦР. Данная закладка отображает данные кривой плавления в 
следующих четырех представлениях: 

• Melt Curve (Кривая плавления). Отображение данных реального времени для каждого 

флуорофора в виде графика зависимости ОЕФ от температуры для каждой лунки 

• Melt Peak (Пик плавления). Отображение отрицательной регрессии данных ОЕФ 

относительно температуры для каждой лунки 

• Well Selector (Селектор лунок). Выбор лунок для отображения или скрытия данных 

• Peak spreadsheet (Электронная таблица пиков). Отображение электронной таблицы 

данных, собранных в выбранных лунках 

ПРИМЕЧАНИЕ: Данная электронная таблица отображает до двух пиков на кривую. Для 
вывода на экран большего количества пиков щелкните на закладке Melt Curve Data 

(стр. 93). 
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Рис. 68. Конфигурация закладки Melt Curve окна Data Analysis 

Отрегулируйте данные кривой плавления одним из следующих методов: 

• Отрегулируйте пороговый уровень на графике пиков плавления для включения или 
исключения пиков в анализ/из анализа данных щелчком и «перетаскиванием» 

• Выберите Positive (Положительный) в ниспадающем меню Peak Type (Тип пика) для 

отображения данных для пиков выше пороговой линии температуры плавления или 
выберите Negative (Отрицательный) для отображения данных для пиков ниже пороговой 

линии температуры плавления 

• Откройте окно Trace Styles для изменения цвета данных на графиках кривой плавления и 
пика плавления 

• Выберите количество в селекторе количества этапов (стр. 75) для отображения данных 
кривой плавления на другом этапе протокола. Перечень отображает более одного этапа, 
если протокол включает прочтение планшета (значок «камера») на двух или более этапах 
плавления 

• Выберите лунки в селекторе лунок для фокусирования на подмножествах данных 

• Выберите группу лунок (стр. 75) для отображения и анализа подгруппы лунок на планшете. 
Выберите каждую группу лунок по имени в ниспадающем меню Well Group на панели 
инструментов 

Закладка Melt Curve Data (Данные кривой плавления) 

Закладка Melt Curve Data отображает данные закладки Melt Curve в виде множества электронных 
таблиц, включающих все пики плавления для каждой кривой. Выберите одну из четырех опций для 
отображения данных кривой плавления в различных электронных таблицах: 

• Melt Peak (Пики плавления). Перечень всех данных, включая все пики плавления, для 

каждой кривой 

• Plate (Планшет). Перечень данных и содержимого каждой лунки планшета 

• RFU (ОЕФ). Перечень количеств ОЕФ при каждой температуре для каждой лунки 

• -d(RFU)/dT (-d(ОЕФ)/dT). Перечень отрицательных скоростей изменения ОЕФ при 

изменении температуры (T). Это первый график регрессии для каждой лунки планшета 
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Электронная таблица Melt Peaks Spreadsheet 
(Пики плавления) 

Выберите электронную таблицу Melt Peaks (Рис. 69) для просмотра данных кривой плавления. 

 

Рис. 69. Электронная таблица Melt Peaks закладки Melt Curve Data 

Электронная таблица пиков плавления (Рис. 69) включает следующую информацию (Таблица 28): 

Таблица 28. Содержимое электронной таблицы Melt Peaks 
 

Информация Описание 

Well Позиция лунки на планшете 

Fluor Детектированный флуорофор 

Content Тип образца, указанный в списке окна Plate Editor 

Target Имя мишени (гена) для амплификации 

Sample Имя образца, указанное в списке окна Plate Editor 

Melt Temperature Температура плавления каждого продукта (один пик (самый высокий) на ряд 
в электронной таблице) 

Peak Height Высота пика 

Begin Temperature Температура в начале пика 

End Temperature Температура в конце пика 
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Электронная таблица Plate (Планшет) 

Выберите электронную таблицу Plate (Рис. 70) для отображения данных кривой плавления на 
карте планшета. 

 

Рис. 70. Электронная таблица Plate закладки Melt Curve Data 

ПРИМЕЧАНИЕ: Для регулировки пика отрегулируйте пороговую линию на графике кривой 
плавления закладки Melt Curve. 

Электронная таблица Plate содержит следующую информацию (Таблица 29): 

Таблица 29. Содержимое электронной таблицы Plate 
 

Информация Описание 

Content Комбинация типа образца (обязательно) и количества 
дубликатов (опционально) 

Sample Описание образца 

Peak 1 Первый пик плавления (самый высокий) 

Peak 2 Второй пик плавления (низкий) 

Электронная таблица RFU (ОЕФ) 

Выберите электронную таблицу RFU для просмотра показаний в относительных единицах 

флуоресценции для каждой лунки, собранных при построении кривой плавления (Рис. 71). 

 

Рис. 71. Электронная таблица RFU закладки Melt Curve Data 
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Информация, отображаемая в электронной таблице RFU, приведена в Таблице 30. 

Таблица 30. Содержимое электронной таблицы RFU 
 

Информация Описание 

Well number (A1, A2, A3, A4, 
A5...) 

Позиция загруженной лунки на планшете 

Temperature Температура плавления амплифицированной мишени. Одна 
лунка на ряд и множество лунок для множества продуктов в 
одной лунке 

Электронная таблица -d(RFU)/dT (-d(ОЕФ)/dT) 

Выберите электронную таблицу -d(RFU)/dT для просмотра типов данных, отображенных на 
Рис. 72. 

 

Рис. 72. Электронная таблица -d(RFU)/dT закладки Melt Curve Data 

Информация, отображаемая в электронной таблице -d(RFU)/dT, приведена в Таблице 31. 

Таблица 31. Содержимое электронной таблицы -d(RFU)/dT 
 

Информация Описание 

Well number 
(A1, A2, A3, A4, A5...) 

Позиция загруженной лунки на планшете 

-d(RFU)/dT Отрицательная скорость изменения ОЕФ при изменении 
температуры (T) 

Закладка End Point (Конечная точка) 

Откройте закладку End Point для анализа конечных относительных единиц флуоресценции (ОЕФ) 
для лунок с образцами. Программное обеспечение производит сравнение уровней ОЕФ для лунок 
с неизвестными образцами с уровнями ОЕФ с отрицательными контролями и осуществляет 
количественный анализ отрицательных образцов как положительных и отрицательных. Значение 
ОЕФ положительных образцов превышает среднее значение ОЕФ отрицательных контролей плюс 
значение критической оптической плотности («уровня среза» (cutoff)). 

Для анализа данных конечной точки планшет должен содержать отрицательные контроли, в 
противном случае программное обеспечение не сможет произвести идентификацию. Выполните 
один из двух данных типов протоколов: 

• Выполните протокол количественного анализа. Задайте параметры стандартного 

протокола. После завершения эксперимента откройте окно Data Analysis, отрегулируйте 
настройки анализа данных в закладке Quantitation и затем щелкните на закладке End Point 
для определения конечного цикла 

• Выполните протокол анализа флуоресценции по конечной точке. Загрузите протокол 

анализа флуоресценции по конечной точке в закладку Plate окна Run Setup, выберите или 
создайте планшет и запустите эксперимент 
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Закладка End Point отображает средние значения ОЕФ для определения, была или не была 
произведена амплификация мишени последним (конечным) циклом. Используйте эти данные для 
определения присутствия (положительный результат) специфической целевой 
последовательности в образце. Значения ОЕФ положительных мишеней выше определенного 
Вами «уровня среза». 

СОВЕТ: Для создания протокола анализа по конечной точке откройте закладку Protocol (окно 
Run Setup) и выберите Options > End Point Only Run (Опции > Анализ флуоресценции по 
конечной точке). 

Программное обеспечение отображает эти данные в закладке End Point: 

• Settings (Настройки). Отрегулируйте настройки анализа данных 

• Results (Результаты). Отображение результатов немедленно после регулировки настроек 

• Well Selector (Селектор лунок). Выбирает лунки с данными флуоресценции, которые вы 

хотите отобразить 

• Well spreadsheet (Электронная таблица данных лунок). Отображает электронную 

таблицу уровней ОЕФ в конечной точке, собранных в выбранных лунках 

 

Рис. 73. Конфигурация закладки End Point 

Перечень результатов (Results) включает следующую информацию: 

• Lowest RFU value (Сааме низкое значение ОЕФ). Самое низкое значение ОЕФ в данных 

• Highest RFU value (Самое высокое значение ОЕФ). Самое высокое значение ОЕФ в 

данных 

• Negative Control Average (Среднее для отрицательных контролей). Среднее значение 

ОЕФ для лунок, содержащих отрицательные контроли 

• Cut Off Value (Критическая оптическая плотность). Рассчитывается посредством 

добавления допуска (RFU (ОЕФ) или Percentage of Range (Диапазон в процентах) в секции 
Settings (Настройки) и среднего значения ОЕФ отрицательных контролей. Образцы с 
уровнем ОЕФ, превышающим критическую оптическую плотность, рассматриваются как 
положительные. Для регулировки «уровня среза» измените значение в поле RFU или в поле 
Percentage of Range 

Критическая оптическая плотность рассчитывается по следующей формуле: 

Критическая оптическая плотность = среднее значения ОЕФ отрицательных контролей + допуск 

Выберите допуск одним из следующих методов: 

• RFUs (ОЕФ) (по умолчанию). Выберите данный метод для использования абсолютного 

значения ОЕФ для допуска. Минимальное значение допуска для ОЕФ составляет 2. 
Максимальным значением является модуль самого высокого уровня ОЕФ минус модуль 
самого низкого уровня ОЕФ. Значение допуска для ОЕФ составляет 10% от общего 
диапазона ОЕФ 

• Percent of Range (Диапазон в процентах). Выберите данный метод для использования 

диапазона ОЕФ в процентах для допуска. Минимальный процент диапазона – 1%. 
Максимальный процент диапазона – 99%. Процент диапазона по умолчанию – 10%. 
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Регулировка настроек анализа данных флуоресценции по 
конечной точке 

Откорректируйте данные в закладке End Point одним из следующих методов: 

• Выберите Fluorophore (Флуорофор) из ниспадающего списка для отображения данных 

• Выберите End Cycle to Average (Среднее значение по конечному циклу) для задания 

количества циклов, которое программное обеспечение будет использовать для расчета 
среднего значения ОЕФ в конечной точке 

• Выберите RFUs для отображения данных в относительных единицах флуоресценции 

• Выберите Percentage of Range для отображения данных как процент диапазона ОЕФ 

• Выберите лунки в селекторе лунок для фокусирования на подмножествах данных 

• Выберите группу лунок (стр. 75) для отображения и анализа подгруппы лунок на планшете. 
Выберите каждую группу лунок по имени в ниспадающем меню Well Group на панели 
инструментов 

Описание данных флуоресценции по конечной точке 

В Таблице 32 приведена информация, содержащаяся в электронной таблице закладки End Point. 

Таблица 32. Содержимое электронной таблицы End Point 
 

Информация Описание 

Well Позиция лунки на планшете 

Fluor Детектированный флуорофор 

Content Комбинация типа образца и количества дубликатов 

End RFU Количество ОЕФ в конечном цикле 

Call Положительные или отрицательные, где значение ОЕФ положительных 
образцов превышает среднее значение ОЕФ отрицательных контролей 
плюс значение критической оптической плотности 

Sample Имя образца, загруженного в лунки в окне Plate Editor 

Закладка Allelic Discrimination (Дискриминация аллелей) 

Закладка Allelic Discrimination назначает генотипы лункам с неизвестными образцами. Используйте 
эти данные для идентификации генотипов образцов, включая аллель 1 (Allele 1), аллель 2 
(Allele 2), гетерозиготу (Heterozygote), отсутствие амплификации (No Call) и неопределенный 
(Undetermined). 

ПРИМЕЧАНИЕ: Данные для дискриминации аллелей должны быть получены из 
многократных экспериментов с использованием не менее двух флуорофоров. Каждый 
флуорофор идентифицирует один аллель во всех образцах. 

Аллельный дискриминантный анализ требует следующего минимального содержимого лунок: 

• Два флуорофора в каждой лунке 

• Образцы без ДНК-мишени (NTC) для оптимизации анализа данных 

Программное обеспечение отображает данные дискриминации аллелей в следующих 
представлениях: 

• RFU chart (График ОЕФ). Отображение данных на графике ОЕФ для аллеля 1/аллеля 2. 

Каждая точка на графике представляет данные от двух флуорофоров в одной лунке. Вы 
можете осуществлять переключение между прямоугольной и полярной системами 
координат, выбирая и отменяя выбор кнопки-флажка Polar Coordinates (Полярные 
координаты). Система прямоугольных координат представляет ОЕФ для аллеля 1 по оси X 
и ОЕФ для аллеля 2 – по оси Y. Полярная система координат представляет угол по оси X и 
расстояние ОЕФ по оси Y от начала координат (медиана всех NTC) 

• Well spreadsheet (Электронная таблица данных лунок). Отображает электронную 

таблицу, перечисляющую данные дискриминации аллелей, собранные в каждой лунке 
планшета 

• Well selector (Селектор лунок). Выбирает лунки с данными флуоресценции, которые вы 

хотите отобразить 
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• Well spreadsheet (Электронная таблица данных лунок). Отображает электронную 

таблицу данных дискриминации аллелей, собранных в выбранных лунках 

• Setting Panel (Панель настроек). Отображает изменения по осям X и Y на графике 

дикриминации аллелей, предоставляет возможность выбора цикла для анализа и 
отображения карты сигналов 

 

Рис. 74. Конфигурация закладки Allelic Discrimination окна Data Analysis 

Корректировка данных для дискриминации аллелей 

Программное обеспечение автоматически назначает генотип лункам с неизвестными образцами 
на основании положений образцов без ДНК-мишени и расстоянии точек неизвестных данных от 
образцов без ДНК-мишени. 

Откорректируйте данные дискриминации аллелей одним из следующих методов: 

• Выберите флуорофор для каждой оси графика (X: и Y:) в опциях настроек в нижней правой 

части окна 

• Измените параметры идентификации в ручном режиме щелчком левой кнопкой мыши и 
«перетаскиванием» для выбора точек данных на графике дискриминации аллелей, и затем 
выбрав опцию в Selected Wells (включая Allele 1 (Аллель 1), Allele 2 (Аллель 2), 

Heterozygote (Гетерозигота), No Call (Отсутствует), Undetermined (Неопределенный), Auto 
Call (Автоматическая идентификация)). Вы можете выбрать Auto Call, и тогда 
идентификация будет производиться программным обеспечением 
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Опции контекстного меню графика 

В дополнение к основным опциям меню для копирования, печати и экспорта графиков, 
(Таблица 22) Таблица 33 приводит перечень опций меню, доступных на графике дискриминации 
аллелей. 

Таблица 33. Опции меню, вызываемого правой и левой кнопкой мыши, для графика 
дискриминации аллелей 

 

Опция меню Функция 

Zoom (Изменить масштаб) Фокусирование на выбранной области при наличии более 
одной точки данных 

Well XX (Лунка XX) Просмотр только данной лунки, удаление данной лунки, 
задание цвета данной лунки или исключение данной лунки из 
анализа 

Selected Wells (Выбранные 
лунки) 

Изменение сигналов, просмотр только данных лунок, удаление 
данных лунок, задание цвета данных лунок или исключение 
данных лунок из анализа 

Электронная таблица Allelic Discrimination 
(Дискриминация аллелей) 

Электронная таблица Allelic Discrimination в верхней правой части закладки Allelic Discrimination 
отображает информацию, приведенную в Таблице 34. 

Таблица 34. Содержимое электронной таблицы Allelic Discrimination 
 

Информация Описание 

Well Позиция лунки на планшете 

Sample Имя/описание образца 

Call Идентификация аллелей, включая Allele 1 (Аллель 1), Allele 2 
(Аллель 2), Heterozygote (Гетерозигота), No Call (Отсутствует) или 
Undetermined (Неопределенный) 

RFU1 ОЕФ для аллеля 1 

RFU2 ОЕФ для аллеля 2 

Type Автоматический или ручной режим. Описывает способ 
идентификации. Автоматический означает идентификацию 
программным обеспечением. Ручной означает, что 
идентификация была произведена пользователем 

Закладка Custom Data View (Представление данных, 
задаваемое пользователем) 

Закладка Custom Data View одновременно отображает множество секций окна в настраиваемом 
пользователем формате (Рис. 75). 

Ниспадающее меню Load a Preset View (Загрузить заданное представление) предлагает выбор 

форматов отображения. Формат отображения по умолчанию зависит от анализируемого файла. 
Например, если представлены данные кривой плавления, представлением по умолчанию будет 
формат «данные амплификации + данные плавления». 

Представление данных может быть впоследствии изменено пользователем: 

• Выбор альтернативного заданного представления из ниспадающего списка 

• Использование ниспадающего меню, расположенного в верхней части отдельной секции 
окна 

• Использование опций выбора рядов и столбцов 

• Изменение размеров отдельных секций окна щелчком кнопкой мыши и «перетаскиванием» 
границ 
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Заданные пользователем представления могут быть сохранены как новые заданные шаблоны 
щелчком на Save as Preset (Сохранить как заданный). Существующие заданные представления 

могут быть удалены, переименованы или возвращены к шаблонам по умолчанию с помощью 
опции Manage Presets (Управлять заданными представлениями). 

 

Рис. 75. Закладка Custom Data View 

Закладка QC (Контроль качества) 

Откройте закладку QC для быстрой оценки качества данных эксперимента на основании правил, 
определенных в закладке QC окна User Preferences (более подробная информация приведена в 
разделе «Закладка QC (Контроль качества) на стр. 140). 

Закладка QC подразделяется на четыре области (Рис. 76): 

• График амплификации. Отображает ОЕФ для каждой лунки в каждом цикле. Каждый след 

на графике представляет данные от одного флуорофора в одной лунке 

• Таблица правил проверки качества. Отображает доступные правила проверки качества и 

настройки, определяющие каждое правило. Примененные правила отмечаются «галочкой». 
Правило может быть удалено отменой выбора кнопки-флажка Use (Использовать) 

• Селектор лунок. Выбирает лунки с данными флуоресценции, которые Вы хотите 

отобразить 
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• Сводка правил проверки качества. Отображает выбранное правило и выделяет лунки, не 

прошедшие проверку качества по данному правилу 

 

Рис. 76. Конфигурация закладки QC 

Исключение лунок, не прошедших проверку качества 

Лунки, не отвечающие критериям качества перечисляются в столбце таблицы правил и в сводке. 
Данные лунки могут быть исключены из анализа или включены в анализ выбором или отменой 
выбора соответствующей кнопки-флажка Exclude Wells. 

Закладка Run Information (Информация об эксперименте) 

Закладка Run Information (Рис. 77) отображает протокол и другую информацию о каждом 
эксперименте. Данная закладка содержит следующие опции: 

• Просмотр протокола 

• Ввод и редактирование примечаний Ввод или редактирование примечаний относительно 
эксперимента вводом данных в поле Notes (Примечания) 

• Ввод и редактирование идентификатора данных для анализа вводом идентификатора в 
поле ID (Идентификатор) 

• Просмотр событий, таких как сообщения об ошибках, которые могли произойти в ходе 
проведения анализа, в секции окна Other (Другое). Данные сообщения помогают при 

диагностике неисправностей, возникших в ходе анализа 

СОВЕТ: Копирование, экспорт или вывод на печать протокола производятся щелчком 
правой кнопкой мыши на протоколе. Отмена действия, вырезание, копирование, вставка, 
удаление или выбор текста производятся щелчком правой кнопкой мыши на секциях окна 
Notes, ID или Other 
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Рис. 77. Конфигурация закладки Run Information 

Отчеты на основе файлов данных 

Отчет, продемонстрированный на Рис. 78, отображает информацию о текущем файле данных в 
окне Data Analysis. Для открытия отчета выберите Tools > Reports (Инструменты > Отчеты) или 
щелкните на кнопке Reports (Отчеты) панели инструментов окна Data Analysis. 

Окно Report содержит три секции: 

• Меню и панель инструментов. Выбор опций для форматирования, сохранения и вывода 

на печать отчета или шаблона 

• Перечень опций (верхняя левая часть окна). Выбор опций для отображения в отчете 

• Секция опций (нижняя левая часть окна). Ввод информации о выбранной опции 

• Секция предварительного просмотра (правая часть окна). Предварительный просмотр 

текущего отчета 
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Рис. 78. Пример отчета для файла данных в окне Report 

СОВЕТ: Конфигурация отчета может определять тип данных, представляемых в любом 
отчете, при условии сохранения данного отчета в качестве шаблона. Выберите Template > 
Save (Шаблон > Сохранить) или Save As (Сохранить как) для сохранения текущего 

отчета в качестве шаблона. 

Создание отчета об анализе данных 

Для создания отчета в окне Data Analysis выполните следующие инструкции: 

1. Перед созданием отчета выполните окончательную корректировку содержимого лунок, 
выбранных лунок, графиков и электронных таблиц в окне Data Analysis. 

2. Выберите Tools > Reports (Инструменты > Отчеты) в меню окна Data Analysis для 

открытия окна Report. 

3. Откорректируйте опции, которые будут включены в отчет. Отчет открывается с выбранными 
опциями по умолчанию. Выберите кнопки-флажки в перечне опций отчета для изменения 
целых категорий или отдельных опций в пределах категории. 

ПРИМЕЧАНИЕ: Данные, представленные в отчете, зависят от текущего выбора, 
произведенного в пределах закладок окна Data Analysis. Например, количественный анализ 
может не включать стандартную кривую, и, следовательно, данные стандартной кривой не 
появятся в окне Data Analysis или в статистическом отчете. 

4. Порядок расположения категорий и пунктов в пределах отчета можно изменить щелчком 
кнопкой мыши и «перетаскиванием» категорий и пунктов в требуемое положение. 
Реорганизация пунктов производится только в пределах категорий, которым они 
принадлежат. 

5. Щелкните на кнопке Update Report для обновления секции предварительного просмотра 

отчета. 

6. Распечатайте или сохраните отчет. Щелкните на кнопке Print Report (Печатать отчет) на 
панели инструментов для распечатки текущего отчета. Выберите File > Save (Файл > 
Сохранить) для сохранения отчета в формате PDF (файл формата Adobe Acrobat Reader), 

MHT (Microsoft document) или MHTML (документ Microsoft) и выбора местоположения для 
сохранения файла. Выберите File > Save As (Файл > Сохранить как) для сохранения 

отчета под новым именем или в новом местоположении. 
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7. (Опционально) Создайте шаблон отчета с необходимой информацией. Для сохранения 
текущих настроек отчета в шаблоне выберите Template > Save (Шаблон > Сохранить) или 
Save As (Сохранить как). При необходимости создания нового отчета загрузите данный 

шаблон отчета. 

Категории отчетов об анализе данных 

Отчет может включать любые опции в каждой категории, описанной в Таблице 35, в зависимости 
от типа данных, представленных в окне Data Analysis. 

Таблица 35. Категории отчетов об анализе данных в перечне опций 
 

Категория Опция Описание 

Заголовок Заголовок, подзаголовок и регистрационные 
данные отчета 

 Report Information 
(Информация об отчете) 

Run Date (Дата эксперимента), User Name (Имя 
пользователя), Data File Name (Имя файла данных), 
Data File Path (Путь доступа к файлу данных) и 
Selected Well Group (Выбранная группа лунок) 

 Audit Information (Информация 
для аудита) 

Дополнительная информация, необходимая для 
аудита, включая подписи 

 Notes (Примечания) Примечания к отчету 

Run Setup (Настройка параметров эксперимента) 

 Run Information (Информация 
об эксперименте) 

Run Date (Дата эксперимента), User Name (Имя 
пользователя), Data File Name (Имя файла данных), 
Data File Path (Путь доступа к файлу данных) и 
Selected Well Group (Выбранная группа лунок) 

 Protocol (Протокол) Текстовое представление этапов и опций протокола 

 Plate Display 
(Представление планшета) 

Отображение представления планшета с 
информацией по каждой лунке 

Quantitation (Количественный анализ) 

 Analysis Settings 
(Настройки анализа) 

Включает количество этапов при сборе данных, 
режим анализа и метод вычитания базовой линии 

 Amplification Chart 
(График амплификации) 

Копирование графика амплификации для 
экспериментов, включающих количественный 
анализ 

 Standard Curve Chart 
(Стандартная кривая) 

Копирование стандартной кривой 

 Data (Данные) Электронная таблица с перечнем данных всех 
лунок 

Gene Expression — Bar Chart (Экспрессия генов - гистограмма) 

 Analysis Settings 
(Настройки анализа) 

Включает Analysis Mode (Режим анализа), 
Chart Data (Данные графика), 
Scaling (Масштабирование) и Chart Error 
(Погрешность нанесения на график) 

 Chart (График) Копирование гистограммы 

 Target Names 
(Имена мишеней) 

Нанесение на график имен мишеней 

 Sample Names 
(Имена образцов) 

Нанесение на график имен мишеней 

 Data (Данные) Электронная таблица с перечнем данных всех 
лунок 

 Target Stability 
(Стабильность мишени) 

График значений стабильности мишени 

Gene Expression — Clustergram, Scatter Plot, Volcano Plot, Heat Map (Экспрессия генов – кластерграмма, 
диаграмма рассеяния, график «вулкан», карта нагрева) 

 Analysis Settings 
(Настройки анализа) 

Включает настройки для каждого типа графика 

 Chart (График) Копирование графика 

 Data (Данные) Электронная таблица с перечнем данных каждой 
мишени 

Melt Curve (Кривая плавления) 
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Таблица 35. Категории отчетов об анализе данных в перечне опций (продолжение) 
 

Категория Опция Описание 

 Analysis Settings  
(Настройки анализа) 

Включает настройки количества этапов плавления 
и пороговых линий 

 Melt Curve Chart  
(Кривая плавления) 

Копирование кривой плавления 

 Melt Peak Chart  
(Пики плавления) 

Копирование графика пиков плавления 

 Data (Данные) Электронная таблица с перечнем данных всех 
лунок 

Allelic Discrimination (Дискриминация аллелей) 

 Analysis Settings  
(Настройки анализа) 

Включает флуорофоры, цикл и опцию просмотра 
карты сигналов 

 Allelic Discrimination Chart 
(График дискриминации 
аллелей) 

Копирования графика дискриминации аллелей 

 Data (Данные) Электронная таблица с перечнем данных всех 
лунок 

End Point (Конечная точка) 

 Analysis Settings  
(Настройки анализа) 

Включает Fluorophore (Флуорофор), End Cycles To 
Average (Среднее значение по конечному циклу), 
Mode (Режим), Lowest RFU Value (Самое низкое 
значение ОЕФ), Highest RFU Value (Самое высокое 
значение ОЕФ) и Cutoff Value (Критическая 
оптическая плотность) 

 Data (Данные) Электронная таблица с перечнем данных всех 
лунок 

QC Parameters (Параметры контроля качества) 

 Data (Данные) Электронная таблица с перечнем параметров для 
каждого правила проверки качества 

Отчеты по группам лунок 

Для создания отчетов по конкретным группам лунок: 

1. Выберите Tools > Well Group Reports (Инструменты > Отчеты по группам лунок) в окне 

Data Analysis. 

 

Рис. 79. Окно Well Group Reports 
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2. В окне Well Groups Reports (Рис. 79) можно задать группы лунок (опция Well Groups), этапы 

амплификации (опция Amplification Steps) и этапы плавления (опция Melt Steps) для 
включения в отчеты, выбрав соответствующую кнопку-флажок. 

3. Папку назначения можно переместить в другое расположение, щелкнув на кнопке «...». 

4. Выберите Choose a Report Template (Выбрать шаблон отчета) для выбора другого 

шаблона. Щелкните на кнопке «...» для просмотра файла шаблона. 

5. После создания отчетов можно открыть папку назначения и просмотреть отчеты, выбрав 
соответствующую кнопку-флажок. 

6. Щелкните на Create Reports (Создать отчеты) для создания отчетов в соответствии с 

вышеприведенными инструкциями. 
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9 Анализ экспрессии генов 

В данной главе содержится информация о проведении анализа экспрессии генов: 

• Экспрессия генов (стр. 109) 

• Задание параметров планшета для анализа экспрессии генов (стр. 110) 

• Задание параметров планшета с инструкциями (стр. 110) 

• Гистограмма (стр. 111) 

• Кластерграмма (стр. 118) 

• Диаграмма рассеяния (стр. 119) 

• График «вулкан» (стр. 120) 

• Карта нагрева (стр. 121) 

• Результаты (стр. 121) 

• Исследование генов (стр. 122) 

• Окно Gene Study Report (Отчет об исследовании генов) (стр. 124) 

• Расчеты экспрессии генов (стр. 126) 

Экспрессия генов 

Посредством использования в реакциях контролей, прошедших жесткий отбор, вы можете 
проводить анализ экспрессии генов для нормализации относительных различий в концентрации 
мишени между образцами. Как правило, для нормализации уровней экспрессии исследуемых 
генов используются уровни транскриптов для одного или нескольких референсных генов. 
Референсные гены учитывают разность загрузок или другие изменения, представленные в каждом 
образце, и не должны регулироваться в исследуемой биологической системе. 

Откройте закладку Gene Expression для оценки относительных разностей между ПЦР в одной или 
нескольких лунках. Например, Вы можете оценить относительные количества вирусных геномов 
или относительные количества трансфицированных последовательностей в ПЦР. Наиболее 
широко используемым методом исследования экспрессии генов является сравнение концентраций 
кДНК в нескольких реакциях для исследования уровней устойчивой информационной РНК. 

Программное обеспечение рассчитывает относительный уровень экспрессии мишени под одному 
из следующих сценариев: 

• Относительный уровень экспрессии целевой последовательности (мишень 1) относительно 
другой мишени (мишень 2). Например, количество одного гена относительно другого гена 
при одних условиях обработки образца 
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• Уровень относительной экспрессии целевой последовательности в одном образце по 
сравнению с той же мишенью при других условиях обработки образца. Например, 
относительное количество одного гена относительно его самого при других временных, 
географических условиях или условиях развития 

Задание параметров планшета для анализа экспрессии 
генов 

Для выполнения анализа экспрессии генов содержимое лунок должно иметь следующий состав: 

• Две или более мишеней. Две мишени, представляющие собой различные 

амплифицированные гены или последовательности в образцах 

• Одна или более референс-мишеней. Для нормализованной экспрессии не менее чем 

одна мишень должна быть референс-мишенью. Назначьте все референс-мишени в окне 
Experiment Settings (стр. 53) для анализа данных в режиме нормализованной экспрессии 
(∆∆Cq). Эксперименты, не содержащие референс-мишени, должны проводиться в режиме 
относительной экспрессии (∆Cq) 

• Групповые образцы. Реакции должны включать групповые образцы (не менее двух) для 

отображения данных на графиках закладки Gene Expression. Данные образцы моделируют 
различные методы обработки или условия для каждой из целевых последовательностей. 
Назначьте контрольный образец (опционально) в окне Experiment Settings (стр. 53). Если 
контроль не выбран, контрольное значение можно рассчитать, используя среднее всех 
значений всех образцов 

Требования к заданию параметров планшета для исследования экспрессии генов в редакторе 
планшетов зависят от того, какая ПЦР будет проводиться – синглплексная ПЦР с одним 
флуорофором или мультиплексная ПЦР с несколькими флуорофорами. 

На Рис. 80 приведен пример минимального содержимого лунок для синглплексного анализа 
экспрессии генов. 

 

Рис. 80. Примерное содержимое лунок для синглплексного анализа экспрессии генов 

На Рис. 81 приведен пример минимального содержимого лунок для мультиплексного анализа 
экспрессии генов. 

 

Рис. 81. Примерное содержимое лунок для мультиплексного анализа экспрессии генов 

Задание параметров планшета с инструкциями 

Если параметры планшета в файле данных не содержат информацию, необходимую для анализа, 
и выбрана закладка Gene Expression, область окна, занимаемая гистограммой, будет содержать 
инструкции по вводу данной информации. Для нормализованной экспрессии генов необходимо 
выполнить следующие действия: 

1. Определите имена образца и мишени с помощью: 

• Plate Setup (Настройки планшета). Открытие окна Plate Editor 
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• Replace Plate file (Заменить файл планшета). Выбор ранее созданного файла схемы 

планшета 

• Replace PrimePCR file (Заменить файл PrimePCR). Выберите эксперимент 

PrimePCR™, из которого будет использована схема планшета 

2. Выберите референс-мишени и контрольные образцы с помощью: 

• Experiment Settings (Настройки эксперимента). Открытие окна Experiment Settings для 

выбора одной или нескольких мишеней и контрольного образца 

Если схема планшета уже содержит информацию о мишени и образце, требуется только второй 
этап, который будет выделен оранжевым цветом. Данный этап должен быть выполнен до анализа 
нормализованной экспрессии генов. 

ПРИМЕЧАНИЕ: Данные для кластерграммы, диаграммы рассеяния, графика «вулкан» и 
карты нагрева отображаются только в том случае, если соблюдены все требования к 
нормализованной экспрессии генов, перечисленные в настройках планшета для анализа 
экспрессии генов. 

Гистограмма 

Относительная экспрессия мишеней представлена в двух форматах: 

• График Gene Expression (Экспрессия генов) Отображает данные ПЦР реального времени 

в виде нормализованной экспрессии (∆∆Cq) или относительного количества (∆Cq) 

• Spreadsheet (Электронная таблица). Отображает электронную таблицу данных экспрессии 

генов 

СОВЕТ: Щелкните правой кнопкой мыши на графике или электронной таблице для вызова 
опций. Выберите View/Edit Plate в ниспадающем меню Plate Setup для открытия окна Plate 

Editor и изменения содержимого лунок. 

 

Рис. 82. Конфигурация закладки Gene Expression окна Data Analysis 

СОВЕТ: Выберите Sort (Сортировать) в контекстном меню для изменения порядка 

расположения имен мишеней и образцов на графике. 

СОВЕТ: В окне Experiment Settings выполните быструю настройку формата отображения 
данных в следующем порядке: 1) Mode (Режим), 2) Control Sample (Контрольный образец) и 
3) Reference target(s) (Референс-мишень (мишени)). 

Нормализованная экспрессия генов 

Для нормализации данных используйте измеренный уровень экспрессии одного или нескольких 
референсных генов (мишеней) в качестве коэффициента нормализации. Референсные гены – это 
мишени, не регулированные в исследуемой биологической системе, такие как актин, 
глицеральдегид-3-фосфатдегидрогеназа или гистон H3. 
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Для задания параметров анализа экспрессии генов (∆∆Cq) выполните следующие этапы: 

1. Откройте файл данных (.pcrd). 

2. Просмотрите данные в закладке Quantitation окна Data Analysis. Откорректируйте данные, 

такие как пороговый уровень и режим анализа. 

3. Щелкните на закладке Gene Expression. 

4. Выберите контроль в закладке Samples (Образцы) окна Experiment Settings. Если контроль 

назначен, программное обеспечение нормализует относительные количества для всех генов 
до количества контроля, заданного как 1. 

5. Выберите референсные гены для данного эксперимента в закладке Target (Мишень) окна 

Experiment Settings. Анализ экспрессии генов требует одного референсного гена среди 
мишеней образца. 

6. Выберите Normalized Expression (∆∆Cq) (Нормализованная экспрессия (∆∆Cq), если еще 

не выбрана, и просмотрите уровни экспрессии в закладке Gene Expression. 

ПРИМЕЧАНИЕ: Также можно использовать программу Setup Wizard (стр. 48) для задания 

параметров планшета для анализа нормализованной экспрессии генов. 

ОТНОСИТЕЛЬНОЕ КОЛИЧЕСТВО 

По определению, данные относительного количества (∆Cq) не нормализованы. Данный метод 
используется для количественного анализа образцов, не включающих референсные гены 
(мишени). Обычно при задании параметров эксперимента исследователь уверен в одном из 
следующих факторов: 

• Каждый образец представляет одинаковое количество ДНК-мишени в каждом биологическом 
образце, возможно, одинаковую молекулярную массу РНК или кДНК в каждой лунке 

• Любое изменение количества загруженного биологического образца будет нормализовано 
после эксперимента одним из методов при анализе данных без программного обеспечения. 
Например, исследователь может разделить значение относительного количества на 
коэффициент нормализации, возможно, молекулярную массу нуклеиновой кислоты, 
загруженной для каждого образца, или количество клеток, из которых была изолирована 
нуклеиновая кислота 

Выберите Relative Quantity (∆Cq) (Относительное количество (∆Cq)) в ниспадающем меню 
закладки Gene Expression для проведения анализа относительного количества (∆Cq). 

СОВЕТ: Для сравнения результатов с данными других анализов экспрессии генов откройте 
новую программу исследования генов (стр. 124) или добавьте файл данных к 
существующей программе исследования генов. 

Корректировка данных экспрессии генов 

После выбора метода анализа откорректируйте данные в закладке Gene Expression, изменив 
опции настроек справа от графика. 

GRAPH DATA (ГРАФИЧЕСКИЕ ДАННЫЕ) 

Опции Graph data позволяют представлять данные в графическом виде с одной из двух опций: 

• Relative to control (Относительно контроля). Представьте данные на графике с осью со 

шкалой от 0 до 1. Если Вы назначили контроль для своего эксперимента, выберите данную 
опцию для быстрой визуализации положительной регуляции и отрицательной регуляции 
мишени 

• Relative to zero (Относительно нуля). Представьте данные на графике с началом 

координат «0». 

CONTROL SAMPLE (КОНТРОЛЬНЫЙ ОБРАЗЕЦ) 

Выберите образец, по которому будут нормализованы все количества мишеней. 
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CHART SETTINGS (НАСТРОЙКИ ГРАФИКА) 

Выбор кнопки-флажка Show Chart Settings (Отобразить настройки графика) предоставляет 

доступ к следующим опциям: Опции X-Axis (Ось X), Опции Y-Axis (Ось Y), Scaling 
(Масштабирование), Error Type (Тип погрешности) и Chart Error Bar Multiplier (Коэффициент планок 
погрешностей). 

Опции X-Axis (Ось X) 

Опции X-Axis позволяют выбирать данные графика экспрессии генов по оси Х: 

• Target (Мишень). Выберите данную опцию для вывода имен мишеней по оси Х 

• Sample (Образец). Выберите данную опцию для вывода имен образцов по оси Х 

Опции Y-Axis (Ось Y) 

Опции Y-Axis позволяют отображать график экспрессии генов в одном из трех масштабов: 

• Linear (Линейный). Выберите данную опцию для отображения данных в линейном 

масштабе 

• Log 2 (Логарифмический 2). Выберите данную опцию для оценки образцов в широком 

динамическом диапазоне 

• Log 10 (Логарифмический 10). Выберите данную опцию для оценки образцов в очень 

широком динамическом диапазоне 

ОПЦИИ SCALING (МАСШТАБИРОВАНИЕ) 

Выберите Normalized Gene Expression (∆∆Cq) для активации опций масштабирования на графике 

экспрессии генов. Выберите одну из опций масштабирования для расчета и представления 
данных способом, наиболее соответствующем плану эксперимента: 

• Unscaled (Немасштабированная экспрессия). Данная опция моделирует 

немасштабированную нормализованную экспрессию генов 

• Highest (Самый высокий уровень экспрессии). Представьте нормализованную 

экспрессию генов в самой высокой степени для каждой мишени, разделив уровень 
экспрессии каждого образца на самый высокий уровень экспрессии всех образцов. Данная 
опция масштабирования использует формулу масштабирования до самого высокого уровня 

• Lowest (Самый низкий уровень экспрессии). Пересчитайте нормализованную 

экспрессию генов для каждой мишени, разделив уровень экспрессии каждого образца на 
самый низкий уровень экспрессии всех образцов. Данная опция масштабирования 
использует формулу масштабирования до самого низкого уровня 

• Average (Средний уровень экспрессии). Представьте нормализованную экспрессию генов 

в средней степени для каждой мишени, разделив уровень экспрессии каждого образца на 
среднее геометрическое всех уровней экспрессии всех образцов. Данная опция 
масштабирования использует формулу масштабирования до среднего уровня 

ОПЦИИ ERROR TYPE (ТИП ПОГРЕШНОСТИ) 

Выберите опцию для определения погрешностей (планок погрешностей) на графике экспрессии 
генов: 

• Standard error of the mean (Стандартная погрешность среднего) (по умолчанию, SEMs) 

• Standard deviation (Среднеквадратическое отклонение (SD)) 

ОПЦИИ CHART ERROR BAR MULTIPLIER (КОЭФФИЦИЕНТ ПЛАНОК ПОГРЕШНОСТЕЙ) 

Выберите коэффициент для планок погрешностей графика экспрессии генов. Выберите одно из 
целых чисел: +/-1 (по умолчанию), 2 или 3. Тип коэффициента меняется при выборе опций Error 
Type: 

• SEMs для стандартной погрешности среднего 

• Std Devs для среднеквадратического отклонения 

ОКНО TARGET STABILITY VALUE (ПОКАЗАТЕЛЬ СТАБИЛЬНОСТИ МИШЕНИ) 

Показатели стабильности мишени рассчитываются во всех случаях, когда используется несколько 
референсных генов. Программное обеспечение рассчитывает два параметра качества для 
референсных генов: 
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• Coefficient of Variation (Коэффициент вариации) (CV) нормализованных относительных 

количеств референсных генов. Низкие значения CV указывают на более высокую стабильность 

• M-value (Значение M). Мера стабильности экспрессии референсных генов 

Таблица 36. Допустимые значения стабильности экспрессированных 
референсных генов 

(Hellemans et al. 2007) 
 

Образцы CV M 

Гомогенный <0,25 <0,5 

Гетерогенный <0,5 <1 

Опции контекстного меню 

Щелкните правой кнопкой мыши в любой области гистограммы для выбора пунктов меню, 
перечисленных в Таблице 37. 

Таблица 37. Пункты контекстного меню 
 

Пункт меню Функция 

Copy (Копировать) Копирование графика в буфер промежуточного хранения 

Save Image As... 
(Сохранить изображение как) 

Сохранение графика в графическом представлении в виде файла 
изображения. Задайте разрешение и размеры изображения и 
выберите формат (PNG, GIF, JPG, TIF или BMP) 

Page Setup… (Макет страницы) Выбор макета страницы для печати 

Print... (Печатать) Печать графика 

Set Scale to Default 
(Задать масштаб по 
умолчанию) 

Выберите Show All (Отобразить все) для отображения всех 
данных на гистограмме или Scroll Bar (Зона прокрутки) для 

вывода на экран зоны прокрутки при наличии слишком большого 
количества образцов 

Chart Options... 
(Опции графика) 

Открытие окна Chart Options (Опции графика) для внесения 
изменений 

Sort… (Сортировать) Сортировка порядка расположения образцов или мишеней по оси 
Х графика 

User Corrected Std Devs 
(Откорректированные 
пользователем среднекв. 
отклонения) 

Расчет планок погрешностей с использованием 
скорректированной формулы расчета среднеквадратического 
отклонения 

Use Solid Bar Colors 
(Использовать цвета столбиков) 

Отображение цветных столбиков на графике 

X-Axis Labels (Метки по оси Х) Выбор способа отображения меток по оси Х: по горизонтали или 
под углом 

Электронная таблица данных 

Таблица 38 содержит информацию, отображаемую в электронной таблицы данных гистограммы. 

Таблица 38. Описание информации электронной таблицы закладки Bar Chart 
 

Информация Описание 

Target (Мишень) Имя мишени (амплифицированного гена), выбранное в окне 
Experiment Settings 

Sample (Образец) Имя образца, выбранное в окне Experiment Settings 

Ctrl (Контрольный) Контрольный образец, когда образцу присвоено имя 
контрольного образца в окне Experiment Settings 

Expression (Экспрессия) Нормализованная экспрессия генов (опция Normalized Gene 
Expression (∆∆Cq) или относительное количество (опция Relative 
quantity (∆Cq), в зависимости от выбранного режима 

Expression SEM или Expression 
SD (SEM) (или SD) 

Стандартная погрешность среднего или среднеквадратическое 
отклонение, в зависимости от выбранной опции 
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Таблица 38. Описание информации электронной таблицы закладки Bar Chart (продолжение) 
 

Информация Описание 

Corrected expression SEM или 
Corrected Expression SD 
(Скорректированная SEM 
экспрессии) или 
(Скорректированное SD 
экспрессии) 

Расчет скорректированного значения для стандартной 
погрешности среднего (SEM) или среднеквадратического 
отклонения (SD) для относительной экспрессии, в зависимости от 
выбранной опции 

Cq Mean (Cq среднее) Среднее цикла количественного анализа 

Cq SEM (или SD) Стандартная погрешность среднего или среднеквадратическое 
отклонение цикла количественного анализа, в зависимости от 
выбранной опции 

Опция Show Details (Отобразить подробную информацию) 

При выборе Show Details из контекстного меню электронной таблицы гистограммы 
предоставляется следующая информация (Таблица 39). 

Таблица 39. Информация электронной таблицы гистограммы, отображаемая при выборе 
опции Show Details 

 

Информация Описание 

Data Set (Набор данных) Данные флуоресценции от одного флуорофора в файле данных 

Относительное количество Рассчитанное относительное количество образцов 

Relative Quantity SD 
(Среднеквадр. отклонение 
относительного количества) 

Среднеквадратическое отклонение при расчете относительного 
количества 

Corrected Relative Quantity SD 
(Скорректированное 
среднеквадр. отклонение 
относительного количества) 

Рассчитанное среднеквадратическое отклонение 
скорректированного относительного количества 

Relative Quantity SEM 
(Стандартн. погрешн. среднего 
относительного количества) 

Стандартная погрешность среднего при расчете относительного 
количества 

Corrected Relative Quantity SEM 
(Стандартн. погрешн. среднего 
откорректированного 
относительного количества) 

Рассчитанная стандартная погрешность среднего 
откорректированного относительного количества 

Unscaled Expression 
(Немасштабированная 
экспрессия) 

Рассчитанная немасштабированная экспрессия 

Unscaled Expression SD 
(Среднеквадратич. отклонение 
немасштабированной 
экспрессии) 

Рассчитанное среднеквадратическое отклонение 
немасштабированной экспрессии 

Corrected Unscaled Expression 
SD (Скорректированное 
среднеквадратич. отклонение 
немасштабированной 
экспрессии) 

Рассчитанное среднеквадратическое отклонение 
немасштабированной экспрессии 

Unscaled Expression SEM 
(Стандартн. погрешн. среднего 
немасштабированной 
экспрессии) 

Рассчитанная стандартная погрешность среднего 
немасштабированной экспрессии 

Corrected Unscaled Expression 
SEM (Откорректированная 
стандартн. погрешн. среднего 
немасштабированной 
экспрессии) 

Рассчитанная стандартная погрешность среднего 
немасштабированной экспрессии 

Expression (Экспрессия) Уровень относительной экспрессии 

Wells (Лунки) Количество лунок планшета 
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Окно Experiment Settings (Настройки эксперимента) 

Откройте окно Experiment Settings, щелкнув на кнопке Experiment Settings в закладке Bar Chart. 

В данном окне Вы можете просмотреть или изменить список мишеней (Targets) или образцов 
(Samples), выбрать референсные гены, контрольные образцы или задать группу образцов для 
анализа экспрессии генов, если в лунки были добавлены имена биологических наборов (Рис. 83). 

 

Рис. 83. Окно Experiment Settings с выбранной закладкой Targets 

Для редактирования списков данных закладок используйте следующие функции: 

• Добавьте имя мишени или образца, набрав имя в поле New (Новый) и щелкнув на кнопке 
Add (Добавить) 

• Удалите имя мишени или образца, щелкнув на Remove Name (Имя для удаления) для 
соответствующего ряда, и затем – на кнопке Remove checked item(s) (Удалить 
выбранный пункт(ы) 

• Выберите мишень в качестве эталонной для анализа экспрессии генов, щелкнув в ячейке 
столбца Reference напротив имени мишени 

• Выберите образец в качестве контрольного для анализа экспрессии генов, щелкнув в 
ячейке столбца Control напротив имени образца 

ПРИМЕЧАНИЕ: Для одной группы лунок может быть выбран только один контроль. При 
наличии более одного контроля данные гистограммы будут отображены на графике с 
меткой «None» (Отсутствует) вместо контрольного образца. Для изменения данных 
настроек выберите контрольный образец в ниспадающем меню секции настроек. 

• Выберите тип(ы) образца, который будет исключен из расчетов анализа экспрессии генов 

ОПЦИИ АНАЛИЗА НА ОСНОВАНИИ БИОЛОГИЧЕСКИХ НАБОРОВ 

Загрузка в лунки имени биологического набора позволяет анализировать образцы одним из 
четырех способов. Для доступа к данным опциям из закладки Bar Chart щелкните на кнопке 
Experiments Settings и выберите конфигурацию анализа из ниспадающего списка Biological Set 

Analysis Options (Опции анализа на основании биологических наборов). 

• Target vs. Sample. В расчетах экспрессии генов используется только имя образца в лунке 

• Target vs. Biological Set. В расчетах экспрессии генов используется только имя 

биологического набора 

• Target vs. Sample_Biological Set. Комбинация имени образца и имени биологического 

набора для создания одного имени, которое будет использоваться в расчетах 

• Target vs. Biological Set_Sample. Комбинация имени биологического набора и имени 

образца для создания одного имени, которое будет использоваться в расчетах 
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Опция Show Analysis Settings (Отобразить настройки 
параметров анализа) окна Experiment Settings 

Щелкните на Show Analysis Settings (Отобразить настройки параметров анализа) в окне 

Experiment Settings для просмотра или изменения параметров анализа, приведенных в закладке 
Bar Chart: 

• Щелкните на ячейке столбца Color для изменения цвета мишеней на графике экспрессии 

генов (график Gene Expression) 

• Введите значение оценки эффективности мишени. Программное обеспечение рассчитает 
относительную эффективность для мишени с помощью функции Auto Efficiency 
(Автоматическая настройка эффективности), если данные мишени включают 

стандартную кривую. Или введите ранее определенное значение эффективности 

На Рис. 84 отображены значения эффективности мишеней, которые появляются при выборе 
функции Auto Efficiency. 

 

Рис. 84. Закладка Targets окна Experiment Settings с выбранной опцией 
Show Analysis Settings 

Для изменения настроек параметров образца в закладке Samples: 

• Щелкните на ячейке столбца Color для изменения цвета образцов на графике экспрессии 

генов (график Gene Expression) 

• Выберите кнопку-флажок в столбце Show Graph (Отображать график) для отображения 

данных образца на графике Gene Expression с помощью цветовой кодировки, выбранной в 
столбце Color 
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Рис. 85 отображает закладку Samples (Образцы) с выбранной опцией Show Chart (Отобразить 
график). 

 

Рис. 85. Закладка Samples окна Experiment Settings с выбранной опцией 
Show Analysis Settings 

Кластерграмма 

Кластерграмма отображает данные в иерархии, определенной степенью сходства экспрессии для 
различных мишеней и образцов. 

ПРИМЕЧАНИЕ: Необходимо выбрать референс-мишень для отображения графиков 
данных, отличных от гистограмм относительной экспрессии. 

Кластерграмма отображает относительную экспрессию образца или мишени следующим образом: 

• Upregulation (Положительная регуляция) (красный). Высокий уровень экспрессии 

• Downregulation (Отрицательная регуляция) (зеленый). Низкий уровень экспрессии 

• No regulation (Отсутствие регуляции) (черный) 

• No value calculated (Значения не рассчитаны) (черный с белой меткой «X» 

Чем менее насыщен цвет, тем больше разность уровней относительной экспрессии. Если 
нормализованное значение Cq не рассчитано, ячейка будет выделена черным цветом с белой 
меткой «X». 

На внешних границах графика данных представлена дендрограмма, отображающая иерархию 
группирования. Мишени или образцы с одинаковыми схемами экспрессии будут иметь смежные 
ветви, в то время как мишени и образцы с разными схемами будут удалены друг от друга. 

Настройки 

Необходимо задать следующие настройки: 

• Cluster By (Группировать по). Можно выбрать группирование по мишеням (Targets), 

образцам (Samples), по мишеням и образцам (Both) или ни по какому признаку (None) 

• Size (Размер). Размер изображения можно отрегулировать с помощью движка для 

изменения масштаба графика с целью обеспечения простой визуализации 

• Split Out Replicates (Отдельные дубликаты). Данная опция отображает значения для 

отдельных дубликатов 

СОВЕТ: Систему цветов для кластерграммы, диаграммы рассеяния, графика «вулкан» и 
карты нагрева можно изменить с настроек по умолчанию (красный/зеленый) на 
красный/синий, выбрав данную опцию в контекстном меню любого графика. 
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Опции контекстного меню 

Щелкните правой кнопкой мыши в любой области кластерграммы для выбора пунктов меню, 
перечисленных в Таблице 40. 

Таблица 40. Пункты контекстного меню 
 

Пункт меню Функция 

Copy (Копировать) Копирование графика в буфер промежуточного хранения 

Save Image As... 
(Сохранить изображение как) 

Сохранения графика в виде файла изображения. Доступны 
следующие форматы: PNG, GIF, JPG, TIF или BMP. Разрешение 
изображения будет соответствовать разрешению экрана 
компьютера 

Print... (Печатать) Печать графика 

Color Scheme (Система цветов) Выберите Red/Green (Красный/зеленый) или Red/Blue 
(Красный/синий) для определения цветовой гаммы графика 

Электронная таблица данных 

Электронная таблица перечисляет данные мишеней, образцов и нормализованной экспрессии. 
Выберите кнопку-флажок или отмените выбор кнопки-флажка рядом с мишенью для включения ее 
в кластерграмму или исключения из кластерграммы. Выберите опции контекстного меню графика, 
вызвав меню щелчком правой кнопкой мыши. 

Диаграмма рассеяния 

Диаграмма рассеяния отображает нормализованную экспрессию мишеней для контрольного 
образца в сравнении с экспериментальным образцом. 

Диаграмма отображает следующие изменения данных экспрессии мишени в зависимости от 
заданного порогового уровня: 

• Upregulation (Положительная регуляция) (красный кружок). Относительно высокий 

уровень экспрессии 

• Downregulation (Отрицательная регуляция) (зеленый кружок). Относительно низкий 

уровень экспрессии 

• No change (Без изменений) (черный кружок) 

Щелкните кнопкой мыши на пороговой линии и «перетащите» ее для регулировки значения 
порогового уровня регуляции. 

СОВЕТ: Для изменения символа, используемого для диаграммы рассеяния или графика 
«вулкан» выберите Symbol (Символ) из контекстного меню, после чего выберите одну из 

представленных опций. 

Настройки 

Необходимо задать следующие настройки: 

• Control Sample (Контрольный образец) 

• Experimental Sample (Экспериментальный образец) 

• Regulation Threshold (Пороговый уровень регуляции). При изменении данного значения 

пороговая линия будет перемещаться в соответствующем направлении 

Опции контекстного меню 

Щелкните правой кнопкой мыши в любой области диаграммы рассеяния для выбора пунктов 
меню, перечисленных в Таблице 41. 
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Таблица 41. Пункты контекстного меню 
 

Пункт меню Функция 

Copy (Копировать) Копирование графика в буфер промежуточного хранения 

Save Image As... 
(Сохранить изображение как) 

Сохранения графика в виде файла изображения. Задайте 
разрешение и размеры изображения и выберите формат (PNG, 
GIF, JPG, TIF или BMP) 

Page Setup… (Макет страницы) Выбор макета страницы для печати 

Print... (Печатать) Печать графика 

Set Scale to Default 
(Задать масштаб по 
умолчанию) 

Возврат представления графика к настройкам по умолчанию 
после увеличения графика 

Chart Options... 
(Опции графика) 

Открытие окна Chart Options (Опции графика) для внесения 
изменений 

Обозначение Выбор символа для точек данных 

Color Scheme (Система цветов) Выберите Red/Green (Красный/зеленый) или Red/Blue 
(Красный/синий) для определения цветовой гаммы графика 

Электронная таблица данных 

Электронная таблица приводит данные мишени, нормализованной экспрессии для контрольного 
образца и экспериментальных образцов, а также информацию о регуляции мишеней 
(отрицательной или положительной) по сравнению с настройками порогового уровня. Выберите 
кнопку-флажок или отмените выбор кнопки-флажка рядом с мишенью для включения ее в 
кластерграмму или исключения из диаграммы. Выберите опции контекстного меню графика, 
вызвав меню щелчком правой кнопкой мыши. 

График «вулкан» 

График «вулкан» отображает изменение уровня экспрессии (регуляции) мишени для 
экспериментального образца в сравнении с контрольным образцом и индицирует степень 
достоверности на основании значения P. 

Данный график отображает следующие изменения данных экспрессии в зависимости от заданного 
порогового уровня: 

• Upregulation (Положительная регуляция) (красный кружок). Высокий уровень 

экспрессии 

• Downregulation (Отрицательная регуляция) (зеленый кружок). Низкий уровень 

экспрессии 

• No change (Без изменений) (черный кружок) 

Щелкните кнопкой мыши на вертикальной пороговой линии и «перетащите» ее для регулировки 
значения порогового уровня регуляции. 

Настройки 

Необходимо задать следующие настройки: 

• Control Sample (Контрольный образец) 

• Experimental Sample (Экспериментальный образец) 

• Пороговый уровень регуляции или P-значения. Введите или отредактируйте значение с 

помощью кнопок со стрелками, и пороговые линии установятся в соответствии с заданными 
параметрами 

Опции контекстного меню 

Щелкните правой кнопкой мыши в любой области графика для выбора пунктов меню, 
перечисленных в Таблице 41. 
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Электронная таблица данных 

Данная электронная таблица содержит данные мишени, образца, регуляции, P-значения, а также 
информацию о том, превышает или нет P-значение пороговый уровень, и индицирует 
положительную или отрицательную регуляцию по сравнению с настройками порогового уровня. 
Выберите кнопку-флажок или отмените выбор кнопки-флажка рядом с мишенью для включения ее 
в кластерграмму или исключения из диаграммы. Выберите опции контекстного меню графика, 
вызвав меню щелчком правой кнопкой мыши. 

Карта нагрева 

Карта нагрева представляет визуальное отображение регуляции мишеней для 
экспериментального образца в сравнении с контрольным образцом на основании относительной 
нормализованной экспрессии и точки ее проявления на планшете. 

Легенда под картой нагрева отображает диапазон данных нормализованной экспрессии: 

• Upregulation (Положительная регуляция) (красный). Высокий уровень экспрессии 

• Downregulation (Отрицательная регуляция) (зеленый). Низкий уровень экспрессии 

• No change (Без изменений) (черный) 

Чем менее насыщен цвет, тем больше разность уровней относительной нормализованной 
экспрессии. Если нормализованное значение экспрессии не рассчитано, ячейка будет выделена 
черным цветом с белой меткой «X». 

Настройки 

Необходимо задать следующие настройки: 

• Control Sample (Контрольный образец) 

• Experimental Sample (Экспериментальный образец) 

• Size (Размер). Размер изображения можно отрегулировать с помощью движка для 

изменения масштаба графика с целью обеспечения простой визуализации 

• Split Out Replicates (Отдельные дубликаты). Отображение значений для отдельных 

дубликатов 

Опции контекстного меню 

Щелкните правой кнопкой мыши в любой области карты нагрева для выбора пунктов меню, 
перечисленных в Таблице 40. 

Электронная таблица данных 

Электронная таблица перечисляет данные мишеней, образцов и регуляции. Выберите опции 
контекстного меню графика, вызвав меню щелчком правой кнопкой мыши. 

Результаты 

Электронная таблица результатов суммирует данные всех графиков. Содержимое электронной 
таблицы результатов приведено в Таблице 42. 
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Таблица 42. Содержимое электронной таблицы закладки Results 
 

Информация Описание 

Target (Мишень) Имя мишени (амплифицированного гена) 

Sample (Образец) Название образца 

Mean Cq (Cq среднее) Среднее цикла количественного анализа 

Mean Efficiency Corrected Cq 
(Среднее откорректированное 
Cq эффективности) 

Среднее значение данных количественного анализа после 
регулировки реакционной эффективности 

Normalized Expression 
(Нормализованная экспрессия) 

Экспрессия мишени, нормализованная до референс-мишени 
(∆∆Cq) 

Relative Normalized Expression 
(Относительная 
нормализованная экспрессия) 

Нормализованная экспрессия относительно контрольного 
образца. Также именуемая «кратностью изменения» 

Regulation (Регуляция) Изменение уровня экспрессии относительно контрольного 
образца 

Compared to Regulation 
Threshold (В сравнении с 
пороговым уровнем регуляции) 

Положительная или отрицательная регуляция 
экспериментального образца на основании настроек пороговой 
линии 

P-Value (P-значение) Вероятность значительной разницы между уровнями экспрессии 

Exceeds P-Value Threshold 
(Превышение порогового 
уровня P-значения) 

Индикация превышения/не превышения порогового уровня P 

значения для мишени 

ПРИМЕЧАНИЕ: Данные для дубликатов приведены только в тех электронных таблицах 
анализа данных, для которых выбрана опция Split Out Replicates (т.е. кластерграмма и карта 
нагрева); могут возникать разногласия данных экспрессии в электронных таблицах данных 
анализа экспрессии генов, если для гистограммы не был выбран контрольный образец. 

Исследование генов 

Создайте программу исследования генов для сравнения данных экспрессии генов одного или 
нескольких экспериментов с использованием ПЦР реального времени с помощью калибратора 
между постановками для нормализации данных между экспериментами. Создайте программу 
исследования генов, добавив данные из одного или нескольких файлов данных (.pcrd) к 
программе; программное обеспечение объединит данные в едином файле (.mgxd). 

ПРИМЕЧАНИЕ: Максимальное количество образцов, которое можно проанализировать в 
рамках программы исследования генов, ограничено объемом памяти RAM и виртуальной 
памяти. 

Калибровка между постановками исследований генов 

При каждом исследовании генов автоматически применяется функция калибровки между 
постановками для каждой мишени с целью нормализации различий между анализируемыми 
мишенями в отдельных экспериментах с использованием ПЦР реального времени (т.е. между 
различными файлами .pcrd, сгенерированными с различных планшетов). 

Чтобы программное обеспечение смогло распознать образец в качестве калибратора между 
постановками, необходимо строгое соответствие имени мишени, имени образа и, если 
применяется, имени биологического набора, в диапазоне всего планшета. 

ПРИМЕЧАНИЕ: Для обеспечения калибровки между постановками требуется наличие не 
менее одного образца-калибратора. Мишени без соответствующих калибраторов будут 
подвергаться обработки без коррекции (не рекомендуется). 

Калибраторы между постановками используются двумя способами: 

1. На мишень: различные праймеры ПЦР обладают разной эффективностью. По умолчанию, 
калибратор между постановками применяется ко всем лункам одного планшета с одинаковым 
именем мишени, т.е. Cq генерируется с теми же реагентами. 
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2. Полное исследование: пользователем выбирается один калибратор между постановками, 
который применяется ко всему исследованию генов. 

Для получения более подробной информации свяжитесь со службой технической поддержки 
(номера телефонов приведены на четвертой стороне обложки). 

Окно Gene Study (Программа исследования генов) 

Окно Gene Study содержит две закладки: 

• Закладка Study Setup (Задание параметров программы исследования генов). 

Щелкните на данной закладке для управления экспериментами по исследованию генов. 
Добавление или удаление файлов данных в закладке Gene Study не изменяет исходных 
данных файла 

• Закладка Study Analysis (Анализ данных исследования генов). Щелкните на данной 

закладке для просмотра данных экспрессии генов для комбинированных экспериментов 

На Рис. 86 представлено окно Gene Study с закладками Study Setup и Study Analysis. 

 

Рис. 86. Закладка Study Setup окна Gene Study 

Закладка Study Setup (Задание параметров программы 
исследования генов) 

Перед импортом данных в программу исследования генов выполните следующие действия в окне 
Data Analysis: 

• Убедитесь, что образцы, имеющие одинаковый состав, имеют одно имя. Программное 
обеспечение предполагает, что лунки с одинаковым именем мишени или образца содержат 
одинаковые образцы 

• Отрегулируйте базовую линию и пороговый уровень (Cq) в закладке Quantitation для 
оптимизации данных каждого эксперимента перед добавлением их в программу 

• Выберите группу лунок, которую Вы хотите включить в программу исследования генов 

Закладка Study Setup (Рис. 86) отображает перечень всех экспериментов в рамках эксперимента 
по исследованию генов. 

• Add runs (Добавить эксперименты). Щелкните на кнопке Add Data Files (Добавить 
файлы данных) для выбора файла в окне программы ускоренного просмотра. Для 

быстрого добавления экспериментов в программу исследования генов «перетащите» файл 
данных (.pcrd) в окно Gene Study 

СОВЕТ: Для отображения данных одной группы лунок в программе исследования генов 
необходимо выбрать группу перед импортом файла данных. 

• Remove runs from this Gene Study (Удалить эксперименты из программы 
исследования генов). Выберите один или несколько файлов из списка и щелкните на 
Remove 

• Add notes about the Gene Study (Добавить примечания к программе исследования 
генов). Введите комментарии в поле Notes (Примечания) к файлам и анализу 
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Закладка Study Setup содержит перечни файлов данных программы исследования генов 
(см. Таблицу 43). 

Таблица 43. Закладка Study Setup окна Gene Study 
 

Заголовок столбца Описание 

File Name (Имя файла) Имя файла данных эксперимента (расширение .pcrd) 

File Folder (Папка файла) Директория, в которой хранится файл данных каждого 
эксперимента программы исследования генов 

Date Created (Дата создания) Дата сбора данных эксперимента 

Well Group Name 
(Имя группы лунок) 

Имя группы лунок, выбранной при добавлении файла в 
программу исследования генов 
 
СОВЕТ: Для анализа одной группы лунок в программе 
исследования генов необходимо выбрать группу в окне Data 
Analysis перед импортом файла данных в программу 
исследования генов 

Этап Этап протокола, включающий прочтение планшета для сбора 
данных ПЦР реального времени 

Run Type 
(Тип эксперимента) 

Определенный пользователем эксперимент или эксперимент 
PrimePCR 

Protocol Edited 
(Отредактированный протокол) 

Если данная кнопка-флажок выбрана, значит, протокол, 
использованный для эксперимента PrimePCR, был 
отредактирован 

Plate View 
(Представление планшета) 

Открытие карты планшета с данными каждого эксперимента, 
включенного в программу исследования генов 

Закладка Study Analysis (Анализ данных исследования 
генов) 

Закладка Study Analysis отображает данные всех экспериментов, добавленных в программу 
исследования генов. Доступные для выбора опции анализа данных экспрессии генов аналогичны 
опциям для одного файла данных за следующим исключением: 

• Для гистограмм значения калибровки между постановками (если рассчитаны) отображаются 
при щелчке кнопкой мыши на кнопке Inter-run Calibration (Калибровка между 
постановками) 

• Для карт нагрева, при условии, что те же мишени находятся в тех же лунках на нескольких 
планшетах, но при наличии различных образцов, для выбора конкретного планшета для 
анализа используйте ниспадающее меню 

Окно Gene Study Report (Отчет об исследовании генов) 

Откройте окно Gene Study Report для составления отчета об исследовании генов на основании 
данных программы исследования генов. Для создания отчета по исследованию генов выполните 
следующие шаги: 

1. Перед созданием отчета отредактируйте данные для отчета по исследованию генов и 
графики. 

2. Выберите Tools > Reports (Инструменты > Отчеты) для открытия окна Gene Study Report. 

3. Выберите кнопки-флажки в перечне опций отчета для выбора и удаления опций для 
отображения нужных данных. Выберите опции, приведенные в Таблице 44. 

Таблица 44. Категории отчета по исследованию генов 
 

Категория Опция Описание 

Заголовок Заголовок, подзаголовок и регистрационные 
данные отчета 
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Таблица 44. Категории отчета по исследованию генов (продолжение) 
 

Категория Опция Описание 

 Report Information 
(Информация об отчете) 

Run Date (Дата эксперимента), User Name (Имя 
пользователя), Data File Name (Имя файла 
данных), Data File Path (Путь доступа к файлу 
данных) и Selected Well Group (Выбранная группа 
лунок) 

 Gene Study File List 
(Перечень файлов данных 
исследования генов) 

Перечень файлов данных исследования генов 

 Notes (Примечания) Примечания к отчету 

Гистограмма данных 
исследования генов 

Analysis Settings (Настройки 
анализа) 

Перечень выбранных параметров анализа 

 Chart (График) График данных экспрессии генов 

 Target Names (Имена 
мишеней) 

Мишени, используемые в исследовании генов 

 Sample Names (Имена 
образцов) 

Образцы, используемые в исследовании генов 

 Data (Данные) Электронная таблица данных 

 Target Stability 
(Стабильность мишени) 

Данные стабильности мишени 

 Inter-run Calibration 
(Калибровка между 
постановками) 

Данные калибровки между постановками 

Study Analysis-Clustergram, 
Scatter Plot, Volcano Plot, 
and Heat Map (Анализ 
исследования – 
кластерграмма, диаграмма 
рассеяния, график 
«вулкан», карта нагрева) 

Analysis Settings (Настройки 
анализа) 

Перечень выбранных параметров анализа 

 Chart (График) График данных экспрессии генов 

 Data (Данные) Электронная таблица данных 

4. Заполните отчет, набрав текст и вставив изображения, используя секцию опций (Рис. 87). 

 

Рис. 87. Опции Header (Заголовок) и Logo (Регистрационные данные) отчета Gene Study 

5. Щелкните на кнопке Update Report для обновления секции предварительного просмотра 

отчета. Отчет отобразится в секции предварительного просмотра отчета. 

6. Распечатайте или сохраните отчет. Щелкните на кнопке Print на панели инструментов для 
распечатки текущего отчета. Выберите File > Save (Файл > Сохранить) для сохранения 

отчета в формате PDF (файл формата Adobe Acrobat Reader), MHT (Microsoft document) или 
MHTML (документ Microsoft) и выбора местоположения для сохранения файла. Выберите 
File > Save As (Файл > Сохранить как) для сохранения отчета под новым именем или в 

новом местоположении. 
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7. Создайте шаблон отчета после создания отчета с содержимым, которое вы хотите 
включить в отчеты. Для создания шаблона выберите Template > Save or Save As 
(Шаблон > Сохранить) или Save As (Сохранить как) и сохраните текущий отчет в 

качестве шаблона. 

Расчеты экспрессии генов 

Программное обеспечение CFX Manager™ автоматически выводит формулы и выводит 
результирующую информацию в закладках окна Data Analysis. 

Реакционная эффективность 

Опыт показывает, что использование точных данных измерения эффективности для каждого 
набора праймеров и зондов обеспечивает более точные результаты анализа данных экспрессии 
генов. Значение эффективности по умолчанию, используемое в расчетах анализа экспрессии 
генов, составляет 100%. Для оценки реакционной эффективности постройте стандартную кривую, 
используя серию разведений репрезентативного образца в соответствующем динамическом 
диапазоне, и затем зарегистрируйте значение эффективности для последующего анализа 
экспрессии генов. Если Ваш эксперимент включает стандартную кривую, программное 
обеспечение автоматически рассчитает эффективность и отобразит ее значение под стандартной 
кривой закладки Quantification после выбора опции Auto Efficiency (Автоматическое вычисление 
значения эффективности) в закладке Targets окна Experiment Settings. 

Под эффективностью (E) в формулах расчета эффективности подразумевается термин, 
использованный в публикации Pfaffl (2001) and Vandesompele et al. (2002). В данных публикациях 
эффективность «2» (идеальное удваивание с каждым циклом) эквивалентна 100% эффективности, 
полученной с использованием данного программного обеспечения. Вы можете преобразовать 
Ваши расчеты эффективности в расчеты, используемые программным обеспечением, 
посредством следующих математических зависимостей: 

• E = (% эффективности* 0,01) +1 

• % эффективности = (E - 1)* 100 

Относительное количество 

Относительное количество (∆Cq) для любого образца (целевого гена) рассчитывается по 
следующей формуле: 

 

Относительное количество образца (GOI) = E 
(Cq (мин) - Cq (образца)) 
GOI 

где: 

• E = эффективность набора праймеров и зондов. Данная эффективность рассчитывается по 
формуле (% эффективности * 0,01) + 1, где 100% эффективность = 2 

• Cq (мин) = среднее значение Cq для образца с самым низким средним значением Cq для GOI 

• Cq (образца) = среднее значение Cq для образца 

• GOI = целевой ген (одна мишень) 

Относительное количество с выбранным 
контрольным образцом 

Если назначен контрольный образец (контроль), то относительное количество (RQ) для любого 
образца (GOI) с целевым геном рассчитывается по следующей формуле: 

 

Относительное количество образца (GOI) = E 
(Cq (контроля) - Cq (образца)) 
GOI 
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где: 

• E = эффективность набора праймеров и зондов. Данная эффективность рассчитывается по 
формуле (% эффективности * 0,01) + 1, где 100% эффективность = 2 

• Cq (контроля) = Среднее значение Cq для контрольного образца 

• Cq (образца) = Среднее значение Cq для любого образца с целевым геном 

• GOI = целевой ген (одна мишень) 

Среднеквадратическое отклонение относительного 
количества 

Среднеквадратическое отклонение относительного количества рассчитывается по следующей 
формуле: 

SD относительного количества = SD Cq GOI × Относительное количествообразца X × Ln (EGOI) 

где: 

• SD относительного количества = среднеквадратическое отклонение относительного 
количества 

• SD Cq образца = среднеквадратическое отклонение Cq для образца (целевой ген) 

• Относительное количество = Относительное количество образца 

• E = эффективность набора праймеров и зондов. Данная эффективность рассчитывается по 
формуле (% эффективности * 0,01) + 1, где 100% эффективность = 2 

• GOI = целевой ген (одна мишень) 

Откорректированное Cq эффективности (CqE) 

Откорректированное Cq эффективности рассчитывается по следующей формуле: 

CqE = Cq × (log(E)/log(2)) 

где: 

• E = эффективность 

Среднее откорректированное Cq эффективности (MCqE) 

Среднее откорректированное Cq эффективности рассчитывается по следующей формуле: 
 

MCqE = 
CqE (Дуб. 1) + CqE (Дуб. 2) +…+ CqE (Дуб. n) 

n 

где: 

• откорректированное Cq эффективности 

• n = количество дубликатов 
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Коэффициент нормализации 

Знаменатель уравнения нормализованной экспрессии называется коэффициент нормализации. 
Коэффициент нормализации – это геометрическое среднее относительных количеств всех 
референс-мишеней (генов) для данного образца, определяемое следующей формулой: 

Коэффициент нормализации образца (GOI) = (RQ образца (Реф. 1) × RQ образца (Реф.  2) × ... × RQ образца (Реф. n))  

где: 

• RQ = относительное количество 

• n = количество референс-мишеней 

• GOI = целевой ген (одна мишень) 

Нормализованная экспрессия 

Нормализованная экспрессия (∆∆Cq) – это относительное количество мишени (гена), 
нормализованное до количеств референс-мишеней (генов или последовательностей) в вашей 
биологической системе. Для выбора референс-мишеней откройте окно Experiment Settings и 
щелкните на столбце для каждой мишени, играющей роль референсного гена. 

Расчет нормализованной экспрессии описывается следующей формулой, использующей 
рассчитанное относительное количество (RQ): 

 

Нормализованная экспрессия образца (GOI) = 
RQ образца (GOI) 

(RQ образца (Реф. 1) × RQ образца (Реф. 2) × ... × RQ образца (Реф. n))  

где: 

• RQ = относительное количество образца 

• Реф. = референс-мишень в эксперименте, включающем одну или несколько референс-
мишеней в каждом образце 

• GOI = целевой ген (одна мишень) 

При условии неизменности уровня экспрессии референс-мишеней в биологической системе 
расчет нормализованной экспрессии обусловит разность объемов загрузки или количеств клеток 
каждого образца. 

Нормализованная экспрессия с выбранным контрольным 
образцом 

При выборе контрольного образца в окне Experiment Settings программное обеспечение задает 
уровень экспрессии контрольного образца как «1». В данном случае программное обеспечение 
нормализует относительные количества экспрессии мишеней (генов) до количества контрольного 
образца (значение «1»). Данная нормализованная экспрессия эквивалентна анализу 
немасштабированной нормализованной экспрессии с выбранным контролем. 

ПРИМЕЧАНИЕ: Данная нормализованная экспрессия известна также как «относительная 
нормализованная экспрессия» и «кратность изменения». 
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Среднеквадратическое отклонение для нормализованной 
экспрессии 

Повторное масштабирование значения нормализованной экспрессии сопровождается делением 
среднеквадратического отклонения нормализованной экспрессии на значение нормализованной 
экспрессии для отдельного самого высокого или самого низкого уровня экспрессии, в зависимости 
от выбранной вами опции масштабирования. Среднеквадратическое отклонение (SD) 
коэффициента нормализации рассчитывается по следующей формуле: 

2 2 2

образца (Реф.1) образца (Реф. 2) образца (Реф. n)

n n

образца (Реф.1) образца (Реф. 2) образца (Реф. n)

SD RQ SD RQ SD RQ
SD NF = NF × + +...+

n ×RQ n ×RQ n ×RQ

     
     
     
     

 

где: 

• RQ = относительное количество образца 

• SD = среднеквадратичное отклонение 

• NF = коэффициент нормализации 

• Реф. (Ref) = референс-мишень 

• n = количество референс-мишеней 

Когда выбран контрольный образец, нет необходимости использовать функцию повторного 
масштабирования, что продемонстрировано нижеприведенной формулой: 

22

образца (GOI)образца

образца (GOI) образца (GOI)

образца образца (GOI)

SD RQSD NF
SD NE = NE × +

NF RQ

  
     

   

 

где: 

• NE = нормализованная экспрессия 

• RQ = относительное количество образца 

• SD = среднеквадратичное отклонение 

• GOI = целевой ген (одна мишень) 

Нормализованная экспрессия, отмасштабированная до 
самого высокого уровня экспрессии 

Если эксперимент не включает контроли, отмасштабируйте нормализованную экспрессию (NE) 
для каждой мишени (гена), разделив уровень экспрессии каждого образца на самый высокий 
уровень экспрессии во всех образцах. Программное обеспечение установит самый высокий 
уровень экспрессии на значение «1» и произведет повторное масштабирование всех уровней 
экспрессии образца. Самая высокая степень масштабирования рассчитывается по следующей 
формуле: 

 

Масштабированная нормализованная экспрессия образца (GOI) = 
Нормализованная экспрессия образца (GOI) 

Нормализованная экспрессия образца, (GOI), выс. 

где: 

GOI = целевой ген (одна мишень) 
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Нормализованная экспрессия, отмасштабированная до 
самого низкого уровня экспрессии 

Если эксперимент не включает контроли, отмасштабируйте нормализованную экспрессию (NE) 
для каждой мишени (гена), разделив уровень экспрессии каждого образца на самый низкий 
уровень экспрессии во всех образцах. Программное обеспечение установит самый низкий уровень 
экспрессии на значение «1» и произведет повторное масштабирование всех уровней экспрессии 
образца. Самая низкая степень масштабирования рассчитывается по следующей формуле: 

 

Масштабированная нормализованная экспрессия образца (GOI) = 
Нормализованная экспрессия образца (GOI) 

Нормализованная экспрессия образца, (GOI), низк. 

где: 

GOI = целевой ген (одна мишень) 

Нормализованная экспрессия, отмасштабированная до 
среднего уровня экспрессии 

Если эксперимент не включает контроли, отмасштабируйте нормализованную экспрессию (NE) 
для каждой мишени (гена), разделив уровень экспрессии каждого образца на средний 
геометрический уровень экспрессии во всех образцах. Программное обеспечение установит 
средний уровень экспрессии на значение «1» и произведет повторное масштабирование всех 
уровней экспрессии образца. Средняя степень масштабирования рассчитывается по следующей 
формуле: 

 

Масштабированная нормализованная экспрессия образца (GOI) = 
Нормализованная экспрессия образца (GOI) 

Нормализованная экспрессия геом. средн. (GOI) 

где: 

• GOI = целевой ген (одна мишень) 

• Геом. средн. = геометрическое среднее нормализованной экспрессии для всех образцов 

Среднеквадратическое отклонение для масштабированной 
нормализованной экспрессии 

Повторное масштабирование значения нормализованной экспрессии (NE) сопровождается 
делением среднеквадратического отклонения (SD) нормализованной экспрессии на значение 
нормализованной экспрессии для самого высокого (Макс.) или самого низкого (Мин.) уровня 
экспрессии, в зависимости от выбранной вами опции масштабирования. 

ПРИМЕЧАНИЕ: Когда выбран контрольный образец, нет необходимости использовать 
функцию повторного масштабирования при расчете среднеквадратического отклонения. 

Формула расчета: 

 

SD масштабирован. NE образца (GOI) = 
SD NE образца (GOI) 

NE МАКС. или МИН. (GOI) 

где: 

• NE = нормализованная экспрессия 

• SD = среднеквадратичное отклонение 

• GOI = целевой ген (одна мишень) 

• МАКС. = самый высокий уровень экспрессии 

• МИН. = самый низкий уровень экспрессии 
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Регуляция 

Регуляция – показатель повышения или понижения экспрессии мишени экспериментального 
образца в сравнении с контрольным образцом, определяемый следующей формулой: 

Для RNE ≥ 1 регуляция = RNE 

Для RNE < 1 регуляция = (-1)/RNE 

где: 

• RNE = относительная нормализованная экспрессия (то же, что и нормализованная 
экспрессия с выбранным контролем) 

P-значение 

P-значение – это показатель статистической значимости точки данных экспериментального 
образца по сравнению с контрольным образцом. 

ПРИМЕЧАНИЕ: Для контрольного и экспериментального образцов требуется не менее двух 
контролей для определения P-значения. Чем больше дубликатов, тем выше точность. 

P-значение рассчитывается следующим образом: 

P-значение = 1 - A 

где: 

 

где: 

v = Count (NE образца (экспериментального)) + Count (NE образца (контрольного)) - 2 

• Г = гамма-функция 

• t = t-статистика 

( ) ( )

2 2

( ) ( ) ( ) ( )

( ( ) - ( ( )
=

( ( ) -1)* ( ) + ( ( ) -1)* ( )

образца экспериментального t образца контроля

образца экспериментального t образца экспериментального t образца контроля образца контроля

Mean NE Mean NE
t

Count NE SD NE Count NE SD NE

C
( ) ( ) ( ) ( )

1 1
* +

( ) + ( ) - 2 ( ) ( )
образца экспериментального t образца контроля образца экспериментального t образца контроля

ount NE Count NE Count NE Count NE

 

где: 

• Mean = среднее арифметическое 

• NE = нормализованная экспрессия 

• Count(x) = количество элементов в списке x 

• SD = среднеквадратичное отклонение образца 
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Формулы расчета скорректированных значений 

Различия между скорректированными и нескорректированными значениями видны только, если в 
качестве части эксперимента с использованием ПЦР реального времени сгенерирована 
стандартная кривая. Для определения вероятности распространения ошибки программное 
обеспечение использует три уравнения: 

• Дисперсия 

• Дисперсия для нормализованной экспрессии 

• Дисперсия для нормализованного исследуемого гена (мишени) 

Формула расчета дисперсии: 

Дисперсия = 
SD

n
 

где: 

• n = количество референс-мишеней (генов) 

• SD = среднеквадратическое отклонение 

Дисперсия для коэффициента нормализации в формуле расчета нормализованной экспрессии: 

2 2 2

образца (Реф.1) образца (Реф. 2) образца (Реф. n)

n n

образца (Реф.1) образца (Реф. 2) образца (Реф. n)

SE RQ SE RQ SE RQ
SE NF = NF × + +...+

n ×SE RQ n ×SE RQ n ×SE RQ

     
     
     
     

 

где: 

• n = количество референс-мишеней 

• SE = дисперсия 

• NF = нормализованная экспрессия 

• RQ = относительное количество 

Дисперсия для нормализованного целевого гена (GOI): 

2 2

n
n n

n

SE NF SE GOI
SE GOI = GOI × +

NF GOI

   
   

  

 

где: 

• SE = дисперсия 

• GOI = целевой ген (одна мишень) 

• NF = коэффициент нормализации 

• n = количество референс-мишеней 
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10 Пользователи и установки 

В данной главе приведена информация об управлении пользователями программного 
обеспечения и их установками. 

• Регистрация в системе или выбор пользователя (стр. 133) 

• Окно User Preferences (Установки пользователя) (стр. 134) 

• Управление пользователями (стр. 142) 

Регистрация в системе или выбор пользователя 

Программное обеспечение CFX Manager™ осуществляет управление множеством пользователей 
и их установками. Текущий, зарегистрированный в системе, пользователь отображается в верхней 
части главного окна программного обеспечения. 

Программное обеспечение CFX Manager контролирует пользователей, вошедших в систему через 
диалоговое окно входа в систему (Рис. 88). Когда вы запускаете программное обеспечение, 
автоматически открывается диалоговое окно входа в систему, если в окне User Administration 
(Управление пользователями) зарегистрированы два или более пользователей. 

 

Рис. 88. Диалоговое окно входа в систему 

Войдите в систему или переключите пользователей следующим образом: 

1. Откройте диалоговое окно входа в систему, если оно еще не открыто, щелкнув на кнопке 
Select User (Выбрать пользователя) на панели инструментов или выбрав User > Select User 

в строке меню. 

2. Выберите имя из ниспадающего списка User Name (Имя пользователя). Именем 

пользователя по умолчанию является «Admin» (Администратор). 

3. Введите пароль в поле Password (Пароль). 

4. Щелкните на кнопке OK для закрытия диалогового окна входа в систему и открытия 

программного обеспечения. 

5. Для добавления имени пользователя и пароля свяжитесь со своим администратором 
программного обеспечения. 
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Пользователи и установки 

Смена пароля 

Для смены пароля выполните следующие инструкции: 

1. Выберите User > Change Password в главном окне программного обеспечения для 

открытия диалогового окна смены пароля. 

2. Введите старый пароль в поле Old Password (Старый пароль). 

3. Введите новый пароль в поля New Password (Новый пароль) и Confirm New Password 
(Подтвердить новый пароль). 

4. Щелкните на кнопке OK для подтверждения изменений. 

 

Рис. 89. Диалоговое окно Change Password 

Окно User Preferences (Установки пользователя) 

ПО CFX Manager отслеживает установки каждого пользователя, входящего в систему. Для 
изменения установок откройте окно User Preferences одним из следующих способов: 

• Щелкните на кнопке User Preferences на панели инструментов главного окна программного 

обеспечения 

• Выберите User > User Preferences в строке меню главного окна программного обеспечения 

• Щелкните на одной из закладок (Рис. 90) для просмотра или изменения установок 

 

Рис. 90. Окно User Preferences с закладками 
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СОВЕТ: Щелкните на кнопке Restore Default (Вернуться к настройкам по умолчанию) 

для возврата всех настроек к значениям по умолчанию, отображенным в данном 
изображении. Затем щелкните на кнопке OK для сохранения настроек и закройте окно. 

Закладка Email (Электронная почта) 

Выберите закладку Email (Рис. 90) для ввода адреса электронной почты, по которой Вы будете 

получать уведомление о завершении эксперимента. Программное обеспечение будет отправлять 
прикрепленный файл данных или файл отчета по электронной почте при выборе кнопок-флажков 
напротив данных опций. 

Щелкните на кнопке Configure Outgoing Email (Конфигурировать исходящее электронное 
письмо) для открытия окна Options (Опции) (Рис. 91) для конфигурирования SMTP-сервера для 

отправки электронного письма с компьютера. Введите следующие данные: 

• SMTP Server Name (Имя сервера SMTP). Имя SMTP-сервера в соответствии с Вашим ISP 

• Port (Порт). Номер порта Вашего SMTP-сервера в соответствии с Вашим ISP; как правило, 

это «25» 

• Use SSL (Использовать SSL). Будет ли использоваться протокол защиты информации 

SSL. Некоторые SMTP-серверы требуют использования данного протокола, другие требуют, 
чтобы протокол не использовался 

• Use Default «From» Address (Использовать исходящий адрес по умолчанию). Данная 

настройка обычно остается выбранной по умолчанию. Тем не менее, некоторые SMTP-
серверы требуют, чтобы все отправленные письма имели исходящий адрес определенного 
домена, например: <name>@YourCompany.com. В данном случае необходимо отменить 
выбор данной кнопки-флажка, и действительный исходящий адрес электронной почты 
должен быть указан в поле «From» Address 

• Authentication Required (Требуется авторизация). Многие SMTP-серверы требуют 

авторизации. Если это так, данная кнопка-флажок должна быть выбрана, и должны быть 
предоставлены имя пользователя и пароль пользователя в полях User Name и Password, 
соответственно 

• Test email (Тестировать настройки электронной почты). Для тестирования настроек 

электронной почты введите один или несколько адресов электронной почты в текстовое 
поле Test Email Address (Тестировать адрес электронной почты). Множество адресов 
электронной почты можно разделить запятыми. Затем щелкните на кнопке Test Email 

 

Рис. 91. Опции конфигурирования настроек электронной почты 

ПРИМЕЧАНИЕ: Некоторые SMTP-серверы не допускают приложений, а другие допускают 
приложения определенного размера. Если Вы будете использовать ПО CFX Manager для 
отправки по электронной почте файлов данных и/или отчетов, Вы можете проверить 
способность Вашего сервера отправлять приложения, выбрав кнопку-флажок Test 
Attachment (Тестовое приложение), и задав размер приложения в поле Attachment Size 
(Размер приложения) в «МБ» как 5 МБ или больше. 
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Закладка Files (Файлы) 

Выберите закладку Files (Рис. 92) для отображения списка местоположений по умолчанию для 

открытия и сохранения файлов. 

• Default Folder for File Creation (Папка по умолчанию для создания файлов). Выберите 

папку по умолчанию, в которой вы хотите сохранять новые файлы. Выберите 
местоположение для каждого типа файла (протокола, планшета, данных или данных 
исследований генов) 

• File Selection for Run Setup (Выбор файла для задания параметров анализа). Выберите 

файлы протокола и планшета по умолчанию, которые появятся при открытии окна 
Experiment Setup (Задание параметров эксперимента) 

• Data File Prefix (Префикс файла данных). Определите начальный текст имени файла для 

файлов данных. Настройка по умолчанию побуждает программное обеспечение создать 
имя файла, начинающееся с имени пользователя (имя пользователя, на текущий момент 
зарегистрированный в системе), затем содержащее дату (дату создания файла) и имя 
прибора (серийный номер или название прибора) 

 

Рис. 92. Закладка Files окна User Preferences 

СОВЕТ: Щелкните на кнопке «…» справа от каждого поля для открытия окна браузера и 
размещения папки. 

Закладка Protocol (Протокол) 

Выберите закладку Protocol (Рис. 93) в окне User Preferences для задания настроек по умолчанию 

для нового файла протокола в окне Protocol Editor: 

• Protocol Editor (Редактор протоколов). Задайте настройки по умолчанию, которые будут 

отображены в окне Protocol Editor. Выберите объем образца по умолчанию (в микролитрах) 
для описания объема каждого образца в лунках, после чего выберите температуру 
отключения крышки 

• Protocol AutoWriter (Составитель протоколов Protocol AutoWriter). Задайте настройки 

по умолчанию, которые будут отображены в окне Protocol AutoWriter, включая температуру 
отжига для экспериментов, использующих ДНК-полимеразу iProof™, ДНК-полимеразу iTaq™ 
или другие полимеразы, а также длину ампликона 



Руководство по эксплуатации систем ПЦР реального времени с флуоресцентной детекцией 
CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch 

137 

 

Рис. 93. Закладка Protocol окна User Preferences 

Закладка Plate (Планшет) 

Выберите закладку Plate в окне User Preferences (Рис. 94) для задания настроек по умолчанию для 

нового файла планшета в окне Plate Editor: 

• Plate Type (Тип планшета). Выберите из списка тип планшета по умолчанию 

• Plate Size (Размер планшета). Выберите из списка размер планшета по умолчанию 

• Units (Единицы измерения). Выберите единицы измерения концентрации ДНК-мишени 

для лунок, содержащих стандарты. Программное обеспечение использует данные единицы 
измерения для создания стандартной кривой в закладке Quantification окна Data Analysis 

• Scientific Notation (Экспоненциальное представление). Выберите данную опцию для 

экспоненциального представления единиц измерения концентрации 

• Scan Mode (Режим сканирования). Выберите режим сканирования по умолчанию для 

задания количества каналов, которые будут сканироваться в ходе выполнения 
эксперимента 

• Fluorophores (Флуорофоры). Выберите кнопки-флажки соответствующих флуорофоров 

для отображения их в опциях загрузки лунок редактора планшетов 

• Libraries (Библиотеки). Введите имена мишени и образца, используемых в экспериментах 

Введите имена мишеней для перечисления генов и последовательностей, и имена 
образцов для перечисления условий для экспериментальных образцов. Данные имена 
появятся в перечнях закладок Targets и Samples окна Experiment Settings 
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Рис. 94. Закладка Plate окна User Preferences 

Закладка Data Analysis (Анализ данных) 

Выберите закладку Data Analysis в окне User Preferences (Рис. 95) для изменения настроек по 

умолчанию для данных, отображаемых в окне Data Analysis. 

 

Рис. 95. Закладка Data Analysis окна User Preferences 

Выбор режима анализа данных: режим Fluorophore (Флуорофор) или Target (Мишень). 
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Для данных количественного анализа выберите следующие настройки: 

• Baseline Setting (Настройка базовой линии). Выберите для режима анализа метод 

определения базовой линии по умолчанию. Выберите Baseline Subtracted Curve Fit 
(Построение кривой с вычтенной базовой линией), No Baseline Subtraction (Без вычитания 
базовой линии) или Baseline Subtracted (С вычтенной базовой линией) 

• Cq Determination Mode (Режим определения Cq). Выберите режим Regression (Регрессия) 

или режим Single Threshold (Один пороговый уровень) для определения метода расчета 
значений Cq для всех данных флуоресценции 

• Threshold Calc. Mode (Режим расчета порогового значения). Выберите между Auto 

Threshold (Автоматический расчет порогового уровня) и Manual Threshold (расчет 
порогового уровня в ручном режиме). Если выбран ручной режим, положение пороговой 
линии будет зависеть от заданного значения относительных единиц флуоресценции (ОЕФ). 
Данная настройка порогового уровня будет использоваться в файлах данных последующих 
экспериментов 

• Baseline Calc. Mode (Режим расчета базовой линии). Выберите между Auto Baseline 

(Автоматический расчет базовой линии) и Manual Baseline (Расчет базовой линии в ручном 
режиме). Если выбран ручной режим, диапазон циклов, используемый для определения 
базовой линии для всех данных, будет зависеть от заданных значений. Данный диапазон 
будет использоваться в файлах данных последующих экспериментов 

• Log View (Просмотр журнала). Выберите On (Вкл.) для отображения 
полулогарифмического графика данных амплификации. Выберите Off (Выкл.) для 

отображения линейного графика 

Для данных флуоресценции по конечной точке выполните следующие настройки. Выберите 
количество конечных циклов для усреднения при расчете данных в конечной точке: 

• PCR (ПЦР). Введите количество циклов для ПЦР для усреднения конечных циклов для 

данных количественного анализа (значение по умолчанию – 5) 

• End Point Only Run (Анализ флуоресценции по конечной точке). Введите количество 

циклов для протокола анализа флуоресценции по конечной точке для усреднения конечных 
циклов для данных в конечной точке (значение по умолчанию – 2) 

Для данных кривой плавления выберите детектирование положительных или отрицательных 
пиков. 

Для секций селектора лунок выберите опцию добавления лункам меток с типом образца, именем 
мишени или именем образца. 

Закладка Gene Expression (Экспрессия генов) 

Выберите закладку Gene Expression в окне User Preferences (Рис. 96) для задания настроек по 

умолчанию новому файлу данных экспрессии генов. 

 

Рис. 96. Закладка Gene Expression окна User Preferences 
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Задайте настройки по умолчанию новому файлу данных экспрессии генов: 

• Relative to (Относительно…). Выберите Control (Контроль) или Zero (Ноль). Для 

нанесения данных экспрессии генов на график, генерируемых при значении «1» 
(относительно контроля), выберите Control. При назначении контрольного образца в окне 

Experiment Setup программное обеспечение автоматически принимает значения по 
умолчанию для расчета данных относительно контроля. Выберите Relative to zero 
(Относительно нуля) для настройки программного обеспечения на игнорирование 

контроля, что является выбором по умолчанию при отсутствии контрольных образцов, 
назначенных в окне Experiment Settings 

• X-Axis (Ось Х). Нанесите мишень или образец по оси Х 

• Y-Axis (Ось Y). Используйте масштаб Linear, Log 2 или Log 10 по оси Y 

• Scaling (Масштабирование). Выберите опцию масштабирования для графика. Или 

оставьте график немасштабированным. Альтернативно, выберите опцию масштабирования 
до самого высокого (Highest) или самого низкого (Lowest) уровня 

• Method (Метод). Задайте режим анализа по умолчанию, включая нормализованную 

экспрессию (∆∆Cq) или относительную экспрессию (∆Cq) 

• Error Bar (Планки погрешностей). Выберите Std Dev. для среднеквадратического 

отклонения или Std.Error Mean для стандартной погрешности среднего 

• Error Bar (Коэффициент планок погрешностей). Выберите коэффициент 

среднеквадратического отклонения для применения планок погрешностей к графику. 
Значение по умолчанию – «1». Вы можете изменить коэффициент на «2» или на «3» 

Закладка QC (Контроль качества) 

Выберите закладку QC окна User Preferences (Рис. 97) для задания правил проверки качества, 

которые будут применяться к данным, анализируемых модулем анализа данных. Программное 
обеспечение производит согласование данных в отношении проведенных экспериментов и 
присвоенных значений. 

ПРИМЕЧАНИЕ: Лунки, не соответствующие параметрам качества, могут быть исключены из 
анализа в закладке QC окна Data Analysis с помощью опции контекстного меню. 

 

Рис. 97. Закладка QC окна User Preferences 

Задайте значения критической оптической плотности и активируйте следующие правила проверки 
качества: 

• Negative control with a Cq less than XX (Отрицательный контроль со значением Cq ниже XX). 
Введите значение критической оптической плотности Cq 

• NTC with a C(t) less than XX (Образец без ДНК-мишени со значением Cq ниже XX). Введите 
значение критической оптической плотности Cq 
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• NTC with a Cq less than XX (Образец без обратной транскриптазы со значением Cq ниже XX). 
Введите значение критической оптической плотности Cq 

• Positive control with a Cq greater than XX (Положительный контроль со значением Cq выше 
XX). Введите значение критической оптической плотности Cq 

• Unknown without a Cq (Неизвестный образец без Cq) 

• Standard without a Cq (Стандартный образец без Cq) 

• Efficiency greater than XX (Эффективность выше XX). Введите значение критической 
оптической плотности, которое будет рассчитано для стандартной кривой 

• Efficiency less than XX (Эффективность ниже XX). Введите значение критической оптической 
плотности, которое будет рассчитано для стандартной кривой 

• Std Curve R^2 less than XX (R^2 стандартной кривой ниже XX). Введите значение 
критической оптической плотности R^2 для стандартной кривой 

• Replicate group Cq Std Dev greater than XX (Среднеквадратическое отклонение Cq группы 
дубликатов выше XX). Введите среднеквадратическое отклонение критической оптической 
плотности, которое будет рассчитано для группы дубликатов 

Закладка Custom Export (Экспортировать индивидуальный 
отчет) 

Выберите закладку Custom Export (Рис. 98) для определения настроек по умолчанию для полей, 
подлежащих экспорту, и формата экспорта. 

 

Рис. 98. Закладка Custom Export окна User Preferences 

Выберите формат экспорта: (*.txt), CSV (*.csv), Excel 2007 (*.xlsx), Excel 2003 (*.xls), XML (*.xml) и 
HTML (*.html). 

Для экспорта можно выбрать следующие пункты: 

• Sample Description (Описание образца). Well (Лунка), Fluorophore (Флуорофор), Target 

Name (Имя мишени), Content (Содержимое), Replicate # (Количество дубликатов), Sample 
Name (Имя образца), Biological Set Name (Имя биологического набора) и Well Note 
(Примечание к лунке) 

• Quantification (Количественный анализ). Cq, Starting Quantity (Начальное количество), Cq 

Standard Deviation (Среднеквадратич. отклонение Cq) и Quantity Standard Deviation 
(Среднеквадратич. отклонение количества) 

• Melt Curve (Кривая плавления). Melt Temperature (Температура плавления), Peak Height 

(Высота пика), Melt Peak Begin Temperature (Начальная температура пика плавления) и End 
Temperature (Конечная температура) 

• End Point (Конечная точка). End Point Call (Идентификация в конечной точке) и End RFU 

(Конечное значение ОЕФ) 

• Customize Column Names (Изменить заголовки столбцов). Переименование заголовков 

столбцов 
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Порядок расположения пунктов может быть изменен выделением пункта и перемещением его с 
помощью кнопок со стрелками слева от перечня Exported Columns (Экспортированные столбцы) 
вверх или вниз. 

ПРИМЕЧАНИЕ: Выбор опции Restore Defaults в любой закладке окна User Preferences произведет 
возврат всех опций к настройкам по умолчанию. 

User Administration (Управление пользователями) 

Откройте окно User Administration в главном окне программного обеспечения: 

• Выберите Users > User Administration 

• Щелкните на кнопке User Administration в строке меню 

Если Вы зарегистрированы в системе как администратор, откройте окно User Administration для 
управления пользователями и правами пользователей: 

• Manage Users (Управление пользователями). Добавляйте или удаляйте пользователей и 

назначайте каждому пользователю уровень доступа 

• Manage Rights (Управление правами). Изменяйте права пользователей с разными 

уровнями доступа (Principal (Основной), Operator (Оператор) или Guest (Гость)) 

ПРИМЕЧАНИЕ: Редактировать данное окно могут только пользователи с правами 
администратора. Для остальных пользователей данное окно доступно только для 
просмотра. 

Для назначения прав каждому пользователю выберите права из списка в окне User Administration 
(Рис. 99). В данном примере пользователю с правами гостя (Guest) предоставлено право 
сохранения файлов. 

 

Рис. 99. Окно User Administration с тремя пользователями 

Добавление и удаление пользователей программного 
обеспечения 

Добавлять и удалять пользователей может только администратор программного обеспечения. Для 
добавления пользователей программного обеспечения в секции окна Manage Users выполните 
следующие шаги: 

1. Введите имя нового пользователя программного обеспечения. 

2. Выберите уровень доступа пользователя. Данные уровни доступа ограничивают права 
каждого пользователя. Значение по умолчанию: «Principal». 

3. (Опционально) Введите полное имя и пароль нового пользователя программного 
обеспечения в поля Full Name и Password, соответственно. 

4. Щелкните на кнопке OK для открытия диалогового окна и подтверждения команды закрытия 

окна. 
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5. Щелкните на Yes (Да) для закрытия диалогового окна и окна. 

Для удаления пользователя программного обеспечения выполните следующие шаги: 

1. В секции окна Manage Users выберите кнопку-флажок в списке Delete (Удалить) для каждого 
пользователя программного обеспечения, которого Вы хотите удалить. 

2. Щелкните на кнопке OK для открытия диалогового окна и подтверждения команды закрытия 

окна. 

3. Щелкните на Yes (Да) для закрытия диалогового окна и окна. 

ПРИМЕЧАНИЕ: Перечень пользователей программного обеспечения должен обязательно 
включать одного администратора. 

Назначение прав уровням доступа пользователей 

Окно User Administration предоставляет доступ к уровням доступа и правам пользователей. 
Программное обеспечение предоставляет следующие четыре уровня доступа: 

• Administrator (Администратор) (обязательный). Каждый администратор обладает всеми 

правами, которые невозможно изменить. Администратор также может добавлять и удалять 
пользователей программного обеспечения, а также изменять права для каждого уровня 
доступа 

• Principal (Основной). По умолчанию каждый основной пользователь обладает всеми 

правами 

• Operator (Оператор). По умолчанию каждый оператор обладает всеми правами, за 

исключением права пропуска циклов и создания файла исследований генов 

• Guest (Гость). По умолчанию каждый гость не имеет дополнительных прав и обладает 

только правом доступа к чтению файлов 

Для присвоения прав каждому уровню доступа выполните следующие инструкции: Изменять права 
каждого уровня доступа может только пользователь с правами администратора: 

1. В секции окна Manage Rights выберите кнопку-флажок под названием уровня доступа для 
добавления или удаления данного права. Выберите щелчком кнопкой мыши одно или 
несколько прав в списке. Для изменения всех прав для всех уровней доступа по умолчанию 
щелкните на Restore Default Rights (Вернуться к правам по умолчанию). 

2. Щелкните на кнопке OK для открытия диалогового окна и подтверждения команды закрытия 

окна. 

3. Щелкните на Yes (Да) для закрытия диалогового окна и окна. 

Для просмотра текущих уровня доступа и прав пользователя выберите User > User 
Administration. Свяжитесь с администратором программного обеспечения для изменения 

настроек, прав и уровней доступа пользователей, перечисленных в окне User Administration. 
Основные пользователи, операторы или гости могут только просматривать данные настройки, 
права и уровни доступа. 
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11 Ресурсы 

Ознакомьтесь с данной главой для получения информации по подготовке к работе и настройке 
системы CFX96 Touch™, CFX96 Touch Deep Well™, CFX Connect™ или CFX384 Touch™: 

• Автоматическое обновление программного обеспечения и приборов (стр. 145) 

• Извлечение файлов данных из термоциклера (стр. 146) 

• Интеграция системы LIMS (стр. 146) 

• Программа калибровки Calibration Wizard (стр. 151) 

• Техническое обслуживание прибора (стр. 153) 

• Журнал приложения (стр. 155) 

• Диагностика неисправностей (стр. 155) 

• Список литературы (стр. 158) 

Автоматическое обновление программного обеспечения 
и приборов 

Программное обеспечение и приборы могут быть автоматически обновлены с помощью 
программного обеспечения CFX Manager™. 

Доступность обновлений может быть определена тремя способами: 

1. Программное обеспечение автоматически производит проверку на предмет обновлений 
каждый раз при запуске ПО CFX Manager и подключении к компьютеру с запущенным 
программным обеспечением нового прибора. 

2. Сообщения об обновлениях отображаются в нижней части главного окна ПО CFX Manager. 
При щелчке на сообщение появляется окно Updates (Обновления). 

3. Выбор Help > Check For Updates (Справка > Проверить обновления). 

При наличии обновлений окно Updates предоставляет следующие опции: 

• Если доступно обновление только программного обеспечения, выберите Update 

• Если доступны обновления программного обеспечения и прибора, данные обновления 
будут выбраны по умолчанию. Обновление программного обеспечения требует обновления 
прибора на предмет подключенных приборов для обеспечения надлежащей коммуникации 

• Приборы могут обновляться без обновления программного обеспечения посредством 
отмены выбора кнопки-флажка обновления программного обеспечения 
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Когда выбраны обновления программного обеспечения и прибора, программное обеспечение 
произведет обновление, перезагрузится, после чего начнется обновление прибора. После 
обновления прибора необходима его перезагрузка. 

Для загрузки самых свежих обновлений необходимо, чтобы компьютер с программным 
обеспечением CFX Manager был подключен к сети Интернет. Все окна анализа данных должны 
быть закрыты, и все приборы должны находиться в режиме ожидания. 

Если прибор подключен к компьютеру, программное обеспечение CFX Manager проверит 
совместимость программного обеспечения прибора с версией установленного программного 
обеспечения CFX Manager. Если программное обеспечение прибора не совместимо, оно будет 
автоматически обновлено. Для данной операции подключение к сети Интернет не требуется. 

Для предотвращения появления окна обновлений при наличии таковых отмените выбор 
кнопки-флажка Notify when updates are available (Уведомлять при наличии обновлений) 
окна Updates. Для повторной активации окна обновлений выберите Help > Check for 
Updates в главном меню программного обеспечения и выберите кнопку-флажок Notify 
when updates are available. 

ПРИМЕЧАНИЕ: Приборы MiniOpticon™ не подлежат обновлению посредством 
программного обеспечения CFX Manager. 

Извлечение файлов данных из основного блока 
термоциклера 

Файлы данных, расположенные в основном блоке термоциклера, могут быть извлечены на жесткий 
диск подключенного компьютера. Для извлечения файлов выполните следующие инструкции: 

1. В главном окне программного обеспечения выберите прибор в секции окна Detected 
Instruments. 

2. Щелкните правой кнопкой мыши и выберите Retrieve Data Files... (Извлечь файлы 
данных). 

3. Выберите адрес папки, в которую будут сохранены извлеченные файлы. 

4. Щелкните на кнопке Ok. 

ПРИМЕЧАНИЕ: Все файлы в папке данных реального времени в основном блоке 
термоциклера будут отправлены на компьютер. 

Интеграция системы LIMS 

Программное обеспечение CFX Manager™ может быть сконфигурировано для использования с 
Лабораторной информационной системой (LIMS). Для интеграции системы LIMS программному 
обеспечению CFX Manager™ необходима информация по настройкам планшета, 
сгенерированным платформой LIMS (файл LIMS, *.plrn), файл протокола, созданный программным 
обеспечением CFX Manager (*.prcl), определенный адрес экспорта данных и определенный 
формат экспорта. 

Настройка опций папки LIMS и экспорта данных 

1. Выберите Tools > Options (Инструменты > Опции) в главном меню программного 
обеспечения, затем выберите закладку LIMS (Рис. 100) для определения местоположения 

папки, которая будет содержать протокол LIMS (*.prcl), файл LIMS (*.plrn) и 
экспортированные данные. 
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Рис. 100. Окно Options, отображающее закладку LIMS Settings 

2. По завершении анализа может быть автоматически сгенерирован файл для экспорта 
данных, в дополнение к файлу данных *.pcrd ПО CFX Manager . Выберите кнопку-флажок 
Automatically Export Data after Run (Автоматически экспортировать данные по 
завершении эксперимента) (Рис. 100) для автоматического экспорта данных по окончании 

анализа. 

3. Щелкните на кнопке Data Export Settings (Настройки экспорта данных) для задания 

формата файла для экспортированных данных и подлежащих экспорту информационных 
полей (Рис. 101). 

 

Рис. 101. Окно LIMS Data Export Format Settings 
(Настройки формата экспорта данных LIMS) 
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Создание протокола LIMS 

Для запуска эксперимента LIMS необходимо создать файл протокола программного обеспечения 
CFX Manager (*.prcl) и сохранить его в папке протокола LIMS, указанной в закладке LIMS окна 
Options. 

Создание файла LIMS 

Файл LIMS (*.plrn) содержит информацию о настройках планшета и имя файла протокола. Данный 
файл генерируется внутренней системой LIMS Вашей лаборатории. Программное обеспечение 
CFX Manager использует файл LIMS для создания файла планшета, который будет 
использоваться совместно с соответствующим файлом протокола для запуска анализа и 
генерации данных. 

Нижеприведенные шаги производятся специалистом по системе LIMS. 

1. Выберите View > Show > LIMS File Folder (Вид > Отобразить > Папка с файлом LIMS) в 

строке меню главного окна программного обеспечения. 

2. Выберите CFX96 LIMS Plate Import Template.csv или CFX384 LIMS Plate Import 
Template.csv и импортируйте файл в систему LIMS (Рис. 102). 

 

Рис. 102. Открытие шаблона импорта планшета ПО CFX96 в систему LIMS 

3. С помощью LIMS создайте планшет, заполнив соответствующие поля, перечисленные в 
Таблице 45. 

4. Сохраните шаблон с расширением имени файла .plrn непосредственно по выделенному 
адресу папки с файлом LIMS. 

ВНИМАНИЕ! Изменение расширения файла с «.csv» на «.plrn» необходимо для 

программного обеспечения CFX Manager для распознавания файла и запуска протокола 
LIMS. 

Таблица 45. Определение содержимого файлов .csv LIMS 
 

Столбец Ряд Описание Содержимое Назначение 

A 1 Заголовок 
планшета 

Не редактировать Предопределено 

A,B,C 2 Поле/данные/ 
инструкции 

Не редактировать Предопределено 

В 3 Версия Не редактировать Предопределено 

В 4 Plate Size 
(Размер планшета) 

Не редактировать Предопределено 

В 5 Plate Type 
(Тип планшета) 

Введите «BR White», «BR Clear» или другой тип 
калиброванного планшета 

Обязательно 
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Таблица 45. Определение содержимого файлов .csv LIMS 
 

Столбец Ряд Описание Содержимое Назначение 

В 6 Режим 
сканирования  

Введите «SYBR/FAM Only», «All Channels» или 
«FRET» 

Обязательно 

В 7 Units (Единицы 
измерения) 

Введите одну из следующих единиц 
измерения: copy number (число копий), fold 
dilution (коэффициент разведения), micromoles 
(микромоли), nanomoles (наномоли), picomoles 
(пикомоли), femtomoles (фемптомоли), 
attomoles (аттомоли), milligrams (миллиграммы), 
micrograms (микрограммы), nanograms 
(нанограммы), picograms (пикограммы), 
femtograms (фемтограммы), attograms 
(аттограммы) или percent (процент) 

Обязательно 

В 8 Идентификатор 
эксперимента 

Ввести краткое описание или штрих-код, 
идентифицирующие данный анализ 

Опционально 

В 9 Примечание к 
эксперименту 

Ввести описание эксперимента Опционально 

В 10 Выполнение 
протокола 

Введите точное имя файла протокола Обязательно 

A 11-15 TBD/Пустой Не редактировать Предопределено 

A 16 Данные планшета Не редактировать Предопределено 

A 14-110 Позиция лунки Не редактировать Предопределено 

B-G Краситель канала 
1, краситель 
канала 2, 
краситель канала 
3, краситель 
канала 4, 
краситель канала 
5, краситель 
канала FRET 

Ввести имя одного калиброванного красителя 
(например, «FAM») для каждого используемого 
канала 

Обязательно 

H Тип образца Ввести один из следующих типов образцов: 
«Unknown” (Неизвестный), “Standard” 
(Стандарт), “Positive Control” (Положительный 
контроль) или “Negative Control” 
(Отрицательный контроль) 

Обязательно 

I Имя образца Ввести имя образца Опционально 

J-0 Мишень канала 1, 
мишень канала 2, 
мишень канала 3, 
мишень канала 4, 
мишень канала 5, 
мишень канала 
FRET 

Ввести имя мишени для каждого 
используемого канала 

Опционально 

P Имя 
биологического 
набора 

Ввести имя биологического набора Опционально 

Q Дубликат Ввести положительное целое число для 
каждого набора дубликатов. Значение должно 
быть отлично от нуля. 

Опционально 

R-W Количество в 
канале 1, 
количество в 
канале 2, 
количество в 
канале 3, 
количество в 
канале 4, 
количество в 
канале 5, 
количество в 
канале FRET 

Ввести значения количества для всех 
стандартов. Ввести концентрацию в форме 
десятичной дроби. 

Обязательно для 
всех стандартов 

X Примечание к 
лунке 

Ввести примечание к лунке Опционально 
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Таблица 45. Определение содержимого файлов .csv LIMS 
 

Столбец Ряд Описание Content (Содержимое) Назначение 

Y-AD 14-110 Цвет лунки в 
канале 1, цвет 
лунки в канале 2, 
цвет лунки в 
канале 3, цвет 
лунки в канале 4, 
цвет лунки в 
канале 5, цвет 
лунки в канале 
FRET  

Ввести любой определенный пользователем 
цвет следа в 32-битном десятичном формате 
целого числа (argb) 

Опционально 

Запуск анализа на базе LIMS 

Для запуска анализа на базе LIMS: 

1. Откройте файл LIMS одним из следующих способов: 

• «Перетащите» файл .plrn в окно программного обеспечения CFX Manager или на значок 
рабочего стола 

• Выберите Tools > LIMS File Folder в строке меню главного окна программного 

обеспечения Дважды щелкните на файле .plrn для открытия протокола 

• Выберите File > Open > LIMS file в строке меню главного окна программного 
обеспечения Выберите файл .plrn из папки LIMS и щелкните на Open (Открыть) 

2. Для запуска эксперимента для выбранного файла LIMS выберите прибор и щелкните на 
Start Run (Рис. 103). Содержимое файла LIMS и связанного с ним файла протокола 

используется для заполнения полей закладок протокола и планшета. 

 

Рис. 103. Окно Run Setup с готовым к запуску протоколом LIMS 

Экспорт данных в LIMS 

По завершении будет сгенерирован файл данных программного обеспечения CFX Manager (.pcrd) 
и сохранен в определенное местоположение в папку экспортированных данных (Рис. 100). 
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Если в окне LIMS Options выбрана опция Automatically Export Data after Run (Автоматически 
экспортировать данные после анализа), второй файл данных, поддерживающий извлечение 

данных LIMS, будет сохранен по тому же адресу. Формат и содержимое файла определяются 
настройками в окне LIMS Data Export Format Settings. Для экспорта этих данных в ручном режиме 
выберите Export > Export to LIMS Folder в строке меню главного окна программного обеспечения. 

Программа калибровки Calibration Wizard 

Системы CFX96 Touch, CFX96 Touch Deep Well и CFX Connect откалиброваны на заводе-
изготовителе под наиболее широко используемые флуорофоры для планшетов с белыми и 
прозрачными лунками. Система CFX384 Touch откалибрована на заводе-изготовителе под 
использование тех же самых флуорофоров только в планшетах с белыми лунками (Таблица 46). 

Таблица 46. Откалиброванные на заводе-изготовителе флуорофоры, каналы и приборы 
 

Флуорофоры Канал Возбужде
ние (нм) 

Детектиро
вание (нм) 

Прибор 

Красители FAM, SYBR
®
 

Green I 
1 450-490 515-530 Системы ПЦР реального 

времени с флуоресцентной 
детекцией CFX96 Touch™, 
CFX96 Touch Deep Well™, CFX 
Connect™ и CFX384 Touch™ 

VIC, HEX, CAL Fluor Gold 
540, Cal Fluor Orange 560 

2 515-535 560-580 Системы ПЦР реального 
времени с флуоресцентной 
детекцией CFX96 Touch™, 
CFX96 Touch Deep Well™, CFX 
Connect™ и CFX384 Touch™ 

ROX, Texas Red, CAL 
Fluor Red 610, TEX 615 

3 560-590 610-650 Системы ПЦР реального 
времени с флуоресцентной 
детекцией CFX96 Touch™, 
CFX96 Touch Deep Well™ и 
CFX384 Touch™ 

CY5, Quasar 670 4 620-650 675-690 Системы ПЦР реального 
времени с флуоресцентной 
детекцией CFX96 Touch™, 
CFX96 Touch Deep Well™ и 
CFX384 Touch™ 

Quasar 705, Cy5.5 5 672-684 705-730 Только системы ПЦР реального 
времени с флуоресцентной 
детекцией CFX96 Touch™ и 
CFX96 Touch Deep Well™ 

Системы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch также включают 
канал для химического анализа FRET; данный канал не требует калибровки для специфичных 
красителей. 

Для открытия программы Calibration Wizard для калибровки системы CFX96 Touch, CFX96 Touch 
Deep Well, CFX Connect или CFX384 Touch: 

1. Выберите прибор в секции окна Detected Instruments. 

2. Выберите Tool > Calibration Wizard для открытия окна и произведите калибровку новых 

комбинаций красителя и планшета (Рис. 104). 
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На Рис. 104 показан скриншот окна Dye Calibration. 

 

Рис. 104. Окно Dye Calibration 

Калибровка системы ПЦР реального времени с 
флуоресцентной детекцией CFX96 Touch™, CFX96 Touch 
Deep Well™, CFX Connect™ или CFX384 Touch™ 

Для калибровки системы ПЦР реального времени с флуоресцентной детекцией CFX96 Touch™, 
CFX96 Touch Deep Well™, CFX Connect™ или CFX384 Touch™ в окне Dye Calibration: 

1. В секции окна Calibrate New or Existing Fluorophores (Калибровать новые или 
существующие флуорофоры) выберите флуорофор, который вы хотите откалибровать, в 
ниспадающем списке Fluorophore. Если флуорофор не включен в список, наберите 

название в поле для добавления флуорофора в список. 

2. Выберите Plate Type. Если тип планшета не включен в список, наберите название в поле 

для добавления его в список. 

3. Выберите канал для флуорофора в ниспадающем списке Channel. 

4. Щелкните на кнопке Add to List (Добавить в список) для добавления флуорофора. 
Для очистки планшета щелкните на Clear List (Очистить список) для удаления всех 

флуорофоров. 

5. (Опционально) Повторите шаги 1-6 для добавления всех флуорофоров, которые вы 
собираетесь калибровать для данного планшета. 

6. По завершении добавления флуорофоров щелкните на View Plate для открытия окна Pure 
Dye Plate Display (Планшет с калибровочными красителями). Используйте данное окно 

в качестве руководства по загрузке красителей в планшет. 

7. Начните подготовку 96- или 384-луночного планшета для калибровки красителей 
пипетированием раствора красителя в каждую лунку, руководствуясь схемой в окне Pure 
Dye Plate Display. Для каждого флуорофора заполните четыре лунки 50 мкл (96-луночный 

планшет) или 30 мкл (384-луночный планшет) раствором красителя 300 нМ. Помните, что не 
менее половины планшета содержит пустые лунки. 

8. Запечатайте методом тепловой склейки тот планшет, который вы будете использовать в 
своем эксперименте. 

9. Поместите калибровочный планшет в блок и закройте крышку. Затем щелкните на кнопке 
Calibrate (Калибровать) и на кнопке OK для подтверждения наличия планшета в блоке и 

его готовности. 



Руководство по эксплуатации систем ПЦР реального времени с флуоресцентной детекцией 
CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch 

153 

10. Когда ПО CFX Manager завершит процесс калибровки, появится диалоговое окно. Щелкните 
на Yes для завершения калибровки и открытия окна Dye Calibration Viewer (Визуализатор 
калибровки красителей). 

11. Щелкните по OK для закрытия окна. 

Техническое обслуживание прибора 

Системы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect и CFX384 Touch включают 
чувствительный оптический модуль, который быстро перемещается в процессе сбора данных, и 
блок для образцов, который должен очень быстро нагреваться и охлаждаться. Загрязнение 
данных компонентов может повлиять на процессы термоциклирования и сбора данных. 

ВНИМАНИЕ! Ни при каких обстоятельствах не допускайте протекание реакции при 

открытой или негерметичной крышке. Реагенты могут попасть на блок, внутреннюю крышку 
и оптическую головку оптического модуля. Чрезмерное загрязнение может подавить сигнал, 
и загрязнение флуоресценции может стать причиной возникновения сильного фонового 
сигнала. Очистку оптической системы уполномочены производить только инженеры по 
эксплуатационному обслуживанию компании Bio-Rad. 

Для выключения системы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect или CFX384 Touch 
выполните следующие инструкции: 

• Всегда производите очистку внешней поверхности контейнеров перед помещением их в 
блок 

• Никогда не запускайте реакцию при открытой, неплотно прилегающей, проколотой или 
каким-либо другим образом поврежденной герметизирующей пленке во избежание 
загрязнения блока, внутренней крышки и оптической системы 

• Никогда не запускайте ПЦР или ПЦР реального времени с летучими реагентами, которые 
могут взорваться и повредить блок, внутреннюю крышку и оптическую систему 

• Периодически производите очистку блока и внутренней крышки для предотвращения 
скопления грязи, биологически опасных материалов или флуоресцирующих растворов 
(см. «Очистка оптического реакционного модуля» на стр. 153) 

• Не производите очистку и не касайтесь оптической системы за отверстиями нагревательной 
пластины внутренней крышки (Рис. 105) 

• Регулярно производите очистку внешней поверхности крышки и основного блока системы 
C1000 Touch™ или CFX Connect (подробная информация приведена в руководстве по 
эксплуатации термоциклера C1000) 

Очистка оптического реакционного модуля 

Очистка блока оптического реакционного модуля, наряду с основным блоком термоциклера 
C1000™ или CFX Connect должна производиться регулярно для удаления мусора или грязи, 
способных повлиять на функционирование системы. Удаляйте грязь и пролитую жидкость по мере 
их обнаружения мягкой безворсовой тканью, смоченной водой. Регулярная очистка прибора 
обеспечивает высокие эксплуатационные характеристики. Более подробная информация об 
очистке основного блока термоциклера C1000 Touch приведена в руководстве по эксплуатации 
термоциклера C1000. 

ВНИМАНИЕ! Запрещается использовать очищающие растворы, оказывающих 

коррозионное воздействие на алюминий. Не допускайте повреждения поверхности отсека 
реакционного модуля системы C1000 или CFX Connect. Царапины и повреждения на 
поверхности влияют на точность терморегулирования. 

ВНИМАНИЕ! Запрещается наливать воду или прочие растворы в отсек реакционного 

модуля системы C1000 или CFX Connect. Влажные компоненты могут привести к удару 
электрическим током при включении термоциклера в сеть. 

Очистку оптического реакционного модуля системы CFX96, CFX96 Deep Well, CFX Connect или 
CFX384 необходимо производить по мере обнаружения грязи, мусора или загрязнений блока или 
внутренней крышки. Любое загрязнение может повлиять на способность блока быстро изменять 
температуру и производить сбор точных данных флуоресценции. Ниже приведены инструкции по 
очистке реакционного модуля. 
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ВНИМАНИЕ! Для предотвращения удара электрическим током перед выполнением чистки 

всегда извлекайте реакционный модуль из основного блока термоциклера или отключайте 
термоциклер от сети. 

ВНИМАНИЕ! Никогда не касайтесь и не допускайте контакта растворов с оптической 

системой, расположенной за отверстиями нагревательной пластины во внутренней крышке 
(Рис. 105). 

 

 

 

Никогда не касайтесь 
оптической системы, 

расположенной за 
данными отверстиями 

Планшет  
(96-луночный) 

Рис. 105. Отверстия нагревательной пластины во внутренней крышке 

СОВЕТ: Для получения инструкций по обращению и удалению радиоактивных и 
биологически опасных материалов изучите руководства по радиационной безопасности, 
принятые в вашем учреждении. Эти руководства включают методы очистки, контроля и 
утилизации опасных материалов. 

• Очищайте внешние поверхности. Используйте влажную ткань или тонкую бумагу для 

удаления разливов с внешней поверхности корпуса. При необходимости используйте 
нейтральный мыльный раствор и очищайте поверхность влажной тканью. Чистка крышки 
предотвращает появление коррозии. 

• Очищайте охлаждающие пластины. Удаляйте пыль мягкой щеткой или влажной тканью. 

Удаляйте любую тяжѐлую пыль, находящуюся глубоко в вентиляционных отверстиях, с 
помощью пылесоса. Используйте воду и мягкую безворсовую ткань для удаления мусора, 
застрявшего в пластинах. Избегайте царапания поверхности. При необходимости 
используйте нейтральный мыльный раствор и полностью удаляйте остатки. Чистка пластин 
повышает точность нагревания и охлаждения образца. 

ПРИМЕЧАНИЕ: Запрещается использовать очищающие растворы, коррозионные для 
алюминия, такие как отбеливающее вещество или абразивные чистящие средства. 

• Не рекомендуется использовать масло в лунках. При использовании масла следует 

выполнять тщательную и частую чистку лунок. Очищайте масло, если оно изменило свой 
цвет или содержит грязь. Для удаления масла используйте 95% этиловый спирт. 
Не допускайте скопления масла в блоке. 

• Очищайте лунки блока. Немедленно удалите жидкость для предотвращения ее 

высыхания. Используйте одноразовые пластиковые пипетки с водой (рекомендуется), 95% 
этиловым спиртом или раствором отбеливающего средства с водой с концентрацией 1:100. 
Для очистки блока используйте мягкую безворсовую ткань или бумажную салфетку. Всегда 
споласкивайте лунки водой несколько раз для удаления всех следов чистящих реагентов 

ВНИМАНИЕ! Запрещается чистить блок агрессивными щелочными растворами 

(агрессивное мыло, аммиак или высококонцентрированное отбеливающее средство). 
Запрещается использовать коррозионные или абразивные чистящие растворы. Такие 
чистящие средства могут повредить блок и препятствовать точному контролю температуры. 
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ВНИМАНИЕ! Отбеливающее вещество, этиловый спирт или мыло, оставшиеся в ячейках 

блока, могут вызвать коррозию блока и разрушать пластиковые поверхности в процессе 
анализа. Всегда тщательно ополаскивайте ячейки блока после каждой чистки водой 
несколько раз для удаления всех следов чистящих реагентов. 

ВНИМАНИЕ! Запрещается нагревать блок после добавления очищающего раствора. 

Нагревание блока с очищающим раствором приведѐт к повреждению блока, реакционного 
модуля и основного блока термоциклера. 

• Очищайте внутреннюю крышку. Используйте мягкую ткань и воду для удаления мусора и 

растворов с поверхности внутренней крышки. Не используйте абразивные чистящие 
средства или грубый материал, который может поцарапать поверхность. Чистка внутренней 
крышки повышает точность нагревания и охлаждения образца. 

Журнал приложения 

Перед запуском нового эксперимента приборы CFX96 Touch, CFX96 Touch Deep Well, CFX Connect 
и CFX384 инициируют процедуру самодиагностики для проверки соответствия функционирования 
системы спецификациям. Программное обеспечение регистрирует результаты теста в рабочем 
журнале и журнале приложения. При обнаружении проблемы в одном или нескольких 
экспериментах откройте рабочий журнал и журнал приложения для определения времени 
возникновения проблемы. 

Программное обеспечение CFX Manager отслеживает состояние прибора в ходе выполнения 
эксперимента, регистрируя данные в журнале приложения (Рис. 106). Используйте данные 
журналы для отслеживания событий прибора и программного обеспечения, а также для 
диагностики неисправностей. 

Для открытия журнала приложения в главном окне программного обеспечения выберите 
View > Application Log. 

 

Рис. 106. Пример файла журнала событий 

Диагностика неисправностей 

Восстановление файла данных 

Файлы данных автономных экспериментов можно восстановить, выполнив следующие инструкции: 

1. Вставьте флэш-накопитель USB в USB-порт основного блока термоциклера. 

2. Коснитесь кнопки Tools (Инструменты). 

3. Выберите Run Reports (Отчеты по экспериментам). 

4. Выберите файл из списка. 



Ресурсы 

156 

5. Коснитесь кнопки Recover Data (Восстановить данные). Будет создан новый файл данных 

(.zpcr) и экспортирован на флэш-накопитель USB. 

ПРИМЕЧАНИЕ: Восстановлению подлежат только последние 5 файлов. 

Обычно проблемы программного обеспечения с прибором могут быть решены перезагрузкой 
компьютера и системы. Перед перезагрузкой убедитесь, что все выполняющиеся процедуры 
сохранены. 

ПРИМЕЧАНИЕ: Убедитесь, что компьютер имеет достаточный объем оперативной памяти и 
свободного пространства на жестком диске. Минимальный объем оперативной памяти 
составляет 2 ГБ, и минимальное пространство на жестком диске – 20 ГБ. 

Извлечение регистрационных файлов из основного блока 
термоциклера 

Регистрационные файлы, расположенные в основном блоке термоциклера, могут быть извлечены 
на жесткий диск подключенного компьютера. Для извлечения файлов выполните следующие 
инструкции: 

1. В главном окне программного обеспечения выберите прибор в секции окна Detected 
Instruments. 

2. Щелкните правой кнопкой мыши и выберите Retrieve Log Files... (Извлечь 
регистрационные файлы). 

3. Выберите адрес папки, в которую будут сохранены извлеченные файлы. 

4. Щелкните на кнопке Ok. 

Установка программного обеспечения в ручном режиме 

При необходимости установите программное обеспечение вручную, руководствуясь следующими 
инструкциями: 

1. Вставьте CD-диск с программным обеспечением. 

2. Щелкните правой кнопкой мыши на значке CD-диска и выберите Explore для открытия окна 

CD-диска. 

3. Дважды щелкните на папке CFX_Manager для открытия папки, и затем дважды щелкните на 
setup.exe для запуска программы установки программного обеспечения. 

4. Выполните инструкции программы по установке программного обеспечения и щелкните на 
Finish. 

Переустановка драйверов 

При необходимости выполните переустановку драйверов, выбрав Tools > Reinstall Instrument 
Drivers (Инструменты > Переустановить драйверы прибора) в главном меню. 

ПРИМЕЧАНИЕ: При наличии проблем связи программного обеспечения с системой 
реального времени после переустановки драйверов и проверки USB-соединения свяжитесь 
со службой технической поддержки компании Bio-Rad. 

Отказ питания 

При отказе питания прибор и компьютер выключаются. Если перерыв в энергоснабжении 
непродолжительный, прибор возобновит выполнение протокола, но в журнале приложения будет 
зарегистрировано событие отказа питания. В зависимости от настроек компьютера и 
продолжительности отсутствия энергоснабжения прибор и программное обеспечение 
предпринимают попытку продолжить работу в зависимости от этапа протокола: 

• Если протокол находится на этапе, не включающем считывания планшета, то его 
выполнение продолжится сразу после восстановления энергоснабжения 

• Если протокол находится на этапе, включающем считывание данных с планшета, то прибор 
дождется повторного запуска программного обеспечения и восстановит связь для сбора 
данных. 
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В данной ситуации выполнение протокола продолжится только в том случае, если 
программное обеспечение не отключено компьютером. После запуска компьютера и 
программного обеспечения выполнение протокола возобновится 

Если Вы хотите открыть крышку с электроприводом реакционного модуля для извлечения 
образцов во время отсутствия энергоснабжения, выполните нижеприведенные инструкции по 
демонтажу стопорной пластины: 

1. Выньте реакционный модуль из основного блока термоциклера C1000 Touch или CFX 
Connect, нажав на запорную планку. 

2. Поместите модуль на лабораторный стол таким образом, чтобы передняя часть модуля 
выступала на 2 дюйма (5,08 см) за край стола, как показано на Рис. 107. 

 

Рис. 107. Установка оптического модуля для демонтажа стопорной пластины 

3. С помощью универсального ключа извлеките два больших винта из-под переднего края 
реакционного модуля (под кнопкой открытия крышки). Не вынимайте два маленьких винта, 
расположенных на переднем крае модуля. Вы должны услышать щелчок. На Рис. 108 
продемонстрированы два больших винта. 

 

Рис. 108. Удалите данные винты для открытия оптического модуля 

4. Откройте крышку реакционного модуля. Помните, что защелка (из темного пластика) уже не 
закреплена. Выньте образцы из блока. 
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5. Произведите повторную сборку реакционного модуля с крышкой в открытом положении, 
установив на место замок и зафиксировав его большими винтами. На Рис. 109 
продемонстрирована установленная защелка. 

 

Рис. 109. Защелка оптического модуля 
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